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1  Introduction
What is Ham Radio Deluxe?

Ham Radio Deluxe (HRD) is an integrated suite of software products for amateur 
radio. The five modules in the suite provide rig control, logging, digital communi-
cations, satellite tracking, and rotator control.

Rig Control Ham Radio Deluxe Rig Control provides rig control through a richly featured full 
screen interface and other products in the Ham Radio Deluxe Suite via a direct 
connection or TCP/IP remote access.

Logbook Ham Radio Deluxe Logbook provides QSO logging, DX cluster connectivity, 
callsign lookup, awards tracking (with integration to LoTW, eQSL, and Ham 
Radio Deluxelog.net), and contesting. Microsoft Access and MySQL are support 
with strong features for backup and recovery.

Digital Master 
(DM-780)

DM-780 provides most popular sound card digital modes with direct integration 
to Ham Radio Deluxe Logbook.

Satellite 
Tracking

Ham Radio Deluxe Satellite Tracking provides satellite operations with rig con-
trol and Google Earth integration.

Rotator Ham Radio Deluxe Rotator provides control for 15 popular models of antenna 
rotators.

How It All Began
In early 2003 Peter PH1PH and Simon HB9DRV talked about developing a sim-
ple program to control the soon to be released ICOM IC-703.

Maybe it was the beer, maybe the desire to give something back to the radio ama-
teur community, however on June 6th, 2003 the first line of code was written, 
Ham Radio Deluxe (Ham Radio Deluxe) was born.

By late 2005 the number of registered users stood at 20,006 – quite an achieve-
ment in such a short time.

This Guide
If you are only going to read one more section, then now go to Getting Started.

Please report errors and omissions to n0zrd(at)mnyarc.org or in the Ham Radio 
Deluxe forums 
http://forums.hrdsoftwarellc.com. 
When you get there, select Headquarters>Documentaton.

As this guide matures further it may flow differently than it currently does. Please 
check the table of contents for the new evolving layout. Note that this document 
has some sections that are still in DRAFT mode which means that it can have lots 
of old or wrong information.
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System Requirements
Computer Ham Radio Deluxe is designed for Windows XP/SP3, Vista and Windows 7 or 8), 

also Internet Explorer 6.0 (or higher) is required. Most modules will work on 
Windows 2000. Digital Master 780 does not, however, work with Windows 2000. 
The policy is to support Windows versions which are supported by Microsoft. 

There are no plans for a LINUX or Macintosh native version, Ham Radio Deluxe 
is known to run under Wine for LINUX and PC emulators for the Macintosh.

The suggested minimum computer specification is: 
Windows XP/SP3

Processor
Ham Radio Deluxe 500 MHz
DM780 1 GHz 
HRD Logbook 500 MHz

Memory
Ham Radio Deluxe 1 GB
DM780 2 GBa

a. DM780 uses more resources than Ham Radio Deluxe when 
decoding many signals simultaneously.

HRD Logbook 2 GB

Hard Drive 
Storage

Ham Radio Deluxe 20 MB
DM780 50MB
HRD Logbook 20 MB

Color Display 1024 x768 minimum 1280 x 1024 preferred

Windows Vista

Processor
Ham Radio Deluxe 2 GHz
DM780 2.4 GHz 
HRD Logbook 2 GHz

Memory
Ham Radio Deluxe 3 GB
DM780 3 GB
HRD Logbook 3 GB

Hard Drive 
Storage

Ham Radio Deluxe 20 MB
DM780 50MB
HRD Logbook 20 MB

Color Display 1024 x768 minimum 1280 x 1024 preferred

Windows 7/8 32 bit

Processor
Ham Radio Deluxe 2.4 GHz
DM780 2.8 GHz Dual Core 
HRD Logbook 2.4 MHz

Memory
Ham Radio Deluxe 4 GB
DM780 4 GB
HRD Logbook 4 GB

Hard Drive 
Storage

Ham Radio Deluxe 20 MB
DM780 50MB
HRD Logbook 20 MB

Color Display 1280 x1024 minimum 1920 x 1080 preferred



Chapter 1 - Introduction System Requirements

Ham Radio Deluxe 3

Windows 7/8 64 bit
Same requirements as 32 bit operating system EXCEPT double the memory to 6 
GB.

Other Software
In addition, you will need the following free software for viewing demos and user 
documentation.

• Adobe Reader 9 or newer
• Adobe Flash Version 11 or newer 

If you do not have them, they can be downloaded from the Adobe website at: 
http://get.adobe.com/reader/ and http://get.adobe.com/flashplayer/

Supported 
Radios

You don‟t need a radio – Ham Radio Deluxe comes with built-in Dem-o-matic 
radio support (FTDX-5000, FTDX-9000, FT-450, FT-950, FT-2000, K2, Orion, 
TS-480, TS-570, TS-590 and TS-2000).

Ham Radio Deluxe currently supports these ‘real’ radios:
• Alinco: DX-77, SR8, SR9
• Elecraft: K2, K3, KX3
• FlexRadio: PowerSDR
• ICOM: IC-31, IC-51, IC-5100, C-703, IC-706, IC-706MkII, IC-706MkIIG, 

IC-707, IC-718, IC-7200, IC-725, IC-726, IC-728, IC-729, IC-7200, IC-735, 
IC-736, IC-737, IC-738, IC-7400, IC-7410, IC-746, IC-746Pro, IC-751A, 
IC-751A (Piexx), IC-756, IC-756Pro, IC-756ProII, IC-756ProIII, IC-761, 
IC-765, IC-775DSP, IC-781, IC-821H, IC-7000, IC-7200, IC-7410, IC-7600, 
IC-7700, IC-7800,   IC-9100, IC-910H, IC-R10, IC-R20, IC-R7000, IC-R75, 
IC-R8500, IC-R9000, IC-R9500, PCR-1000

• Kenwood: TS-50S, TS-60S, TS-140S, TS-440S, TS-450S, TS-480, TS-570, 
TS-590, TS-680S, TS-690S, TS-790, TS-850, TS-870, TS-940S, TS-950, 
TS-990, TS-2000, TS-B2000, R-5000

• Microtelecom: Perseus
• SDR-Radio: SDR-Radio
• Ten-Tec: TT-Argonaut, TT-Jupiter, TT-Pegasus, TT-Omni VII(Radio), 

TT-Omni VII(Remote), TT-Orion, TT-Eagle, RX-350
• Yaesu: FT-100, FT-450, FT-600, FT-767GX, FT-817, FT-840, FT-847, 

FT-857, FT-890, FT-897, FT-900, FT-920, FT-950, FT-990, FT-1000D, 
FT-1000MP MkV, FT-2000, FTDX-3000, FTDX-5000, FTDX-9000.

Internet 
Connection

Not absolutely required but really is essential to fully utilize all the features. The 
best connection is a full time connection such as cable or DSL. Registering the 
program is much easier when done online.

Radio 
Interfacing

Ham Radio Deluxe is designed to be used with one of the rigs listed above. Some 
modules, however, can be used without a connection to a rig. Logging will work 
but will not be as automated. Satellite tracking is still fun without a rig connected. 
In fact, there are only a few of the above listed rigs that “really” work fully with 
the satellite module.

Some of the rigs listed above do not fully avail themselves to all the features of 
Ham Radio Deluxe. A number of the rigs do not provide Tx control easily. That is 
the limit of the rig, not Ham Radio Deluxe. 
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For CAT control, all radios require some sort of SERIAL connection between the 
radio and the computer. Some of the newer model radios are equipped with a USB 
port on the back of the radio. All that is needed there is a USB cable from the 
radio to a USB port on the computer.

Other radios have a standard DB9 serial port on the back which either connects 
directly to a DB9 Serial port connector on the back of the computer or through a 
Serial/USB converter to a USB connector the computer, while others connect 
from an ACC or DATA plug on the back of the radio through a Serial/USB con-
verter to the computer.

Many of these cables use the serial port. If you don’t have a serial port all is not 
lost – USB serial converters are widely available. Also, there are options available 
that are USB based. 

One of these is HamLinkUSB from Timewave. This will allow rig control with 
most of the radios listed above. 

Note:  If you need a Serial/USB converter be specially aware of the type of 
chips and drivers that are in the converter you choose. We recommend 
ONLY converters with FTDI or SI Labs chipsets and drivers. We have 
found these to preform exceptionally well with HRD and other radio 
related software. 

Beware of Prolific chipsets and drivers. There are many of these on the 
market which are counterfeit and the chipsets are of poor quality. The 
drivers are also poorly written and will not work properly with HRD, 
especially if trying to use them on a Windows 7 or 8 system.

Some of the problems you may experience with these chipsets and 
drivers are system crashes, BSOD, program lock-ups, drivers won't 
install properly, comports disappear for no reason, just to name a few.

If in doubt as to what you need to connect your radio to the computer 
running Ham Radio Deluxe, contact support@hrdsoftwarellc.com or 
Timewave either through their website at www.timewave.com or phone 
them at 1-651-489-5080. They can provide you with cables and 
connectors to meet your needs.

The future trend in radio control and interfacing is the USB connection. More and 
more radios will only have USB ports and not Serial or Parallel ports. The USB 
port will even pass audio as rig control with a few of the radios.

For the majority of the radios listed above, you will need to have a more robust 
interface if you need to send or receive audio. The audio recorder and PSK31 are 
two examples of this need. 

For more interfacing information visit the Downloads page at http://www.ham-
radio-deluxe.com/ for A basic guide to CAT and Audio interfacing which contains 
many designs for both CAT and audio interfaces for use with Ham Radio Deluxe.

Check out the cable and interface solutions from:
• Timewave   http://www.timewave.com 
• Tigertronics http://www.tigertronics.com
• ZLP Electronics   http://g4zlp.ham-radio.ch/ 
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• West Mountain Radio http://www.westmountainradio.com/.

Public 
Interfaces

Other (non-Ham Radio Deluxe) programs are supported via a DDE interface (see 
DDE Support) and a serial port (see 3rd-Party Programs).

Logbooks typically use these interfaces; for example - contest-oriented logbooks.

Installation
Introduction Ham Radio Deluxe is designed for Windows XP, Vista and Windows 7) and 8, 

Internet Explorer 6.0 (or higher) is required. The policy is to support Windows 
versions which are supported by Microsoft. 

The Logbook uses MS Access by default or you can use MySQL, see Database 
for more information.

Ham Radio 
Deluxe

Ham Radio Deluxe can be installed in under a minute. Special knowledge is not 
needed – the kit does everything for you!

You will not need to reboot your computer, Ham Radio Deluxe does not update 
your system files or change your system’s configuration in any way.

You may or may not see the following screen depending upon the update status of 
your machine.

You will see this or an updated version of this screen to get you started with the 
installation.
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When you start the installation the first screen shows the release and build you are 
installing.

You must accept the licensing conditions. 
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Select the folder where Ham Radio Deluxe will be installed, the suggested default 
is usually sufficient.

Select the folder in the Start menu where the Ham Radio Deluxe entries will be 
added, the suggested default is usually sufficient.



8 Ham Radio Deluxe

Installation Chapter 1 - Introduction

Click Install to start the installation.

The progress of the installation is shown while the software is being installed.
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When the software has been installed select the programs to be started, then press 
Finish.

First Steps
Product 
Activation

Registration
Ham Radio Deluxe has an improved registration system. The following instruc-
tions should get you up and running without any problems.

When you first start Ham Radio Deluxe you will be presented with the following 
welcome screen.

Pressing Next at this screen will continue on with the registration process.
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1 This screen asks for your call sign. Enter ONLY your assigned call sign. DO 
NOT enter any prefix such as KR6/N4XXX or modifiers like /P or /?.
After you have entered your call sign press Next.

2 If you purchased Ham Radio Deluxe from a distributor and received a CD or 
if you purchased online and were sent a key, here is where you enter the 16 
character Main Activation Key. The activaton key may be copied and pasted 
from the e-mail you received to avoid any mistakes in entering. Just 
highlight the entire purchase key in the e-mail, right click and select Copy. 
Place your cursor in the first box of the above screen, right click and click 
Paste. Once the key is entered, press Next.
If you do not have a Activation Key and would like to continue with the 30-day 
trial subscription, just press the Next button when you reach this screen.

Note:  If you already have a registered subscription and are installing Ham 
Radio Deluxe on a second computer or re-installing Ham Radio Deluxe 
for any reason, entering your call sign in step 1 and just clicking next on 
the above screen will also bring up the following screen. However, when 
you click Finish it will automatically change to a full registered version.
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If running the 30-day trial you will now see the above screen. 

If you entered a activation key you will now see the above screen with your call-
sign and activation key. Just click the Finish button to continue to the next screen.
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Those who have purchased the software with the support will see a screen like 
this, showing your call sign, telling you that you have a Subscription License and 
indicating the expiration date.

Those running the Trial version will show have their call sign, Trial Subscription 
and an expiration date 30 days from the date installed on your computer. At this 
screen, just click on the Continue button at the bottom of the screen to continue 
on to the Rig Control setup screen.

If you have any problems or questions about the registration please contact sup-
port either by phone at (813) 434-4667 or send an e-mail to support@hrdsoft-
warellc.com

Connection You can dive into Ham Radio Deluxe using a demo radio or your radio. A good 
way to explore the program is with a demo radio first and then connect your rig.

Demo-o-matic Radio
Now that you have installed Ham Radio Deluxe you can try it out using a Dem-o-
matic radio. This is a reasonably accurate simulation of the real thing, designed 
for use during presentations and while developing Ham Radio Deluxe when a 
radio is not available (on the train, in a plane, in an airport, stuck in a hotel room 
in Finland etc.).

From the Start menu select Programs > Ham Radio Deluxe. Once the splash 
screen has closed you see the Connect window. If you do not have the correct con-
nection cable, select one of the Dem-o-matic radios so that you can open Ham 
Radio Deluxe.
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Dem-o-matic
The Dem-o-matic radios do not need cables – simply select Dem-o-matic in the 
Company drop down, select an option in the Radio drop down, and then press 
Connect.

They are ideal for demonstrating Ham Radio Deluxe when you do not have a suit-
able radio available. It is also the only way that you can open Ham Radio Deluxe 
if you do not have a supported radio or the correct connecting cable.

Your Radio
PLEASE DO SOME HOMEWORK!!! Read your radio's manual to find out 
exactly how it is supposed to be connected to a computer for CAT control. Some 
radios require special drivers to be loaded in the computer to access certain model 
radios. These drivers can usually be downloaded from the manufacturers website. 
All this information is in your radios user manual or from the radio's manufactur-
ers tech support system.

Please refer to See “Radio Interfacing” on page 3. to review the requirements for 
Ham Radio Deluxe interfacing.

Configuration 
Options

To connect your radio you will need to connect the necessary cables and install 
drives if needed. You must also do some configuring within Ham Radio Deluxe. 
This is usually a one time exercise.

Once you have all your cables in place it's time to turn on your radio, boot up your 
computer and start Ham Radio Deluxe. The next screen you should see is the 
radio connection setup screen. This is where you select your radio and set some 
parameters to allow the Ham Radio Deluxe Rig Control software to connect to 
your radio.
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The New Tab

Notice there are four tabs at the top of this display. The one currently showing is 
the NEW tab. This is where you configure the setup for any new radio you want to 
connect to the Ham Radio Deluxe software. We will continue with this setup in 
the next section.

This is where you actually configure how Ham Radio Deluxe connects to your 
radio. It also allows you to configure what modules Ham Radio Deluxe loads, by 
default, on start-up.

The Preset Tab
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Once you have a radio configured properly and it starts from the NEW window, 
the configuration is saved in the Preset page. As you can see here, there are sev-
eral radios configured both real ones and demo-o-matic ones. 

Serial Ports Tab

The Serial Ports tab displays all the comports available on your computer. You 
will notice just below the window near the center it has two radio buttons. One 
says Show All ports and the other says Only ports connected to PC. These buttons 
come in handy when you are trying to figure out which ports are actually being 
used by the Ham Radio Deluxe Software and which are just available for use.

The Connection Process
Each radio must be on a different comm port from the computer. This allows you 
to actually operate two or more radios at the same time and switch between them 
with a couple clicks of the mouse. We will also show that in another section of this 
manual.

If you have a radio configured in this screen which you no longer own or have 
connected to Ham Radio Deluxe, you can easily remove it from the Presets by 
clicking on the setup line in the display window, to highlight the unwanted config-
uration, and click on the "X Remove" located on the left just below the slider near 
the left center of the dialog box.

Company
Select your radio manufacturer from the drop-down list. The Dem-o-Matic radios 
do not require a COM port, they are for demonstrating Ham Radio Deluxe when 
you do not have a suitable radio available.

FlexRadio: you must install the vCOM virtual serial port drivers from Philip Cov-
ington (N8VB). These are used to provide the connection between Ham Radio 
Deluxe and the PowerSDR software that must be running before you try to create 
the connection with Ham Radio Deluxe. 
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Note:  It seems that vCOM will not run on Vista/Windows 7 64bit because 
the 64-bit version is very insistent on having signed drivers. A signed 64 
bit versions might be available for a few dollars from VSPE. More 
information is available from http://www.flex- radio.com/, to install the 
vCOM drivers see N8VB vCOM

.

ICOM: disable the CI-V Transceive option for best performance.

Kenwood: make sure Packet communication mode is switched OFF (if sup-
ported). Most Kenwood radios require CTS and RTS to be ON for flow control.

Radio
Select your radio model from the drop-down list.
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If your radio does not appear in this drop-down list there is a chance it can be sup-
ported by the commands of a different model from the same manufacturer. Con-
tact HRD Support or the manufacturer of your radio for information on about 
compatibility with another models firmware CAT command set.

COM Port

The COM port on this computer where you have connected the radio interface 
cable.  Make sure that you do not have other programs using the same port, for 
example mobile phones and personal organizers. It is recommended you NOT use 
the Auto-Detect. The Auto-Detect can sometimes fail to detect the port. To see the 
COM ports on your computer select the Serial Port tab to see a display.
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Speed
The speed used for communicating with the radio, check the speed setting via the 
radio's configuration menu. Again, it’s not recommended to use the Auto-Detect. 
Also remember that “FASTER IS NOT ALWAYS BETTER”. Sometimes faster 
speeds can cause timing problems when sending commands back and forth 
between Ham Radio Deluxe and the radio. The important thing is that you set the 
speed in Ham Radio Deluxe and the port speed in the radio the same. Check your 
radio manual to find out how to set the com port speed. A 4800 baud connect 
speed is normally plenty fast enough to support most radios.

CI-V Address
ICOM only: the address assigned to the radio, consult the radio's documentation 
for the default address. This can also be configured via the radio's configuration 
menu.

CTS
Enables the CTS flow control, required for Kenwood radios.

DTR
Enables the DTR line when the COM Port is opened and leaves it on, usually to 
provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 inter-
faces this can be left unchecked (off).

RTS
Enables the RTS line when the COM Port is opened and leaves it on, usually to 
provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 inter-
faces this can be left unchecked (off).

Next, put a check in the boxes for DTR and RTS. Some radios don’t require both 
of these settings checked so they can be unchecked if there is a failure to connect 
to the radio. 

Note:  If you will be connecting more than one radio to Ham Radio Deluxe 
and you would like the current one to be the default radio, place a check 
in the box where it says “Always connect to this radio when starting 
HRD Rig Control”.

Connecting
Press Connect to connect to the radio. If you see the error below then the COM 
port is currently held open by another program or the radio is not turned on.

Check that you have not started another radio control program. Other culprits are 
PDA and mobile phone connections. Even if you have disconnected a device from 
a COM port you must make sure that the software is no longer running.
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Once connected Ham Radio Deluxe reads the radio’s frequency to ensure that the 
options you selected are correct. If you see the error below then Ham Radio 
Deluxe failed to read the radio’s frequency:

If Ham Radio Deluxe can read the frequency the Connect window is replaced 
with the main radio display – you are now using Ham Radio Deluxe!

If Ham Radio Deluxe cannot read the frequency then check:
• Correct COM port is selected,
• Speed on radio is the same as the speed selected in Ham Radio Deluxe,
• Your cable – you may have a NULL modem cable when a normal serial 

cable is needed,
• Cable is connected correctly to your PC (you may have more than one COM 

port),
• DTR / RTS are selected if required to power an active cable such as CT-62 

or a cable from third-party provider.
If you still can’t get started refer to:

• Command Tester, and
• Portmon.

Icom CI-V 
Details

Icom's CI-V Protocol
ICOM's CI-V protocol is based on a relatively simple bi-directional, single-wire 
TTL level signaling system. The single wire consists of a communications line 
(DATA) and a ground reference (GND). The DATA line is held high when there is 
no traffic. As long as the DATA line is high, any device can initiate communica-
tion by pulling the line low and sending the Icom attention command (FEFE). 
When the line goes low, the other devices see this as a BUSY indication, allowing 
the single DATA line to offer some amount of basic flow control. Multiple devices 
may connected across the CI-V port in parallel, as long as each device is set up 
with a unique hex address. All in all, it's quite elegant in it's simplicity.

Default Icom CI-V Addresses
Each Icom model has it's own, distinct default address. As a general rule, Icom 
used only even addresses ($02, $04, $06 ...). Each model was given a new default 
address when it came out. The user can change the default address if required. On 
older rigs this was done by (re-) soldering some diodes, on newer rigs the adress 
can be changed by setup through the front panel or even by CI-V commands. 
Addresses can be selected from $01 to $EF, giving 239 distinct addresses. The 
following is a nearly complete table of all known addresses from CI-V capable 
rigs, not only by Icom.
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Icom Model Addr Memories Band Edge Type
IC-271 $20 32 1,2 VHF All mode
IC-275 $10 99+3 P1,P2 VHF All mode
IC-375 $12 99+3 P1, P2 220MHz All mode
IC-471 $22 32 1,2 UHF All mode
IC-475 $14 99+3 P1,P2 UHF All mode
IC-575 $16 99+2 P1,P2 10m & 6m All mode
IC-7000 $70 500+2 6 HF/VHF/UHF All mode
IC-703 $68 99+2 P1, P2 HF All mode QRP
IC-706 $48 99+3 P1, P2 HF/VHF All mode
IC-706MkII $4E 99+3 P1, P2 HF/VHF All mode
IC-706MkIIG $58 99+3 P1, P2 HF/VHF/UHF All mode
IC-707 $3e ? ? HF All mode
IC-718 $5E 99+2 ? HF All mode
IC-7200 $76 200 P1,P2 HF All mode
IC-725 $ 28 26 25,26 HF All mode
IC-726 $30 24+2 P1, P2 HF/6m All mode
IC-728 $38 26 25, 26 HF All mode
IC-729 $3A 26 25, 26 HF/6m All mode
IC-735 $04 12 11, 12 HF All mode
IC-736 $40 ? ? HF/6m All mode
IC-737 $3C 99+3 P1, P2 HF All mode
IC-738 $44 ? ? HF All mode
IC-7400 
(IC-746Pro)

$66 99+2 P1, P2 HF/VHF All mode

IC-746 $56 99+2 P1, P2 HF/VHF All mode
IC-751A $1C 32 1,2 HF All mode
IC-756 $50 99+2 P1, P2 HF/6m All mode
IC-756Pro $5C 99+2 P1, P2 HF/6m All mode
IC-756ProII $64 99+2 P1, P2 HF/6m All mode
IC-756ProIII $6e 99+2 P1, P2 HF/6m All mode
IC-761 $1E ? P1, P2 HF All mode
IC-765 $2C 99+2 P1, P2 HF All mode
IC-775 $46 99+2 P1, P2 HF All mode
IC-7700 $74 100 P1, P2 HF All mode Contest
IC-78 $62 ? ? HF All mode
IC-7800 $6A 99 P1, P2 HF All mode
IC-781 $26 99+2 P1, P2 HF All mode
IC-820 $42 2x80+3 P1, P2 VHF/UHF All mode
IC-821 $4C 2x80+3 P1, P2 VHF/UHF All mode
IC-910 $60 2x100 + 1 2 x 6 VHF/UHF All mode
IC-970 $2E 99+3 P1, P2 VHF/UHF All mode
IC-1271 $24 32 1,2 SHF
IC-1275 $18 32+3 P1, P2 SHF
IC-X3 ? P1, P2 Commercial HF Transceiver
IC-R10 $52 ? ? Handheld scanner
IC-R20 $6C 1000+200 50 Handheld scanner
IC-R71 $1A 32 ? General Coverage Receiver
IC-R72 $32 101 ? General Coverage Receiver
IC-R75 $5A 100 P1, P2 General Coverage Receiver
IC-R7000 $08 ? ? General Coverage Receiver
IC-R7100 $34 99 10xP1,P2 General Coverage Receiver
IC-R8500 $4A 800 n/a General Coverage Receiver
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What’s Next
It is time to play a little Ham Radio Deluxe to see what it does. Even if you can 
connect to a radio, let’s start by connecting to a Kenwood TS-2000 through Dem-
o-matic.

Appearance You should now have something that looks like the display below. The Rig Con-
trol Display (GUI) is a generic representation of an HF radio's front panel. It con-
tains most of the operating functions and controls of the actual radio it is 
connected to. This display does not in any way and can not be made to actually 
depict the front control panel of your actual radio.

Below is a screen shot of the Rig Control Display representing a Kenwood TS-
2000 all band, all mode radio.

IC-R9000 $2A 99 10xP1, P2 General Coverage Receiver
IC-R9500 $72 1000 Auto: 100, Skip: 100, 

Scanedge: 20
General Coverage Receiver

IC-RX7 $78 1600 Organized by Category, 
Group etc.

Handheld Scanner

Icom Model Addr Memories Band Edge Type
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This is the default appearance for Ham Radio Deluxe. For the sake of quality doc-
umentation we will change the appearance to LCD which is a reverse of what we 
now see.

Multiple Radios
HRD has the capabilities to display an operate multiple radios from one screen. In 
the image below we see a Kenwood TS-480 displayed and controlled by the top 
pane while a Kenwood TS-2000 is being displayed and operated from the bottom 
pane.

Each radio can be accessed and operated with just a few clicks of the mouse but-
ton.

Each radio must have it's own dedicated comport on the computer. It can be either 
through USB/Serial connections or you can have a multi-port serial card installed 
in your desktop.

To configure your setup for multiple radios, once you have your first radio 
installed and connected via the connection manager, adding a second or third 
radio is quite simple.

In the main Rig Control screen of the first radio installed either click on Files > 
Connect or click on the icon that has the round green circle with the white arrow 
in it. This brings up the Radio Connection screen that you have seen before when 
you set up your first radio.
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In this screen you configure the second radio, just like you did for your first in the 
initial setup of Ham Radio Deluxe. You select the Manufacturer, the radio model, 
the comport and the comport speed. You also select the flow control used to com-
municate with this second radio.

Note:  Make sure you don't have a check mark in the Always connect to this 
radio when starting HRD Rig Control. This will allow you to select 
which radio you would like to connect to first.

Click on the Connect button to allow Ham Radio Deluxe to connect to and control 
this second radio. Once in the Rig Control screen you can click on the Windows 
menu option and select with radio window to display or configure the display to 
show both radios in the same window, as we did earlier in this section. 

After you shut Ham Radio Deluxe down, and restart it, when the Connection win-
dow opens, select the Preset tab on the window. This shows you the radios you 
have connected to your computer and allows you to select which radio you would 
like to start first.

To change the appearance:

1 From the View menu select Color Schemes,
2 Select the Schemes tab if it is not selected.
3 In the Schemes list locate LCD and double click on it.
4 Your display should have changed to a white background with black text. If 

you want to keep the change, press OK otherwise press Cancel and your 
display will revert back to the default appearance.

 Congratulations. You have made your first of many modifications of Ham Radio 
Deluxe. 
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Like many features of this and other well designed programs there a several ways 
on doing the same task. For example, you can get to same customize menu by any 
of the following methods.

• From the View menu select Customize and then Radio Layout.
• From the Toolbar select Customize.
• Right click over most locations except the frequency display and select 

Customize Layout.
• Press [Ctrl+F8]

You will find this to be true for most of the functions within Ham Radio Deluxe. 
Use whatever process that you like the most. That’s it for the introduction. Let’s 
move on to learning more about Ham Radio Deluxe.
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2  Getting Started
Rig Control Tour

The Ham Radio Deluxe program has many, many features. This section attempts 
to describe the essentials you need to know to get started. Ham Radio Deluxe is 
designed to be intuitive; nevertheless even the most experienced user has prob-
lems remembering all the available options!

To aid in the clarity of the screen shots the LCD Scheme is used and we will con-
tinue to use the Dem-o-matic TS-2000 so that you can follow along if you like.

Tuning the Radio
OK! We know you want to find if this software works. Take a few minutes to 
search the bands to see if you can hear anyone. Please come back and we will help 
you get more comfortable with the many features and benefits of Ham Radio 
Deluxe.

Frequency 
Selection

You can adjust or select a frequency in several different ways. The currently 
active digit has a bar above and below the digit. Our example above has the active 
digit, which is 3, for the main band and for the MHz “5” on the sub band. You can 
change the active digit by either clicking on it or using the left or right arrow keys.
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Mouse Wheel
When you rotate the mouse wheel in the frequency display the currently active 
digit is incremented / decremented depending on the scroll direction.

If you rotate while the cursor is over an inactive digit then the digit is activated.

Up/Down
The up-arrow, down-arrow, - and + keys increment / decrement the active digit.

Mouse-click
Select a digital by clicking over the digit. To increment / decrement click above /
below the center of the digit and keep the mouse button pressed.

Direct Entry
You have two ways to do direct entry of a frequency.

Choice A
To enter values just press a numeric key (0-9). The active digital is updated and 
the next digit to the right is made active.

Choice B
1 With your cursor placed anywhere with the rig control window press Enter 

to display the Enter Frequency window.

2 Enter the new frequency, and then press Apply.
If you check Auto-apply then the new frequency is applied every time you make a 
change.

If you check Track this window is updated with changes made to the frequency 
display – for example when you tune the radio manually.

Griffin etc.
Support for third-party devices such as the Griffin Powermate is available – see  
Keyboard Accelerators on page 46.

Tuning Dial Fine Tuning

There are two fine tuning ranges – Fine I and Fine II. In the Tuning menu select 
Show Fine II to show the second range. (If you are only showing the default Fine 
I, then the title is Fine.)

Set the range from the Tuning menu or by clicking the  button.

To change the mouse wheel step, click the  button (also set with the Mouse 
Wheel pane of Program Options on page 50). 
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This allows you to easily make small adjustments in the frequency. To change the 
frequency either:

• Drag the marker with the mouse (and keep on dragging – the bar will scroll 
to the left or right),

• Rotate the mouse wheel (press Shift to increase the mouse wheel step by a 
factor of 2, press Ctrl to increase by a factor of 5),

• Click in the tuning bar or on frequency text such as 14.235.0.

Main Tuning

The differences between a main tuning bar and a fine tuning bar is that the main 
tuning bar shows the whole band range as defined by the band layout.

Band Selection The Band Section buttons are shown between the Fine and Main layouts.

The buttons currently displayed are:
• ALT,
• BSP,
• Band buttons – 160m, 80, … and 10m.

ALT – only displayed if you have two VFO’s displayed (for example Kenwood 
TS-2000), switches between the main and alternate (second) VFO. When high-
lighted you are tuning the second VFO with the tuning dial.

BSP (bandspread) – when you press BSP a new layout is dynamically created. 
The current band is split into multiple segments, for example the 20m band (14 
MHz – 14.350 MHz) can be split into 7 segments, each of 50 kHz. To restore the 
previous layout press BSP and select Off.

The band buttons select the corresponding band; the last used frequency and mode 
for the band are restored. They also show which bands are currently displayed. 
The displayed bands have the text in white while the hidden bands text is dis-
played in grey.
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Display Scroll
If there is not enough room to display all the frequency ranges defined in the 
current band layout use this button to scroll the frequency ranges (bands) up 
or down

Mode Selection As you would now expect, there are several ways to select your operating mode. 
The most obvious method to click on the small mode display above your dis-
played frequency.

A small button just above the frequency display shows the current mode. To select 
or change the mode click on this button. A drop-down menu will come up where 
you can choose which operating mode you want to use.

Another method of selecting an operating mode:
1 Select an operating mode is to press the Selection button in 

the toolbar.
2 In the drop down that opens select Mode.
3 Select the desired mode.
4 If you would like to close the selection window press the X 

in the top right corner of the selection window. Check the 
next page for more information on the selection window.

Your rig configuration may have a list button displayed to 
allow to change the operating mode. This button is usually 
located in the upper right corner of the button display at the 
top of the screen. Press the selection arrow and make your 
choice.

Controlling Your Radio’s Features
One main reason you have obtained Ham Radio Deluxe is to control your radios 
many features from one location. You have already seen how easy it is to tune 
your radio and select the operating mode without touching the radio. Let’s explore 
how to access the other features.

Buttons Located on each side of the frequency window are buttons. All kinds of buttons. 
The first impression is, wow this is great. Then the cold reality hits you that you 
need to figure out what they all do. The good news is they are laid out with a plan. 
You can change the layout to suit your needs add operating style. We will get to 
that later.
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Tuning Control 
To the left of the frequency window is a group of 
buttons that aid in tuning your radio.

Press a button to activate the option. If it is a but-
ton where the option state can be read from the 
radio – for example the selected VFO A– the but-
ton indicates whether the option is currently 
selected.

The buttons displayed will depend upon the radio 
that is connected to Ham Radio Deluxe.

Radio Feature Control
To the right of the frequency window 
is a group of buttons that control fea-
tures of your radio. This display will 
be different for each model of radio. 
The Kenwood TS-2000 is used for 
this example. 

We see buttons for antenna selection, 
noise reduction, attenuation and pre- 
amp control to mention a few.

Drop Downs Drop downs are multiple choice buttons and are most often 
located in the top right portion of your screen. . When to press a 
drop down button a popup menu is displayed. Select an option or 
press escape. If possible the drop down displays the current 
selected option.

The drop down buttons displayed will depend upon the radio 
that is connected to Ham Radio Deluxe. The layout for your 
radio can be changed in the Customize Layout. More on that later.

Sliders If your radio has the option for slides, they can be 
displayed either by pressing the Sliders button on 
the tool bar or by clicking on View in the menu bar 
and and selecting Slider controls at the bottom of 
the list. 

Use the mouse to adjust a slider value.

To select the sliders that are displayed with the Sliders – see  Sliders: Appearance 
on page 44.

.Menus and Toolbars
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Menu Bar The menu bar is very similar to any other program that you have used. You can 
find all the commands available somewhere in the menu bar. This bar also shows 
you keyboard shortcuts when they are available. We will refer to the menu bar 
many times as you read through this manual. Take a moment and look in each of 
the menu item by clicking on the item.

Toolbar The toolbar hold the tools that you will need most often when using Ham Radio 
Deluxe. Each icon displayed is a functional button for selection of that task.

The Connect tool, which you have already used, is for connecting your 
radio to Ham Radio Deluxe. You can have more than one radio con-
nected at a time. This could easily happen when working a satellite or 
connecting to a dx cluster.

The Selection tool toggles a menu pane along the left side of your screen 
that allows you to have many selections available quickly. 

1  Press the Selection Button.
2  Select Menus. You will see a list of the 
possible signal modes displayed.
3 Select Advanced. You see a list that does not 
mean much yet partly because you can see 
only a small portion of the window. 
You need to move your cursor onto the right edge 
of the selection menu. Press the left mouse button 
and drag the window wider.

You now see both the option and the value. For this 
radio, you have a set of sliders that do the same 
function as the slides at the bottom of your screen.

Your screen should now low something like the 
image below. Place you mouse on the grey area 
of the slider and move it to the right. You should 
see the value changing in the middle of the 
slider.
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The Selection menu is also available by selecting Favorites > Display from the 
menu bar.

Select Favorite to add a selection to your favorites list. The list is dis-
played from the Selection tool that we just discussed or by selecting 
Favorites from the Menu Bar and choosing Display.

When you press Favorite, a dialog appears that allows you to add a new favorite.
1 Press the Favorite button.

2 In the field labeled Title enter [WWV 10.000 MHz]
3 In the field labeled Freq: enter [10.000.000]
4 Click on the Mode box and select AM.
5 Click on OK to save your new favorite.
6 Look at the bottom of your Favorite list and you should see your latest 

creation.
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Quick Save tool as the name implies is a way to rapidly save marker so 
you can move between the selections with a click of the mouse. The 
markers are displayed above the frequency band at the designated fre-
quency.

We will discuss this more later. Please see  Quick Save on page 59

The Full Screen tool toggles Ham Radio Deluxe into an out of Full 
Screen Mode.

Try clicking it and view the results.

The Logbook tool starts the Ham Radio Deluxe Logbook application.

The Satellites tool starts the Ham Radio Deluxe Satellite Tracker appli-
cation. This application show the current location of many satellites and 
will run without a radio attached.

The SW Data tool toggles the Shortwave Database which displays at 
the bottom of your screen.

The Sliders tool toggles the slider controls at the bottom of the screen. 
This button will be grayed out for radios that do not have this option 
available for controlling functions.

The Customize tool opens the Customize Display dialog where you can 
modify you display. We touched briefly on this in the last chapter and 
we will cover it in detail later. Please see  Customize Layout on 

page 37.

The Options tool opens the Options dialog where many settings can be 
made. The dialog is a chapter all by itself. Please refer to  Program 
Options on page 46/

The Add tool adds an entry to the Logbook. This will open a dialog 
window if you have Logbook open.
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The DM780 tool starts Digital Master 780 which is a Ham Radio 
Deluxe application for operating in the digital modes. To use this appli-
cation you must be able to pass audio to and from your radio through an 

interface. Please refer to   Digital Master-780 on page 159 for more information. 

There a few other tool in the tool bar but we will leave them for later as they are 
for advanced features not used to get started in Ham Radio Deluxe.

Frequency Display

The image above shows the default view of the frequency display. We have the 
mode for the main band at the top enter of the display. Below that is the frequency 
setting for the main band. 

The lower right area displays the sub band if it is available. Not all radios have the 
sub band available. The lower left displays the meters if the radio sends that data 
out.

Enhanced 
Display

You have the option to add additional information to the frequency display by 
changing your Customize Layout Options. To do that:

1 Click on the Customize button on the tool bar. This opens the Customize 
Layout dialog.

2 Select the Frequency tab.
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3 In the Dropdowns area of the dialog select All. 
You should see additional items displayed at the top of the sample main display. 
The actual items that will be displayed depend upon the radio you have 
connected. With the Kenwood TS-2000 that we are using for our examples we 
have several items that will display.

4 Click on OK to accept the change.
Your frequency display should now look something like this:

You can click on any of these drop downs and change their settings from a list. If 
that is too much information, you can go back and select Mode.

Configuration See  Frequency Display on page 43.

Band Layout 
Selection

The current band layout is displayed below the frequency 
display and able the fine tuning bar. 

Click here to select a different layout from the Bands 
menu. If you reside in the americas, select Region 2.

Date & Time By default the date is displayed to the left of the Band Layout and the time is dis-
played in local format to the right of the Band Layout. This can be changed by 
clicking on each to set the clock and time format.
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3  Configuration
Customize Layout
Introduction In the previous chapter we explored the layout as delivered. We did do some small 

acts of customization We will now explore most of the items that can be changed, 
modified, or even removed. The final layout is up to the user to define. Just 
because it is delivered as the default view, it may not be what you want or desire. 
Before you start making wholesale changes, make sure that you have your radio 
connected and working.

There are, as usual, several ways to navigate to the Customize Layout dialog win-
dow which is used to define the appearance of the radio display. Your choices are:

• From the menu bar select Tools. Near the bottom of the selection box, click 
on Customize Layout.

• Press Ctrl+F8 keys.
• Press the   Customize button on the tool bar.

Schemes

The first tab on the display is Schemes. Schemes are pre-defined customizations 
created by the Ham Radio Deluxe software creative team and other Ham Radio 
Deluxe users. There are four default schemes shipped with Ham Radio Deluxe: 
Scheme #1 - #3 and the System Default. You can not change the look of the 
default schemes.
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Note:  The scheme that you choose applies to all radio windows.

You can add or modify schemes displayed in the large Schemes list. The Ham 
Radio Deluxe team and the Ham Radio Deluxe users have already created the 
schemes that are there. Special thanks to Danielle in Northallerton, UK. for his 
contributions.

• Select a default scheme by pressing the scheme button (or select an entry 
and press Select); 

• Select one of the other schemes by double-clicking on the entry in the 
Schemes list.

If you have modified a layout scheme and wish to save it with a new name press 
Save and you will be prompted for a Scheme name. Use Rename and Delete to 
organize the available schemes.

If you need to save the file to a location different than the default location press 
the Save as File button. This allows you to save your options file to any location.

If you receive a options file from someone else, you can add it to your copy of 
Ham Radio Deluxe by pressing the Load from File button and navigating to the 
options file location and selecting the file.

Layout

The next tab is the Layout tab. This is where we can modify the screen layout for 
our buttons and drop downs. This is one place where personal preference will 
cause you to pull your hair out because things are not where YOU want them. Re 
mapping the layout is really quite easy.
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Ham Radio Deluxe is a data-driven program. For each radio there is a table of 
supported commands and associated button / drop down / slider names. The lay-
out order is more-or-less alphabetical. Don’t be put off by the amount of informa-
tion in this window – take it slowly and read the information here.

Note:  The layout definition is saved on a per-radio basis in the registry. For 
your sanity only have a connection open to the radio that you plan to 
modify the layout. Close any other radio connections.

This small portion of the dialog allows us to do amazing things.

Clear Entry
If we click on a button above the area such as the VFO A button, we can clear the 
button so we can use the location for some other function. This is done by clicking 
the Clear button. We can also remove an entry by dragging it into the Unassigned 
list on the right side of the dialog box.

Moving Entries
We can move the selected entry by simply dragging it with the mouse 
or by using the four arrow-buttons.

Dropdown Button / CAT Command / Macros
You can create new buttons - for example, to create a USB button from the Mode 
dropdown:

1 Open the Customize Layout dialog and click on the Layout tab.
2 Select or create an empty button position – the selected entry will start to 

blink (you can reposition this button later),
3 In the Define Button area of the dialog, press Select (above the Save and 

Load buttons), This will open the Configure Button dialog.
4 In the Configure Button dialog window select Mode: LSB and enter the text 

to appear on the new button.
5  Press OK.
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6 Press Apply in the lower left corner of the current screen.
7 The previously empty button position now has a new value – LSB!

If you had previously created a macro or created a custom CAT command, you 
would have had the choice of applying one of them to your button. We will cover 
macros and CAT commands later in this manual.

Hiding Dropdowns
Hide dropdowns hides the dropdown buttons 
on the top right edge of the layout window, 
releasing two columns where you can assign 
new button definitions.

Hide status texts hides the three top-left 
meters (-1-, -2-, -3-) and the status text area 
underneath, releasing two columns where you 
can assign new button definitions.

Dropdowns
Select the dropdown menu, and then simply drag 
an entry to an unused location in the display.

If you drag to a location that already has a defini-
tion the current definition is removed, if a stan-
dard button it is returned to the unassigned list.

Unassigned
Entries in the Unassigned list are standard but-
tons that are not currently displayed. Simply 
drag an entry to an unused location in the dis-
play.

If you drag to a location that already has a definition the current definition is 
removed, if a standard button it is returned to the Unassigned list.
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Styles
In the Buttons tab you can define up to seven button styles, 
shown here in the Button Styles group. The Buttons tab is 
the next tab we will visit.

To assign a style to a button either:
•Drag the style over the button, or
•Click a style to apply it to the currently selected (blinking) 
button.

Save / Load
To distribute your layouts with other users of your radio 
model use the Save and Load buttons. You can also clear 
the deck and start over fresh or revert back to the default 
button layout.

Customizing 
Buttons

Within the Buttons tab you can define:
• Seven button color combinations,
• The font, and
• The button size.

The default button size is small; this is so that users with low resolutions such as 
800 x 600 still have a usable configuration. There are no rules when using the but-
ton size; select the size which pleases you most.
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For the technical readers the button size is tied to the font size of the radio display 
form (font is Microsoft Sans Serif, size is 8, 9, 10 or 12 point).

Changing the font size simply changes the font assigned to the form.

The button size can also be changed by selecting View on the menu bar and then 
selecting Layout Size. You can also [right click] on any button on your display 
and select Layout Size.

Faceplate

Background
These colors are applied to the background area of the display and to the transmit 
meters (if any) such as PWR, SWR and ALC.

Status Window
The status window displays information which you cannot normally change using 
buttons or sliders in Ham Radio Deluxe.

Typical examples are Scanning status, Split mode and Memory channels.

Clock Position
The clock is displayed to the left, right or both sides of the band title.
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Frequency 
Display

If your radio supports simultaneous access to two VFO’s (Kenwood, some Yaesu) 
then Ham Radio Deluxe will display two VFO’s, otherwise just one VFO is dis-
played.

First select the VFO you are updating – main or sub. The colors you can set are:
• Background,
• Frequency – the digits,
• Active Posn – the bar above and below the current digit,
• Inactive Posn – the bar above and below the other digit. Default is the same 

as the background color.
The Font can also be set, use the Main > Sub and Sub > Main buttons to copy 
settings between VFO’s.

Dropdowns
The dropdown buttons (Mode, Filter…) can be displayed at the top of the main 
frequency display.

Select:
• None (no dropdowns),
• Mode (only the mode dropdown) or
• All (all dropdowns).

If Mode or All is selected you can check Add Border to add a border around the 
text.

If All is selected you can check Include Title to add the Dropdown button’s title 
(if there is room).
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Customize 
Meters

The Background and Text colors should be obvious. There are three graduation 
colors:

• Bars: Low – the first bar color,
• Bars: High – the color at the position set by the High Position slider, and
• Bars: Free – the color for the free (empty) bars.

If you check Show peak reading the recent peak value is displayed.

When Ham Radio Deluxe is in TX mode the S Meter value is replaced by the 
value selected in the Main and Sub dropdowns, the value you select must be dis-
played by Ham Radio Deluxe in the upper right hand corner of the display. For 
Kenwood radios the value to be displayed is selected with the meter slider or the 
individual buttons (SWR / Comp / ALC / dB).

If you check the Always update… option then the S Meter is updated when you 
change frequency – this results in slower performance.

Sliders: 
Appearance

If supported by your radio, sliders are displayed at the bottom of the display. Here 
you define the appearance of the sliders. These colors are optionally applied to the 
sliders in the Advanced selection windows (select Advanced from the View 
menu).
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Sliders: Layout

Here you select the sliders to be displayed. Define up to six layouts, for example 
one layout for SSB and another for CW.

Tuning Dial

Here you define the colors, fonts and band button positions.



46 Ham Radio Deluxe

Program Options Chapter 3 - Configuration

Program Options
Introduction Used to define various Ham Radio Deluxe features, Program Options can be 

selected in three different ways:
• From the menu bar, select Tools > Program Options at the bottom of the 

list.
• Press F8

• Press the   Options icon on the toolbar. 

Most users will find that they can live with the defaults that can be modified in 
this dialog.

Keyboard 
Accelerators

Define accelerators for use with the Keyboard or with programmable interfaces 
such as the Griffin Powermate.

When you press Add the definition window is displayed.
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Keyboard combinations are assigned to display buttons and arrow keys. As an 
example, we will assume that we want tot assign the key combination  
Ctrl+Alt+W to the Tune button. To do this we would do the following steps:

1 In the Key field we would enter the letter W.
2 Place a check mark in the boxes preceding Alt and Ctrl.
3 In the text box below HRD Button enter the word Tune.
4 Press OK to save your new accelerator.

You will now see your new accelerator listed.

The Ham Radio Deluxe menu has pre-assigned accelerators; these cannot be rede-
fined. These are listed in the Reserved window.

Comms

Normally you will not have to change the default settings.
• Read timeout – serial port timeout.
• Switch off – some radios such as the FT-817 or the Kenwood TS-2000 can 

be powered down using a CAT command. If this option is selected you are 
prompted to switch off the radio.

• Polling – to reduce CPU load for slower systems.
• Dual VFO tracking – if selected both VFO’s are tracked on every refresh. 

Only of use with Satellite Tracking ( Satellite Tracking on page 209).
• Refresh interval – the interval between consecutive refreshes of the display.
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COM Port TX

Some early ICOM radios do not support switching between TX and RX using 
CAT commands. The only way to enable computer controlled TX/RX this is by 
toggling a COM port pin.

You require a special CAT cable if you select this option.

ICOM 
Calibration

ICOM radios return a S Meter value between 0 and 255, normally 0 is S0, 12 is S1 
and so on. As a S Meter unit is 6 dB the algorithm applied is to divide the returned 
value by two to get dB, then divide dB by 6 to get S units.

Some radios such as the IC-706 have a different logic – use the Offset and Scale 
values to adjust the returned values so that the S Meter in Ham Radio Deluxe cor-
responds to the S Meter on your radio.
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Internet

Ham Radio Deluxe is able to detect whether you have an Internet connection with 
Internet GetConnectedState(). Uncheck this option if you do not want Internet 
access.

Out Of Band

If you like to know where your band limits are when you are scrolling through a 
band and not watching the frequency window you can enable the optional sound 
files played when you tune in / out of band. You also have the ability to use a 
sound file of your choosing.
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Mouse Wheel

You can define the tuning step when rotating the mouse wheel over the active tun-
ing bar here. 

Selection 
Window

Defines options affecting the appearance and operation of the selection window.
• Single-click – normally the Favorites tree folders are opened / closed with a 

double-click. Check this option to enable single-click operation.
• Show numeric value – the Select Windows‟s Advanced slider values are 

optionally superimposed on the slider.
• Show the Options icon – historical support for the version 2 Advanced slider 

look and feel.
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Themes

Docking panes are used for optional windows such as: Bandscope, Calendar, DX 
Cluster, Logbook, Selection, Shortwave Database and WinKey.

Main Theme
Select whichever visual theme you want – Office 2003 is an acceptable default.

System Theme
When you select Office 2003 or Windows XP for Menus and Toolbars you can 
select an optional System theme.

Main Tabs
If you have more than one main window open – for example Radio and Logbook 
– then the main tabs are a useful way of switching between windows.

Main tabs can be toggled On / Off by selecting from the Menu Bar View> Main 
Tabs.
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Updates

Select how frequently Ham Radio Deluxe reminds you to check for new updates.

Yaesu

Special options for Yaesu radios. Due to firmware “features” in the FTDX-9000 it 
is necessary to wait up to 250ms after writing a command to the radio. With any 
luck Yaesu will fix this at some date in the future. 
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Band Layouts
Introduction A necessary feature of a fully customizable radio program such as Ham Radio 

Deluxe is the definition of custom band layouts.

The IARU regions have own band plans; there is no doubt that these will change 
in the future. Consider also the traditionalist who has never owned a microphone 
in his life and is only interested in the CW portions of the bands – he wants his 
own band layouts.

With this feature you can edit any band so only the frequencies are shown which 
are allowed by your License class. You can then activate the Out-Of-Band alarms 
to notify you when you tune outside of your allowed frequency ranges.

Manager To start the Manager do one of the following:
• Select Manager from the Bands menu. or 
• Press CTRL+B.

Here you see the existing definitions. In the Edit menu you have the expected 
New, Copy, Edit and Delete options.
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Adding A 
Definition

In this example a band layout is 
created for our CW enthusiast. 
Select New from the Edit menu to 
create a new definition using the 
Band Layout Editor.

1 In the Title field enter CW 
Only.

2 From the Edit menu select 
New to define a new 
frequency range.

3 In the Band field enter [160m]
4 In the From field enter 

[01.800.000]
5 In the To field enter 

[01.830.000]
6 Ensure Enable is checked
7 Press OK

When you press OK the frequency range is added to the band layout. Repeat the 
steps above for 80m and 40m using the values below:

• 80m, 3.5MHz to 3.55MHz, (Remember the leading zero)
• 40m, 7.0MHz to 7.05MHz. 

The band layout now looks like this:
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To rearrange the order of the frequency ranges just select a range and 
use the Move menu options or the Move buttons.

8 When you have finished your new layout press OK. The CW Only definition 
is added to the band layouts. 

9 In the Band Layouts window press OK to save the definitions and close the 
window.

Copying A 
Definition

To copy an existing band layout:
1 Start the Manager,
2 Select the entry to be copied,
3 Select Copy from the Edit menu,
4 Enter the new title,
5 Change the frequency ranges are appropriate,
6 Press OK.

Selecting To select a band layout either:
• Open the Bands pane in the Selectionwindow 

(select Display from the Bands menu) and select an 
entry in the list, or

• Click on the Band Title 160m – 10m (Region 1) in 
the radio display and select a new layout from the 
popup window.
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Favorites
Favorites was introduced in the Getting Started chapter. We will now look at the 
favorites manager in detail. Favorite definitions are selected from the Favorites 
pane in the Selection window.

Manager Start the manager from the Favorites menu or the Favorites pane in the Selection 
window. It is designed to be easy to use – let’s see.

The favorites manager, as the name implies, provides a means to manage your 
favorite frequencies. The can be grouped in Root folders my band, mode, topic, or 
interest. New Root folders are created using the New Root button. Root folders 
can have sub folders to help further group your favorites. These sub folders are 
created using the New Folder button. You add your favorite frequency using the 
Add button.

Root folders and their associated sub folders can be turned on and off by checking 
or unchecking the box in front of the folder. If for example you do not have an 
antenna for 160m, you can uncheck the box in front of the folder and 160m will 
no longer be listed in the Favorites pane of the Selection window. They will still 
be visible, however, in the band display above the 160m band.

New Root – create a new top-level (root) folder. Folders are not saved if they are 
empty (no child folders or definitions). An example would be a Root Folder 
labeled JOTA for Jamboree on the Air.

New Folder – create a new folder as a child of the currently selected folder. An 
example would be to create a sub folder under JOTA labeled SSB or CW.

Root Folder

Sub Folder

Favorite Freq.
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Sort Folder – sort the entries in the currently selected folder:
• By title,
• By ascending frequency, or
• By descending frequency. 

Add – add a new definition. If you have crated a new empty folder, you can not 
add a favorite frequency to it. You need to add the frequency to either a higher 
level folder or in a folder that has favorites in it. You can then move the new 
favorite to the new folder that you created earlier.

To add a new favorite frequency to an existing folder:
1 Click on the folder that you wish to add a favorite to.
2 Click on Add.
3 Enter a title for your favorite.
4 Enter the desired frequency without the decimal point. 

If you are adding a frequency that starts with a single digit before the first 
decimal point, place your cursor immediately adjacent to the left side of the first 
digit.

 with two

If you are adding a frequency that starts with two digits before the first decimal 
point, place your cursor a bit further to the left so there is a small space between 
the cursor and the leading zero.

For three digits place your cursor a bit more to the left.

5 Select you operating mode.
6 Click on OK and your new favorite will be saved in the selected folder.

You can also select Add from Favorites in the menu bar to add a new defini-
tion.You can also use Cntrl+A keystroke combination to access the add function.

No space

Note the space
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Del – delete the current folder or definition (depending on which you have 
selected).

Move – move an entry to another folder (alternatively drag entries between fold-
ers with your mouse).

1 Highlight the folder or definition.
2 Click on Move.
3 Select the new folder. 
4 Click on OK. 

Copy – make a copy of an existing definition. 

Edit – edit the selected folder / definition.

Arrows – rearrange the selected folder / definition.

Load – load a new set of definitions from a file previously created using Ham 
Radio Deluxe; all current definitions are discarded.

Merge - merge definitions from a file previously created using Ham Radio 
Deluxe. Defaults – restore the default list (hard-coded into Ham Radio Deluxe).

Save – save current definitions to a file.

Favorites 
Markers

To display your favorite markers in the Ham Radio Deluxe display select Show 
Markers from the Favorites menu. The marker size is selected from the Marker 
Size option in the Favorites menu.

The popup text is displayed as you move the mouse pointer over a marker. The 
text is constructed from the favorite title and frequency.
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Quick Save
Introduction This is a simple way of marking a frequency as being interesting – you are moni-

toring three QSO’s with a single radio and you want to quickly switch between the 
frequencies – for example during a 6m sporadic-E opening.

Each definition consists of the frequency in Hertz and mode; definitions are saved 
in the registry.

To switch between Quick Save definitions use the accelerator key combinations 
for the Quick Save menu options Next (Ctrl+F5) and Previous (Ctrl+F6).

Add Entry Select Add from the Quick Save menu or just click the Quick Save but-
ton. An entry is added to the Quick Save pane in the Selection window.

Quick Save 
Markers

To display Quick Save markers in the Ham Radio Deluxe display select Show 
Markers from the Quick Save menu. The marker size is selected from the Marker 
Size option in the Quick Save menu. This only toggles the Quick Save markers. It 
does not toggle the Favorites markers.

The popup text is displayed as you move the mouse pointer over a marker. The 
text is constructed from the frequency and mode.

Macros
Introduction Ham Radio Deluxe supports two types of custom 

definitions:
• CAT commands
• User defined macros which are a combination of 

standard Ham Radio Deluxe input fields
Macros are selected from the Macros pane in the 
Selection window.

CAT Commands A CAT command macro is a command that you define yourself, containing one 
CAT commands as describer in your radio’s handbook. The commands you enter 
must be supported by your radio.

Use CAT commands to add support not provided by the Ham Radio Deluxe inter-
face.

Manager
To open the CAT Command macro manager do one of the following:
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• Press Manager in the Macros> CAT Commands selection pane 
• Select CAT Command Manager from the Macros menu

1 Press New to create a new command definition.
In this example a Kenwood command is defined for the TS-2000. The mode is 
set to USB and the frequency to 50.150 MHz.

2 In the Title field enter [50.150 MHz USB].
3 In the CAT Command field enter the following commands:
# Set mode to USB. 
MD2
# Set frequency to 50.150 MHz
FA00050150000

4 In the Description field enter [Change frequency to 50.150 MHz, mode to 
USB].
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5 Click on OK. The new definition is added to the list in the Manager window.

Protocols Reference
Each brand of radio has a slightly different protocol for their CAT commands. 
Below is are examples of the differences. For complete information, please refer 
to the operating manual for your radio.

ELECRAFT AND KENWOOD
Each command consists of two alphabetical characters (lower or upper case) and 
optional parameters. 

The terminating semicolon (;) is not necessary, it is added automatically.

TS-480, TS-2000
Set mode to LSB .....: MD1
Set mode to USB .....: MD2
Set AF gain to 0 ....: AG0000
Set AF gain to 100 ..: AG0100
Select VFO-B ........: FT1

You can define more than one command; to do this start each command on a new 
line.

Special Commands
Comment ..........: # Some interesting text. 
Pause of 250 ms ..: @ 250

ICOM
ICOM radios use the CI-V format to communicate with the radio. Please read 
your operating manual for command information.

Each entry defined here consists of:
• [1] command,
• [2] optional sub-command and
• [3] optional data.

You must add a - between each byte (each byte is two hexadecimal characters).

IC-7800
Set mode to LSB ..........: 06-00
Set mode to USB ..........: 06-01
Set AF to 0 ..............: 14-01-00
Select preamp 2 ..........: 16-02-02
MOD I/P (data off) MIC ...: 1A-05-00-31-00
MOD I/P (data off) SPDIF .: 1A-05-00-31-07

You can define more than one command; to do this start each command on a new 
line.

Special Commands
Comment ..........: # Some interesting text. 
Pause of 250 ms ..: @ 250

TEN-TEC
In general Ten-Tec commands are two character commands followed by data and 
a carriage return <cr> or <0x0d>. Do NOT add the carriage return - this is added 
automatically.
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Some data must be sent in binary format, hexadecimal is used to represent binary 
data. To set Split mode on for the Argonaut the documented command is 
*O<0x01><0x0d> which is entered here as *Ox01, that is *O (Split mode) + x 
(switch to binary) + 01 (Split On). The carriage return <0x0d> is not added. 
Please read your operating manual for command information.

When you enter x the format switches to binary mode - two hexadecimal charac-
ters per byte. Only enter x once, even if entering more than one byte of data.

Argonaut
Set mode to LSB .....: *M2
Set mode to USB .....: *M1
Set split mode on ...: *Ox01
Set split mode off ..: *Ox00

Jupiter
Set mode to LSB .....: *M2
Set mode to USB .....: *M1
Set AF gain to 32 ...: *Ux20
Set filter to 450Hz .: *Wx1D

You can define more than one command; to do this start each command on a new 
line.

Special Commands
Comment ..........: # Some interesting text. 
Pause of 250 ms ..: @ 250

YAESU
Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very 
similar to that used by Kenwood. So if you are fortunate enough to have the 
FTDX-9000 please use the Kenwood commands – See “ELECRAFT AND KEN-
WOOD” on page 61.

Each Yaesu command consists of five bytes. The bytes are defined in the order in 
which they are sent to the radio. You must add a - between each byte.

Each command consists of four bytes of data and an OpCode. The order in which 
P1-P4 are shown in your operating manual does not matter here - there are differ-
ence between Yaesu radios, just remember that the bytes are defined in the order 
in which they are sent to the radio. 

FT-817
Set mode to LSB ..: 00-00-00-00-07
Set mode to USB ..: 01-00-00-00-07
Split on .........: 00-00-00-00-02

FT-1000MP
Set mode to LSB ..: 00-00-00-00-0C 
Set mode to USB ..: 00-00-00-01-0C 
Split on .........: 00-00-00-01-01

You can define more than one command; to do this start each command on a new 
line.

Special Commands
Comment ..........: # Some interesting text. 
Pause of 250 ms ..: @ 250
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User Defined 
Macros

User created macros are combinations of fields on the Ham Radio Deluxe radio 
display. Users of Microsoft Office will be familiar with the concept supported 
here. When you start out you will see a Macros: Default sub tab in the Selection 
window. This name will / can change depending on how you define your macros. 
You can also add more sub tabs allowing you to sort your macros in a manner con-
venient to your operating style. Let’s do a couple of examples.

Manager
Select Manager from the Macros: Default menu, and then press New to create 
our first new macro. This macro will switch your radio to 50.150 MHz in USB.We 
will put it in a new sub folder called “Simple”.

First we will name the macro and where it will reside. We can then set the mode to 
USB:

1 In the Title field enter [50.150 MHz USB].
2 In the Group field enter [Macros: Simple].
3 In the Description field enter [Change frequency to 50.150 MHz, mode to 

USB].
4 Press Add to open the Macro Editor.
5 Click on Dropdown Button 
6 Select Mode: USB

7 Press OK.
Now we need to set the frequency to 50.150.000:

8 Press Add again to open Macro Editor
9 Click on Frequency button
10 Enter [50.150.000 MHz].
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11 Press OK. Your definition now contains two entries:

12 Press Save, this returns you to the Macros Manager.

13 Press OK. The window closes.
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Another Example
This macro will switch your radio to 14.070 MHz in USB.We will put it in a new 
sub folder called “PSK”. 

1 Reopen the Macro Manager which now can be found in the Macro: Simple 
sub-folder.

2 In the Title field enter [20M PSK].
3 In the Group field enter [Macros: PSK].
4 In the Description field enter [Tune radio to 20M PSK].
5 Press Add to open the Macro Editor.
6 Click on Dropdown Button 
7 Select Mode: USB

8 Press OK.
Now we need to set the frequency to 14.070.000:

9 Press Add again to open Macro Editor
10 Click on Frequency button
11 Enter [14.070.000 MHz].
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12 Press OK. Your definition now contains two entries:
13 Press Save, this returns you to the Macros Manager.

14 Press OK. The window closes.
You now have two sub-folders of macros 
displayed in the Selection window. You can 
create more to match your operating needs.

Snapshots
The snapshot button creates a 
definition that contains the state of 
all input fields. This is an easy 
way of preserving a known state 
of your radio once you have set it 
up exactly the way you want. You 
can add functions as you did pre-
viously to further enhance your 
snapshot.

Your snapshots will be found in their own 
sub-folder of macros.
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4  Remote Radio Control
Remote Station Support
Introduction A popular feature found in Ham Radio Deluxe that is not found in many other 

ham radio software packages is the ability to operate your station via HRD’s built-
in remote server software.

There are places, however, where you may not be able to operate your base sys-
tem from remote. These places are, for example, your work environment where 
the computers you use are behind a firewall or router that are not under your direct 
control. Certain ports need to be available through the firewall and routers in 
order for you to connect remotely to your base station and these may be blocked 
in a corporate environment due to various reasons.Ham Radio Deluxe is evolving 
into a program that supports all the serial port-enabled devices that you control at 
your remote station.

For radio control you use the Ham Radio Deluxe Remote Server. For other devices 
such as keyers and rotators you use the Ham Radio Deluxe Serial Port server. 
Note that the Ham Radio Deluxe Remote Server is highly optimized for use with 
Ham Radio Deluxe and should be used to control the radio.

The Ham Radio Deluxe Serial Port Server enables a connection between Ham 
Radio Deluxe and serial port-enabled devices (keyers, rotators) connected to a 
remote computer that can be contacted via TCP/IP.

Note:  The process of setting up these remote servers is not something an 
inexperienced computer user should attempt. Find a friend who makes 
his living setting up and maintaining computer networks. Be kind to 
them and reward them so they will come again and help when something 
stops working.

Requirements
The remote computer must be running Windows XP through Windows 8.1. Win-
dows server software is also supported for 2003 and higher.

Technology
A Windows service is installed on the remote service. This listens on a port (usu-
ally 7805) for incoming connections from Ham Radio Deluxe (the client). For 
more technical information see  Ham Radio Deluxe Remote Server on page 70

External IP Address
When setting up your remote server there is one important thing you need to take 
into consideration. If you plan to use the remote server and connect from within 
your home network, lets say between the shack and your laptop on the patio out 
back, there will be no problem. You will use the “localhost” or 127.0.0.1 address 
to connect from the remote computer to the host system.

However, if you are planning on connecting to your system via the internet from 
outside your home network you are going to have to know the exact internet IP 
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Address of the computer you are connecting to. This connection must be a full 
time connection.

ISPs assign a Dynamic IP Address to your computer system. For example, your 
dynamic IP address may be 68.74.165.227. This would be the address you would 
use to connect from your remote computer to your base system over the internet. 
The problem comes in when most ISPs change that address from time to time 
without you knowing it. Some change the IP address at random times, others 
change your IP address each time you disconnect and reconnect your modem to 
the internet while others change your IP address each day.

There are two solutions to this problem. The first is to contact your ISP and 
request a STATIC IP address for the system where the remote server is running, 
(your shack computer). This is usually inexpensive, around $5.00 or so a month 
added to your internet bill.

The second solution would be to use a service such as NO-IP, DYNDNS or any 
one of many such services which provide a free solution to the problem of not 
having a static IP address. These services monitor your IP address and track any 
changes while providing you with a constant connection through their DNS serv-
ers so any change in your IP address will not effect the address you use to connect 
to your remote system.If you are installing on a remote computer then the com-
puter must have a static (non-changing) public IP address. If you have a public IP 
address which is not static then visit  http://www.no-ip.com/ and use the free IP 
redirection option.

Internal IP Address
There is another IP address that also requires attention if you plan to run the HRD 
Remote server on a computer in your shack.

If you have only one computer in your shack and it is connected directly to the 
internet via a modem there isn't much problem. A problem arises if you have more 
than one computer in your house and they each connect to the internet through a 
router, wireless or hard wired.

When connected to the internet via a router, each computer connected to the 
router has it's own INTERNAL IP Address. Just like with your Internet IP 
address, this internal IP address can change depending on the sequence the differ-
ent computers are booted up and access the router.

It is advised you set an internal STATIC IP address for the computer running 
HRD's Remote Server software. You will find instructions to do this in the next 
section of this documentation.

Firewall
Make sure you open up ports 7805 (Ham Radio Deluxe Remote Server) and 7806 
(Ham Radio Deluxe Serial Port server) for incoming TCP traffic. This will proba-
bly will need to be done on your router where your internet service enters your 
home. The port assignments can be changed in the configuration files.
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Example

In this example the remote station uses serial ports as follows:
• COM1 --> IC-7800,
• COM4 --> WinKey keyer,
• COM6 --> AlfaSpid rotator.

Two virtual null modem “cables” are installed (pure software, no hardware 
involved). The vCOM driver from N8VB is highly recommended; 

See http://www.philcovington.com/SDR.html. To install the vCOM drivers see  
N8VB vCOM on page 243.

In this example the “cables” map ports as follows:
• COM20 <-> COM21, and
• COM22 <-> COM23.

The local station connects as follows:

IC-7800
Remote port selected, TCP/IP connection made with the Ham Radio Deluxe 
Remote Server running on the remote computer (port 7805).

The Ham Radio Deluxe Remote Server connects to the IC-7800 using COM1.

Keyer
The Ham Radio Deluxe Winkey interface connects to the Ham Radio Deluxe 
Serial Port client on the local computer using the COM20 <-> COM21 virtual 
cable.

The Ham Radio Deluxe Serial Port client connects to the Ham Radio Deluxe 
Serial Port server on the remote computer using TCP/IP (port 7806).
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The Ham Radio Deluxe Serial Port server connects to the K1EL WinKey using 
COM4.

Rotator
The Ham Radio Deluxe Rotator interface connects to the Ham Radio Deluxe 
Serial Port client on the local computer using the COM22 < - > COM23 virtual 
cable.

The Ham Radio Deluxe Serial Port client connects to the Ham Radio Deluxe 
Serial Port server on the remote computer using TCP/IP (port 7806).

The Ham Radio Deluxe Serial Port server connects to the AlfaSpid rotator using 
COM6.

Virtual Null 
Modem 
Software

The vCOM driver from N8VB is highly recommended; see 
http://www.philcovington.com/SDR.html.

This is the same as a null modem cable except it is made using software. The 
vCOM software supports up to 10 cables. Each cable is allocated two COM ports.

You simply connect Ham Radio Deluxe to one end and the Ham Radio Deluxe 
Serial Port Client to the other.

To install the vCOM drivers see  N8VB vCOM on page 243.

Ham Radio Deluxe Remote Server
Gathering 
Necessary 
Information

It is very important to setup a static ip address, if you are going to use port for-
warding. When you have port forwarding setup, your router forwards ports to an 
ip address that you specify. This will probably work when you initially set it up, 
but after restarting your computer it may get a different ip address. When this hap-
pens the ports will no longer be forwarded to your computer's ip address. So the 
port forwarding configuration will not work.

What is an IP Address?
IP addresses are four sets of numbers separated by periods that allow computers to 
identify each other. Every computer has at least one ip address, and two comput-
ers should never have the same ip address. If they do, neither of them will be able 
to connect to the internet. 

Dynamic vs Static IPs 
Most routers assign dynamic IP addresses by default. They do this because 
dynamic ip address networks require no configuration. The end user can simply 
plug their computer in, and their network will work. When ip addresses are 
assigned dynamically, the router is the one that assigns them. Every time a com-
puter reboots it asks the router for an ip address. The router then hands it an ip 
address that has not already been handed out to another computer. This is import-
ant to note. When you set your computer to a static ip address, the router does not 
know that a computer is using that ip address. So the very same ip address may be 
handed to another computer later, and that will prevent both computers from con-
necting to the internet. So when you assign a static IP addresses, it's important to 
assign an IP address that will not be handed out to other computers by the 
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dynamic IP address server. The dynamic IP address server is generally referred to 
as the dhcp server.

Setting Up a 
Static IP For 
Windows 7 

Windows 7 and 8 set up in a similar manner. Windows XP uses a slightly different 
process. If you can, print out these pages of instructions as you will have difficulty 
viewing them online while you preform the config task.

1 Open up the start menu, and look for the Search programs and files box.

2 Type cmd in the Search programs and files box, and press Enter on your 
keyboard. This will bring up a black command prompt window.

3 The command prompt may look different on your screen, but it doesn't 
really matter. Type ipconfig/all in that window, and then press the enter key. 
This will display a lot of information. If it scrolls off the top you may need 
to enlarge the window.

4 Record the following information:
IP address ____.____.____.____

Subnet Mask ____.____.____.____

Default Gateway  ____.____.____.____

DNS Servers ____.____.____.____

____.____.____.____

____.____.____.____

You may not have three DNS Servers. Just leave the unused blank. We are only 
concerned with IPv4 entries, you can ignore the IPv6 stuff.
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The name server entries are a bit complicated. Name Server is just another name 
for DNS (domain name server). Some router's act as a proxy between the actual 
name servers and your computer. You will know when this is the case, because the 
Default Gateway will list the same ip address as the Name Servers entry. 

We need to have the correct Name Server IP addresses. If we do not, you will not 
be able to browse the web. There are a couple ways to get these. The first way is 
to log into your router's web interface, and look at your router's status page. On 
that page you should see an entry for DNS Servers, or Name Servers. Write down 
the ip addresses of your Name Servers. 

Another way to get the correct Name Servers to use, is to give your ISP a call. 
They should know the ip addresses of your Name Servers right off. If they ask you 
why you need them, you can tell them you are trying to setup a static IP address 
on your computer.

5 Type exit in this window, then press the enter key to close it.
6 Once again open the start menu. This time click Control Panel.
7 Click on  Network and Sharing Center.
8 Single click Change adapter settings on the left side of your screen.
9 You might have more than one Internet connection listed here. You will need 

to determine which adapter is your connection to the Internet if this is the 
case. If you have a choice of a wired or wireless connection, choose the 
wired connection.

10 You can either right click or double click on your network adapter and 
choose properties to open up the properties window of this internet 
connection.

11 Click on Internet Protocol Version 4(TCP/IPv4) and then the Properties 
button. 
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12 You will see the following screen:

13 Before you make any changes, write down the settings that you see on this 
page. If something goes wrong you can always change the settings back to 
what they were! You should see a dot in the Obtain an IP address 
automatically box. If you do not, your connection is already setup for a 
static ip. Just close all these windows and you are done.
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Pick an ip address and enter it into the IP Address box. The ip address you choose 
should be very similar to the router's ip address. Only the last number of the ip 
address should be different. If the router's ip address is 192.168.1.1, I might 
choose 192.168.1.10. The ip address you choose should end with a number 
between 1 and 254, and should not be the same as the router's ip address. Every 
device that connects to your network needs to have it's own IP address.

Put the subnet mask we previously found in the subnet mask section. The 
default gateway should go into the Default gateway box. Enter the DNS Servers 
we previously found into the two DNS Server boxes. Click okay all the way out 
of this menu.

If you find that you can not pull up web pages, the problem is most likely the 
DNS numbers you entered. Give your ISP a call, and they will be able to tell you 
which DNS servers to use. 

That's it you should be done! If you can't connect to the internet go back and 
change your configuration back to what it originally was.

 Installing The Ham Radio Deluxe Remote Server files are:
• Ham Radio DeluxeRemoteSvr.exe – the executable, and
• Ham Radio DeluxeRemoteSvr.cfg – configuration file.

To install the service select Remote Service from the Tools> Programs menu.

1 Press Ham Radio Deluxe Remote Server to select this server.
2 Press Install to install the service, and then press Start to start the service.

You can start the Windows Services applet (Start > Settings > Control Panel > 
Administrative Tools > Services) to modify the properties of the service, for 
example disabling automatic startup.
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Firewall
Allow incoming connections on port 7805.

Configuring
Press Configure to edit the file that contains the service configuration. Lines 
needing configuration are highlighted in the configuration file below. Each user 
who accesses the system must have a username and password. A pound sigh (#) 
as the first character of a line indicates the line is a comment and the # must be 
removed from the line before it is recognized by the software.

Config file continues on next page.

#   Ham Radio Deluxe Remote Access Server
#   -------------------------------------
#   Copright (c) 2011-2013 HRD Software LLC
#
#   Note: Remote Server Runs on Windows XP/SP3, Windows7 and Windows 8
#   
#   This file defines the configuration of the Remote Access Server.
#   The format of each entry is TOKEN = VALUE. 
#
#
#   Supported tokens
#   ----------------
#   COM
#   PORT
#   USER1 to USER20
#   WELCOME
#
#
#   A comma-separated list of COM ports that are returned. If not defined then
#   the server returns a list of all COM ports available on the computer.
#
#COM = COM1,COM2,COM3,COM4
#COM = COM3
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The contents of this file should be obvious. After changing the configuration, save 
the changes and you should restart the service.

Restricting TX
One special note – to restrict a user’s ability to switch the radio to transmit there 
are now optional tokens added with the username and password to disable access 
to the TX and any Tune buttons. Add no_tx after the password.

In addition you will want to disable macros as a knowledgeable user can define a 
CAT command to enable TX. Add no_macros after the password.

Enable Restart
The RESTART token enables the Restart button on the connection window. 
Restarting the service will close all COM ports opened by the service and drop all 
connections by Ham Radio Deluxe users.

This should only be allocated to yourself and your friends!

#
##   The TCP/IP port on which the server listens for connections. If not defined
#   then the default value of 7805 is used. Select any port number you want which
#   is not in use by other programs.
#
PORT = 7805

#
#   Username/passwords, these are case-insensitive. Spaces are removed
#   from the beginning and end of the username and password.
#
#   The format is USERx = username,password
#
USER1  = Simon,SnowTime,restart
USER2  = Peter,Uberwald
USER20 = Donald,California

#
#   Welcome text, displayed on the remote user's computer. Note that
#   \n is replaced with a newline. Enter up to 511 characters on a single line.
#
WELCOME = Welcome to the HRD Remote Access Server.\n\nPlease don't break anything!
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Connecting to 
the Remote 
Server

Connecting to the host computer from remote is almost like connecting to the 
radio while on the base computer system.

If you don’t already have it done, you will need to 
1 Install Ham Radio Deluxe, if you have not done so,  on the computer you 

plan to use for the remote connection. 
2 Once installed, run Ham Radio Deluxe. 
3 When the Rig Connection screen appears, you will need to set this up 

EXACTLY as it appears on your HOST system, with ONE exception. 
Instead of entering a comport number you select REMOTE from the drop 
down box as indicated by the red arrow in the image below.

4 Press Connect and the Remote Connection window will display.



78 Ham Radio Deluxe

Ham Radio Deluxe Remote Server Chapter 4 - Remote Radio Control

5 In the New Connection area of this window enter the IP address or the 
domain name of the HOST system. If you are working from inside your 
home through a router, enter the address of 127.0.0.1. The port is the default 
port of 7805.

6 Now you enter a valid user name and password that was configured in the 
Rig Control Configuration file. You can check the Save Settings box so next 
time you connect you just select the connection from the list on the left side 
of the display. The user name and password are not case sensitive.

7 To save these values make sure the Save settings option is checked [X].
8 Press the Connect button. The display will change showing the Com Ports 

in the lower right half of the screen. 
9 Select the com port from the drop down box that connects to the radio at the 

HOST location. You can also uncheck the box for the optional PTT com 
port. 

10 Press the OK button at the bottom of the window and the next screen you 
see should be the rig display from the remote server.

At this point if you have problems connecting to the host machine, you need to 
double check all your settings. Check to make sure the firewall or router are not 
blocking the ports required. If you are still having problems and can’t find the 
answer, feel free to contact HRD Customer support for help.

Load connection information from a file.

 Save connection information to a file.

Press Connect. 

If the connection is successful you will see the confirmation window and the text 
Username / password authenticated. Select a remote COM port, then press ‘OK’ 
is displayed below the Connect button.

Now select the COM port, and then press OK to connect to the remote COM port 
and start the Ham Radio Deluxe radio display.

When the connection with the radio has been confirmed a Remote Connection 
display window shows you the data throughput and average round-trip time.
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Remote Connection

Use the Remote Connection window to show the status of the remote connection.
• Round-trip time: the time required to send a message from Ham Radio 

Deluxe to the remote server and get a response. This will be very similar to 
the value shown when you use Ping to interrogate a remote host. Typically 
values of 50 milliseconds or less are very usable.

• Refresh interval: the interval between refreshes of the selected Regularly 
Read options.

• Send frequency: when the frequency is updated over a link with a high 
round trip time (> 100ms) the performance will be less than optimal with 
Sync selected so if the round trip is high select Async, otherwise just select 
Sync. The disadvantage of using Async is an 'elastic band' effect while 
tuning by dragging Ham Radio Deluxe's small tuning marker.

• Regularly Read: the options that are regularly updated. If you are using a 
fast link - for example to a local station with a low round- trip time then you 
can safely select all options. The disadvantage of selecting options such as 
Buttons, Dropdowns, Sliders and Status Texts is that it may take a second or 
two before Ham Radio Deluxe detects that you are changing the frequency 
by dragging the tuning marker and the current refresh operation cannot be 
interrupted.

Slow Link
If you have a slow link - a round-trip time > 100 ms - then select only Meters. As 
this is a remote station it is unlikely that anyone else will be adjusting the radio's 
controls so you will not need to refresh buttons and dropdowns as you would with 
a locally connected radio.

The disadvantage of not selecting Buttons and Dropdowns is that inter-button 
dependencies will not be shown - for example you may have 4 AGC buttons Off, 
Fast, Medium and Slow, only one of which will be active at any one time. If But-
tons is not enabled for regular refreshes then pressing Fast will not update the 
other AGC buttons. In this case you must press the small refresh button to the 
right of the Buttons check box.

To refresh all display options click Refresh All.
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Problem Solving
The following steps are recommended to solve problems using the remote server.

1 Run Ham Radio Deluxe on the remote computer to check that you can 
actually connect to your radio.

2 When you connect to the remote server make sure you have closed Ham 
Radio Deluxe on the remote computer. If you get the error “Access is 
Denied” then the COM port is held open by another program.

Ham Radio Deluxe Serial Port Client
Starting Select Port Client from the from the Tools> Programs menu.

You must define the serial port mappings before you connect to the serial port 
server running on the remote computer.

Mappings Press Add to define a new mapping.

Each mapping consists of:
• Title – whatever makes sense to you. In this case we’re mapping to a K1EL 

WinKey on Simon’s remote station in the south pacific.
• The local port – one of the virtual null modem ports. Here the two ports are 

COM20 and COM21.
• The remote port – Simon has connected the WinKey to COM1 on the 

remote computer.
• Remote port settings – WinKey uses 1200,8,none,1.
• [X] Enable DTR and [_] Enable RTS – usually checked to provide power to 

a special powered cable or device. For Winkey you must check DTR to 
provide power to WinKey!
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Remote Port Settings
Some useful remote port settings are:

• WinKey – 1200,8,none,1 and [X] Enable DTR.
• AlfaSpid RAS rotator – 600,8,none,1.
• AlfaSpid RAS rotator – 1200,8,none,1.
• Idiom Press rotator – 4800,8,none,1.

Connecting Press Connect to connect to the serial port server on the remote computer.

In the Connect to field enter the remote address, for example 201.42.12.246. If 
you are not using the default port (7806) then append a colon and the port number, 
for example 201.42.12.246:7808 to connect to port 7808 on 201.42.12.246.

In the Username and Password fields enter the username and password you have 
been given; these must also be entered in the configuration file.

When you have finished just press Connect.

Assuming everything works correctly the client will display log information simi-
lar to that below:

The client makes two connections; one to send data, the other to receive data. The 
remote server returns a list of known serial ports after the first connection is estab-
lished, in this case COM1, COM3, COM4, COM5 and COM6.

Now check the Simon’s WinKey mapping and you see logfile messages as the 
local (COM20) and remote (COM1) serial ports are opened.
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Now you can connect to the remote WinKey using COM21 (the other half of the 
COM20 <-> COM21 virtual cable).

If you enable  Tracing you see the data sent and received as the WinKey code 
runs through the initialization and performs an echoback test.

Congratulations – you can now use your remote WinKey.
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Ham Radio Deluxe Serial Port Server
Installing The Ham Radio Deluxe Serial Port files are:

• Ham Radio DeluxeSerialPortSvr.exe – the executable, and
• Ham Radio DeluxeSerialPortSvr.cfg – configuration file.

To install the service select Remote Service from the Tools> Programs menu.

1 Press Ham Radio Deluxe Serial Port Server to select this server.
2 Press Install to install the service.
3 Press Start to start the service.

You can start the Windows Services applet (Start > Settings > Control Panel > 
Administrative Tools > Services) to modify the properties of the service, for 
example disabling automatic startup.
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Firewall
Allow incoming connections on port 7806.

Configuring Press Configure to edit Ham Radio DeluxeSerialPortSvr.cfg that contains the ser-
vice configuration.
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Passing Audio
After the completing of the rig control portion of a remote station you will need to 
setup the ability to pass audio to and from the remote station. If you are only 
working the digital modes like PSK31 you will not need to worry about this. Cw 
was discussed previously in this chapter.

Skype has been a tradional method of passing audio in both directions.  A great 
new option has been added to DM-780 in Ham Radio Deluxe Version 6.2. This 
new option brings us one step closer to being able to provide fully integrated 
audio within the Ham Radio Deluxe suite of programs for remote operation, with-
out having to rely on 3rd party software such as skype. 

 HRD has added an option which allows you can operate voice communications 
using a standard, inexpensive computer headset. 

Voice This Option Will Not Work On All Radios!!! 
This option will NOT work on some radios due to the following conditions.

This failure to work is NOT a fault of our code but rather caused by variations in 
the implementation of PTT on different radios.VOX won't work on some radios, 
PTT won't work via rig control on some radios, there may be no audio out if an 
external PTT foot switch is used with a back-panel ACC connection, some radios 
will have to be programmed via their menus and there are a variety of other possi-
bilities. Some radios have at least six different methods of PTT and each PTT 
input has it own foibles! This makes it almost impossible for Ham Radio Deluxe 
to cover ALL the different ways in which PTT is handled. Therefore, this option 
is available ONLY for those radios that can handle it, and those that can't, it's the 
fault of a "non-standard" implementation of the PTT function in the different 
manufacturer's radios.

Configuration
 The Ham Radio Deluxe Voice option is easily activated from within the DM‐780 
module. 

1 Open DM-780. 
2 Click on Program Options and open the sound card dialog as indicated 

below.
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3 You will notice on the right side of the dialog a new section has been added. 
You will also notice the note that states the enable function will be 
"GRAYED OUT IF UNAVAILABLE". To activate this function, place a 
check-mark in the enable box. 

4 Next, select the Microphone you intend to use, which is normally the default 
microphone for the computer sound card. 

5 Next, select the Headphone, again normally the default. Once these are set 
your almost ready to go.

6 The next step is to select the VOICE mode from the modes listing as shown 
to the right.

7 Once this step is complete you will notice a change n the Transmit Toolbar. 
Instead of seeing the normal "SEND (F4)" you will see instead "PTT (F4)" 
This is your PTT button for the microphone. Just click the PTT button and 
start talking and click the "STOP" button to return the radio to the Receive 
mode.

This new function has been tested with the FT-857D using the Timewave Naviga-
tor interface. It seems to work great on Upper Side Band, however, on this partic-
ular radio, if you plan on using the function to communicate on any 2-meter FM 
repeaters, you MUST put the radio into the PKT mode. The reason for this is the 
FT-857D can only accept audio through the DATA plug on the back of the radio 
with the rig set to USB or PKT and not set to any other mode.

When tested with some contacts on a local repeater, I received very good audio 
reports using an inexpensive, $14.00 computer headset purchased from Walmart. 
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5  Advanced Features
Audio
Introduction Ham Radio Deluxe has a built-in audio grabber and audio playback. This feature 

requires a connection from your radio the your sound card in your computer or an 
external sound card interface.

Audio Grabber The audio grabber stores incoming audio in MP3 files using the MP3 tags to store 
information about the radio settings (or any other information you feel to be 
important).
An alternative to MP3 would be Windows Media format (WMA) but the pro-
gramming of WMA files is rather complex.
To display the audio grabber select Audio Grabber from the Tools menu. 
By default the Audio Grabber is docked at the bottom of your Ham Radio Deluxe 
Screen. By grabbing the top bar o the Audio Grabber you can undock it and make 
it a separate window. To redock the wind grab the top bar of the Audio Grabber 
and start moving it into your Ham Radio Deluxe window. You will see arrows at 
the four edges plus four arrows in the middle of the screen. Move the Audio Grab-
ber over the desired arrow and it will dock in that location.

Record

Here you have the standard recording buttons. From left to right:
• Record,
• Stop,
• Reset current recording,
• Restart (close current file first),
• Browse for MP3 files.

You also set a file limit – a downside of MP3 is that the tags are written at the end 
of the file when it is closed, so to avoid losing information in the event of an unex-
pected event it is best to use more, smaller files.

Folder

Here you select the folder where the MP3 files are stored.
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Quality

Here you select the bandwidth and quality. Modern computers have more than 
enough CPU power to support a very high quality. A bandwidth of 4.5 kHz is usu-
ally acceptable unless you are recording a WFM broadcast.

Soundcard

Select the soundcard that you are recording from.

Tags

Here you see the values stored in the MP3 tags. To change the values just add the 
new text and then press Apply.

Audio Browser Use the audio browser to playback MP3 files. To open the Audio Browser, select 
Audio Browser from the Tools menu. You can also start the Audio Browser by 
clicking on Browser in the Folder tab within Audio Grabber.
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Peter PH1PH came across IrfanView – an excellent freeware utility.

MP3 Player Options
Player
Select MP3 player – a basic MP3 player is built into Ham Radio Deluxe, however 
you can select an alternate player such as the excellent Windows Media Player. 
Press Default to select the default player.

Folder
Select the folder to browse

 Select default folder

Refresh the current folder

Audio File
Select a file to play from the list at the bottom of the window.

 Play currently selected file

 Pause

 Start again

 Stop



90 Ham Radio Deluxe

DDE Support Chapter 5 - Advanced Features

From
 Start at beginning of file

Set From at the current position

To
 To end of file

 Set To at the current position

Use the From and To slider positions to select the part of the file to repeated over 
and over and over again. This is useful for determining exactly what the station 
was sending.

Other Options The other options are:
• Copy – copy the selected files to another folder.
• Delete – delete the selected files.
• Move – move the selected files to another folder.
• Rename – rename the selected file.
• Artist / Album / Title / Description – change the MP3 tags.

DDE Support
Introduction Ham Radio Deluxe uses dynamic data exchange (DDE) for inter-process commu-

nication. DDE allows two or more applications running simultaneously to 
exchange data and commands.
For more information See “3rd-Party Programs” on page 94.

Available 
Support

Select DDE Monitor from the Tools menu to display the supported DDE items.

Commands The commands below are supported by Ham Radio Deluxe.

Add ADIF Record
ADIF <data>

Adds a record to the logbook; the record is supplied in ADIF format. Used by 
PSK31 Deluxe.
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Refresh
REFR button_status

Refreshes all buttons.
REFR dropdown_list

Refreshes all dropdown.

Set Button
BUTN button_title=value

Sets a button state. For normal buttons the value is either on or off.
If title starts with @ then it’s a dropdown, the value must be a dropdown value.

Set Dropdown
DROP button _title=value

Selects a dropdown value.

Set Frequency
FREQ <hertz>

Sets the frequency to the value supplied in Hertz.

Set Mode
MODE <mode>

Sets the mode to the supplied value.

Top Window
TOPW

Makes the Ham Radio Deluxe the top-most window in the Z-order, in other words 
brings Ham Radio Deluxe to the front of your monitor.
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Synchronizer

Introduction The synchronizer is used to control two or more radios where a common fre-
quency is shared by using the Dynamic Data Exchange (DDE) mechanism.
For each radio you are using you start an instance of Ham Radio Deluxe, one 
instance is the Master, the rest are the Slaves, the slaves receive frequency and 
mode information from the master.

Starting Start the Synchroniser from the Tools> Programs menu, then press Scan to find 
the active Ham Radio Deluxe instances.
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Select the master instance (supplied the frequency and mode), and then press 
Start.

In the Frequency and Mode dropdowns you select the corresponding source from 
the Ham Radio Deluxe master instance:

• Radio – as seen on the main Ham Radio Deluxe display,
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• Transverter – frequency is taken from the Transverter window (selected 
from the Tools menu).

• Satellite uplink – the uplink frequency and mode (see  Ground Control on 
page 213).

• Satellite downlink – the downlink frequency and mode (see  Ground Control 
on page 213).

In the Ham Radio Deluxe Slaves group box check the instances to be controlled 
by the Synchroniser.
As soon as you check a slave the slave‟s frequency and mode are updated with the 
current values from the master; every time the master frequency and / or mode 
change they are sent to the slave for so long as the slave option remains checked.

Dual Radio 
Satellite 
Tracking

Refer to  Satellite Tracking on page 209, specifically  Ground Control on 
page 213.
If you are using two radios for satellite tracking (for example two FT-817 or IC- 
7000):

1 Start an instance of Ham Radio Deluxe for each radio; connect to the radios.
2 Select an instance to use as the master, in this example the radio used for 

receive.
3 In the master (receive) instance:

• Start the display.
• Enter transmit and receive frequency information for the satellite you are 

tracking.
• Check the RX VFO, do not check a TX VFO as this instance will not be 

used for transmit.
4 Start the Synchroniser:

• Master is the receive instance,
• Slave is the transmit instance,
• Select the Satellite uplink option for Frequency and Mode so that the 

slave receives the frequency and mode used for transmit as computer by 
the Master instance.

The slave will now be updated with the transmit frequency and mode for transmit 
every time it changes in the master instance.

3rd-Party Programs
Introduction Ham Radio Deluxe supports 3rd-party programs such as logbooks via a virtual 

serial port. See also  DDE Support on page 90.
An example of a virtual serial port is available from Phil Covington N8VB. His 
homepage is http://www.philcovington.com/SDR.html look for the N8VB vCOM 
Virtual Serial Ports Driver download.
To install the vCOM drivers see  N8VB vCOM on page 243. The N8VB driver 
works with Windows 2000, XP and higher. 
N8VB's solution creates a pair of virtual COM ports (virtual because there is no 
hardware associated with a virtual COM port). The ports are effectively connected 
back-to-back – just like a normal serial cable.
In the description that follows two ports are created during the installation, COM7 
(used by Ham Radio Deluxe) and COM8 (used by the 3rd-party program).

• Ham Radio Deluxe opens and listens on COM7 port for incoming requests.
• The other program opens COM8 in exactly the same way it would connect 
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to a radio using a hardware serial port.
The connection parameters used by the 3rd-party program to connect with COM8 
are:

• Speed – any (9600 by default but this really doesn't matter),
• Stop bits – 2,
• Parity – none.

The protocol supported is Kenwood, the command set current supported is:
• FA – Get / set VFO-A.
• FB – Get / set VFO-B.
• MD – Get / set mode.
• IF   – Read status, currently frequency, TX status, and mode are supported,
• SM – Read the S-Meter.

To use this option Ham Radio Deluxe must be connected to a radio, otherwise the 
standard Kenwood error response?; will be returned. The radio does not have to 
support the Kenwood protocol as Ham Radio Deluxe makes the necessary conver-
sions.

Configuring Select 3rd-Party Serial Port from the Tools menu.

1 Enable opens the connection on the selected port – in this case COM7. 
2 Check Connect to automatically open the connected everything Ham Radio 

Deluxe starts. 
3 In the Port dropdown you select the COM port to use 
4 The Mode dropdown is reserved for future use. The only option is Default.
5 Press OK

And that‟s all there is to it.

Testing To test the connection:
1 Start HyperTerminal (supplied with Windows thru XP. If you are using Vista 

or Win7 download TeraTerm which is a free app and is better than 
HyperTerminal). 

2 Connect to COM8 (the virtual serial port used by the 3rd party programs).
3 Enter FA; you will see a value such as FA00050100000; returned 
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(50.1 MHz).

Command 
Detail

FA Reads and sets the VFO A frequency in Hz
Set FA<11 digit frequency>; 
Read FA;
Answer FA<11 digit frequency>;

FB Reads and sets the VFO B frequency in Hz
Set FB<11 digit frequency>; 
Read FB;
Answer FB<11 digit frequency>;

IF Retrieves the transceiver status
Read IF;
Answer IFP1P2P3P4p5P6P7P8P9P10P11P12P13P14P15;

Where:
P1 = 11 digits, frequency in Hz
P2 =  5 digits, not used 
P3 =  5 digits, not used 
P4 =  1 digit, not used 
P5 =  1 digit, not used 
P6 =  1 digit, not used 
P7 =  2 digits, not used
P8 =  1 digit, 0: RX, 1: TX
P9 =  1 digit, see MD above
P10 = 1 digit, not used 
P11 = 1 digit, not used 

  P12 = 1 digit, not used 
P13 = 1 digit, not used 
P14 = 2 digits, not used 
P15 = 1 digit, not used

MD Recalls or reads the operating mode status
Set MD<mode>; 
Read MD;
Answer MD<mode>;
Where mode is one of:

0: None
1: LSB
2: USB
3: CW
4: FM
5: AM
6: FSK
7: CWR (CW Reverse)
8: Tune
9: FSR (FSK Reverse)

SM Retrieves the S-Meter value
Read SM;
Answer IF<4 digit value>;
Where the returned value range is from 0000 to 0030. Each 
unit is 1/2 an S-unit. S5 is 0010, S9 is 0018.
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6  Logbook
Introduction

It is time to be impressed! Ham Radio Deluxe Logbook is probably the best log-
book program and it keeps getting better. As you will see later, the awards track-
ing capability is second to none. 

Setup You will need to go through a few steps to configure logbook. 

Database
Ham Radio Deluxe Logbook is built on Microsoft Access. The driver normally 
used is the Microsoft Access Driver (*.mdb)ODBC driver. You do not need a 
license to use Access databases - the runtime DLLs are included in Windows XP 
or newer.

You can create and manage additional databases for use within Logbook. You can, 
if you desire, create a separate database for contest work or a special event. 
Beware that this can create issues if you are interested in awards tracking.

To manage your database(s), select Manager from the Toolbar. 

This opens the Logbook Databases window.

Within this window you can add new or modify existing databases.

Other Databases
Logbook can be built on MySQL if you choose. Support for MySQL is beyond 
the scope of this document.

Other (non-Ham Radio Deluxe) logbooks are supported via a DDE interface (see  
DDE Support on page 90) and a serial port (see  3rd-Party Programs on page 94). 
So you can use the logbook of your choice with Ham Radio Deluxe provided it 
supports DDE or the Kenwood protocol via a COM port.
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My Station
If you have not already set up the necessary information within my station you 
will need to do that now. This will prove to be critical later so best do it now.

1 From within Logbook select from the Tools menu, Tools > Configure > My 
Station.

2 Information in the My Station screen is used by Ham Radio Deluxe Logbook 
and DM-780. 

Note:  If you have already set up the DM-780 portion of the suite, this screen 
should be populated with the required information and you can just close 
it out and continue with the set up.
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My Station Set Up
Ham Radio Deluxe allows you to set up multiple QTH locations. This allows you 
to have a Home location as well as other locations such as a vacation home or 
favorite portable locations.

Multiple Callsigns
If your License Manager shows more than one callsign 
such as for parent and child or husband and wife, you 
are able to enter station set up information for each call-
sign. You can also set up “Guest” accounts for club or 
special event stations.

If you haven’t already set up the My Station data, in the 
Description field you see the word HOME for a profile of your Home QTH. This 
generates your main location. Then go ahead and fill in all the rest of the informa-
tion for this location. Please note which fields are required if you use one of the 
DX Clusters.

Most of the fields are self-explanatory. A couple of the fields do need a little 
explanation. The field SIG stands for Special Interest Group. This could be a club 
or any organization you belong to. The SIG Info field could be a website address 
for a group. You could leave these fields blank if you like.
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Another spot you might need help is once you enter your Locator, for example 
EN36QR, if you hit the little arrow that points downward, that will automatically 
fill in your Latitude and Longitude fields. 

By the same token, if you know your Latitude / Longitude, enter them and hit the 
upward pointing arrow to fill in your Locator.

If you operate from mobile or maybe have a vacation 
home, you can generate My Station profiles for those 
locations as well by clicking on the Add Location but-
ton. You can copy the data from the Home location to 
be placed in an additional location then just edit any-
thing that is to be different for that profile. Each profile 
is auto-saved when you exit the screen by clicking the 
red X in the upper right corner.

Once you’ve completed configuring your Tags and My Station, your almost home. 
Just a couple more things before you can go on the air live with DM-780.

Note:  This chapter is currently being totally re-written. The many new 
features need to be discussed in detail. Some are covered in the 
next two chapters. The outline below lists what is coming in this 
chapter. Watch the website for updates.

Setup topics

How Logbook works

MS Access based or MY SQL if you dare

My Station setup

Manual data entry

Auto entry

General features
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Allows you to easily store QSO info and track awards

Integrated call sign lookup

Adding entries from paper logs

Interfacing with DM-780

Logbook – A Tour

Menus

Toolbar

Radio pane

Audio monitor and recorder

Browser

Monitor

Digital clock

Favorites

Greyline

Logfile

Radio Pane, Radio Screen

Solar data

Rig tuning (Main and Sub)

Layouts – tuning the product to your style

As you can many great improvements are forthcoming. Everything from 
here to the end of chapter is old and highly suspect for accuracy. 

N0ZRD - The Work Wacker
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Main Display
3

When you start Ham Radio Deluxe a default logbook is created in the default files 
folder, see Files on page 84.

Options Selection fields:

Select the entries that are displayed:

Entries – the maximum displayed in the main list. The fewer you display the 
faster they are loaded. The maximum you can display is 25,000 – if you have 
more than 25,000 entries in your database then only the first 25,000 that match the 
selection criteria are displayed.

Date – display entries since this date. Typically you will only display entries from 
the last few days.

Filter – filter by any field (except dates) – for example mode or callsign. Check 
Exact for an exact match.

Summarize – display the first entry that matches the selection. For example, if you 
select Country and Band you see the first entry for each country and band.

Sort – select the sort criteria (alternatively click the column headers).

Print the logbook (page 90). Select Print Setup from the File menu to select 
paper size, layout, etc. Use Print Preview first to see what it will look like.

 Print preview – see what your logbook looks like before you print it. Print 
preview can be very CPU intensive with a large logbook (25,000 or more 
entries) so be prepared to wait a few seconds before it starts drawing.
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 Add a new entry (page 76).

 Edit the currently selected entry.

 Delete the selected entries.

 Start the logbook analyser.

 Plot selected entries using Mapper. To be plotted an entry must have a valid 
locator.

 Reload the database and refresh the display.

 Auto fit the column widths to their contents. 

 Define column layout.

 Backup the database.

 Database configuration.

 Lookup station using QRZ.com.

 Plot station locations using Google Earth.

Adding An Entry
Select Add Entry from the Logbook menu. Here you see many more fields than 
those in a paper logbook; only a few are mandatory.

The entry window is divided into two sections: Main and Tabbed (for want of a 
better description).

The Main section contains the frequently used fields whereas the Tabbed section 
contains the less-frequently used fields.

Main

The buttons  and  respectively hide and show the tabbed fields, ideal for sim-
ple contest operation when you want the minimum of visual “noise”.
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QRZ.com An excellent Internet resource, http://www.qrz.com/ is used by Ham Radio Deluxe 
to find station information. The fields supported are shown below. Ham Radio 
Deluxe extracts information by parsing the detail field for a station, for example 
http://www.qrz.com/detail/HB9DRV.

In the Options window you can enable automatic QRZ lookups.

Field Description
Start The QSO start date and time. With the Options you can:

• automatically set the start (and end) time to the current time when 
pressing the Reset button, and

• Set the start time when a callsign is entered in the Station field (the 
time is set when the Station field loses focus).

End The end time. The date is taken from the start date, if the end time is less 
than the start time then it is assumed that the QSO ends on the next day. 
With the Options you can:

• automatically set the end (and start) time to the current time when 
pressing the Reset button,

• set the end time when you add the QSO.
Station The callsign of the other station.
QRZ Press QRZ to retrieve information from QRZ.com (see below).
RST 
Recv

The report received from the other station. With the Options you can select 
the default value (if any) entered in this field when you press Reset.

RST 
Sent

The report sent to the other station. This field is divided into two parts:
1 the RST sent, and

2 the additional information sent, for example a serial 
number. 

With the Options you can select that the RST sent count is automatically
Locator Maidenhead locator square. If a valid 4-character (major) or 6-character 

(minor) square the distance and bearing from you locator in the My Station 
tab is shown.
Filled in by you or via a QRZ.com lookup.

Name The other station‟s name, filled in by you or via a QRZ.com lookup.
Remark Whatever you want; filled in by you or via a QRZ.com lookup.
Mode The mode – if you enable the option track radio mode then the value here 

is taken from the Ham Radio Deluxe display. If this option is not enabled 
then pressing  loads the current Ham Radio Deluxe mode.

Band The band – determined from the Ham Radio Deluxe frequency is the 
option track radio frequency is enabled. If this option is not enabled then 
pressing  loads the current Ham Radio Deluxe band.

Freq The frequency – determined from the Ham Radio Deluxe frequency is the 
option track radio frequency is enabled. If this option is not enabled then 
pressing  loads the current Ham Radio Deluxe frequency.
[X] Freq: Make sure this checkbox is checked otherwise the frequency is not added.

Cnty Country – selected from the dropdown list or determined automatically if 
the option find callsign from callsign prefix is enabled.
[X] Cntry: Make sure this checkbox is checked otherwise the country is not added.

IOTA Islands on the Air -  http://www.rsgbiota.org/.
Address The address field, filled in by you or via a QRZ.com lookup.
QTH The station location, as in „my QTH is…‟. Filled in by you or via a 

QRZ.com lookup.
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Contact

More information about the station you have contacted.

Field Description
Last 100 Shows the most recent 100 entries from the logbook.
Partial match List the most recent 100 entries from the logbook that partially match 

the currently entered callsign.
Exact match List the most recent 100 entries from the logbook that match the 

currently entered callsign.

Field Description
SIG The name of the contacted station‟s special activity or interest group.
SIG info Information associated with the contacted station's activity or interest 
10-10 Ten-Ten number
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Location

QSL

Standard QSL information.

eQSL

Not supported by ADIF, these are fields for use with eQSL.cc.

Field Description
County The contacted station's Secondary Administrative Subdivision of 

contacted station (e.g. US county, JA Gun).
State/
province

The code for the contacted station's Primary Administrative 
Subdivision (e.g. US State, JA Island, VE Province).

ARRL sect The contacted station's ARRL section.
CQ zone The contacted station‟s CQ Zone.
ITU zone The contacted station‟s ITU zone.
Distance The distance between the logging station and the contacted station 

in kilometers.
Lat/Lon The contacted station‟s latitude and longitude. Press  to 

determine the latitude and longitude from the Locator field value in 
the Main part of the window.

Field Description
eQSL status Status of the most recent upload.
eQSL user Logon username
eQSL pwd Logon password
eQSL.cc real-time 
uploads

If checked then an upload is made every time you add a QSO. 
This is also known as real-time uploads.
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Ant/Sat

Contest

If you check [X] reset fields after adding an entry then the fields are erased when 
an entry is added. If not checked then the fields are not erased.

Propagation

Basic propagation information, press WWV Download to load the latest informa-
tion from http://www.sec.noaa.gov/ftpdir/latest/wwv.txt.

Field Description
Azimuth The logging station's antenna azimuth, in degrees.
Elevation The logging station's antenna elevation, in degrees.
Path The signal path.
Name Name of satellite.
Mode Satellite mode.

Field Description
Check Contest check (e.g. for ARRL Sweepstakes).
Class Contest class (e.g. for ARRL Field Day).
Precedence Contest precedence (e.g. for ARRL Sweepstakes).
Contest QSO Contest Identifier.

Field Description
A index The geomagnetic A index at the time of the QSO.
K index The geomagnetic K index at the time of the QSO.
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My Station A description of your station at the time of the QSO. These fields are the same as 
those in My Station on page 85.

Select a profile by pressing the corresponding button; press Save to save any 
changes you make.

Custom

Here are six totally customizable fields, use them as you wish. If you check [X] 
reset fields after adding an entry then the fields are erased when an entry is added. 
If not checked then the fields are not erased; the values are stored in the registry 
and loaded the next time you start Ham Radio Deluxe.

Solar flux The solar flux at the time of the QSO.
MS shower For Meteor Scatter QSO’s, the name of the meteor shower in 

progress.
Num 
bursts

The number of meteor scatter bursts heard by the logging station.

Num pings The number of meteor scatter pings heard by the logging station.
Max bursts Maximum length of meteor scatter bursts heard by the logging 

station, in seconds.
Prop mode QSO propagation mode.

Field Description

Field Description
Callsign The logging station's callsign (the callsign used over the air).
Operator The logging operator's callsign.
Owner The callsign of the owner of the station used to log the contact (the 

callsign of the Operator‟s host).
SIG The logging station‟s special activity or interest group.
SIG info Information associated with the logging station's activity or interest 

group.
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Options

Logbook Fields
Select the fields that are displayed – reduce clutter during a contest when you only 
want the bare minimum.

Appearance
The current S-Meter and date/time are shown at the top of the window; remove 
these if you don’t want them.

Reset (Add Only)
Select what happens when you press Reset or when you add a new QSO and the 
[X] Reset fields… option is checked.

Layout Size (Restart Required)
For tired eyes – set the window size to Small, Medium or Large. You must reset 
Ham Radio Deluxe for the change to take effect.

Reset (Add Only)
Select what happens when you press Reset or when you add a new QSO and the 
[X] Reset fields… option is checked.

Start / End Times (Add Only)
As part of the QSO automation enable these options to set the start time when you 
first move out of the Station field and the end time when you add the QSO.

Note – the start time is not updated if you edit the callsign. It is set only when you 
move out of the Station field for the first time.

Behavior (Add Only)
During a contest you will want to auto-increment the RST sent counter – the first 
numeric part of the RST sent field is updated, for example 042GR is updated to 
043GR.

The country is determined from the callsign prefix using the logbook’s country 
data (List - Countries on page 87).
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Audio Grabber (Add Only)
Enable display of the Audio Grabber so that a new audio file is created for each 
QSO.

QRZ (Add Only)
QRZ.com is an excellent resource – here you enable automatic lookups.

Appearance

Adjust the appearance of the display to suit your own taste. Using alternate colors 
makes reading copious data much easier. Using a larger font helps with tired eyes

Custom Fields

Define the titles for the six custom fields available in the logbook windows. Use 
these fields for values not supported elsewhere.
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Various

The options here should be self-explanatory.

List – Bands

The band ranges. This information is taken from the ADIF specifications; it is 
used to determine the correct band from a frequency.

 Resets the table and loads the latest values built into Ham Radio Deluxe.

 Display this data with the default text file viewer.
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List - Countries

The data used to determine country from the callsign prefix. 

 Resets the table and loads the latest values built into Ham Radio Deluxe. 

 Display this data with the default text file viewer. 

 Loads new data from a text file.

 Browse the web for a new countries file, default URL is ftp://
www.ham-radio.ch/countries/ .

 Update logbook entries with the latest countries file data.
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List – Modes

The supported modes; this information is taken from the ADIF specifications. 

 Resets the table and loads the latest values built into Ham Radio Deluxe. 

 Display this data with the default text file viewer.

 Resets the table and loads the latest values built into Ham Radio Deluxe. 

 Display this data with the default text file viewer. 

 Refresh this window.

Logfile

All database activity since starting Ham Radio Deluxe.
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Printing
There’s nothing better than a paper log for reviewing your on-air achievements. 
Before you select the Print option  you should first use the Preview option  to 
review what you will be printing before committing another rain forest to the 
recycling bucket!

When you select Print or Preview the Print Options window is displayed.

When reviewing a contest or QSO’s selected for an award you will usually enable 
the QSO counter option.

The alternate background option makes the log easier to read (just try it), adding 
blank lines between days is very much a personal preference.
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Now press  to save the displayed entries in your database. 

Select the fields and entries to be exported.

If you are only uploading to the ARRL’s Logbook of The World then there is no 
need to export unnecessary fields – this just makes the whole LoTW experience 
Problems

Performance If you find that the database is exceptionally slow make sure that ODBC tracing is 
switched off.

From the Start menu select Settings / Control Panel / Administrative Tools / 
ODBC Data Source Administrator select Tracing. Here you stop tracing (if 
started).

Errors If you get problems using the Logbook – for example a window such as:
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then follow the steps below to generate a trace file which provides all information 
required to diagnose the problem.

1 Close Ham Radio Deluxe.
2 From the Start menu select Settings/Control Panel/Administrative Tools/ 

ODBC Data Source Administrator select Tracing.
3 Press Start Tracing Now.
4 Start Ham Radio Deluxe, open the Logbook, and perform the steps 

necessary to generate the error.
5 Stop tracing.

Save the logfile to a ZIP archive and forward to the Ham Radio Deluxe develop-
ers.
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7  Logging and Managing QSO 
Records
Add Logbook Entry (ALE)

Ham Radio Deluxe Logbook has a number of powerful features for tracking QSO 
data. This information is contained within the Add Logbook Entry (ALE) window 
and its fifteen tabs. This section will describe these areas. The ALE window is 
opened by clicking on the Add button in the toolbar.

Menu Bar But first, it’s necessary to understand the options for the ALE. The ALE’s menu 
bar has a number of menu items.

Options
Clicking the Options menu renders the following choices:

The Times option can be selected for UTC or Local time.

The Start and End times can be set according to the operator’s operating style.

Recommendations
• DXers and Contesters should use Current Time in the Times selection. This 

uses the time of the computer clock when the QSO is logged. Because DX 
and Contest exchanges are so short – lasting for only a few seconds – there’s 
an increased likelihood of making a QSL match to services like LOTW if 
the QSO is set to Current Time.

• Rag-chewers may want to use Set by user. This accommodates QSOs of 
longer durations.
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Font Option
This enables the operator to change the fonts used in the dialog ALE.

QSL Defaults
This enables the operator to choose the initial values for the three QSL fields. This 
is helpful when using a value like Queued to set the LOTW value so that it’s easy 
to do a search for QSLs that need to be uploaded to LOTW.

RST Rcvd / Sent
This provides options for canned values of RST.

Button Position
The operator can select from bottom, middle, and right side location of the 
Update, Cancel, Reset, and Add Spot buttons. This is useful when vertical or hori-
zontal space is restrained.

Menu Position
The choices of positioning the menu on top or bottom are provided.

Other options
Toggle on/off options

• Show Tooltips
• Save VFO B in database
• Keep Propagation Mode
• Mirror Locator on Location Tab 

Show Worked Status

This option enables a W icon to display for Call, Country, and Locator fields. This lets the 
operator know that these items have been worked before.

Tracking
The Tracking menu enables the ALE to use the data coming from the rid for fre-
quency or mode and automatically populated into the ALE. (Default is ON for 
both.)

Show:Fields
This option enables the operator to choose which of the thirteen fields will be dis-
played in the ALE. (Default is all ON.)

Show:Tabs
This option enables the operator to choose which of the fifteen tabs will be dis-
played in the ALE.  (Default is all ON.)
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Logbook Tab The Logbook tab which is the first of many tabs at the bottom of the ALE window 
provides detail on previous QSOs with the station being logged. Partial and Exact 
matches are options

Worked Tab The Worked tab provides detail about previous QSOs with that callsign, country, 
continent, zone, IOTA, or locator… by band and/or mode.

Country Tab The country tab contains the DXCC information about the country being logged. 
This data is ‘display only’ and is not saved in the QSO record.

Contact Tab The Contact tab provides a place to store information about the station operator’s 
age, Special Interest Group (SIG, or club), SIG website, email address, website 
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URL 10-10 number, equipment, and biography. Callsign Lookup sources often 
provide much of this information.

Location Tab The Location tab provides a place to store information about the station operator’s 
location – including State/province, City (QTH), County, ARRL Section, postal 
address, CQ and ITU Zone, continent, distance, and polar coordinates. Callsign 
Lookup sources often provide much of this information.

IOTA Tab The IOTA tab provides a place to store information about the IOTA reference 
number and Island name.

Antenna/
Satellite Tab

The Ant/Sat tab provides a place to store beam heading and satellite information.

Award Tab The Award tab is for tracking the award credits within the various awards pro-
grams. A QSO record cannot have both Submitted and Granted status for a given 
award. Selecting one de-selects the other. More information about the use of this 
tab can be found in the Awards Tracking section of this manual. These values are 
determinants of what is displayed in the Not Submitted, Submitted, and Granted 
columns in the Awards Tracking tab.
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Contest Tab The Contest tab provides a place to store data related to contest exchanges.

Custom Tab Six Custom fields can be defined and used by the operator. This is useful for 
tracking awards that are not hard-coded within Ham Radio Deluxe such as Sum-
mits on the Air (SOTA). Clicking on the Configure button enables the operator to 
rename these fields.

My Station Tab The My Station tab is particularly useful when the operator has multiple operating 
locations. The operator can select from profiles (stations) created in Ham Radio 
Deluxe Logbook

Propagation 
Tab

The propagation tab saves solar data into the QSO record. Be sure to check the 
Track box to turn this feature on. The information comes from the most recent 
WWV or WCY information.
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QSL, eQSL.cc, 
and LOTW tabs

The QSL tab is for tracking paper and electronic QSLs. QSL Sent and Rcvd have 
the following values:

QSL Rcvd:
Y yes (confirmed); an incoming QSL card has been received, or the QSO has 
been confirmed by the online service

N no; an incoming QSL card has not been received, or the QSO has not been 
confirmed by the online service

R requested; the logging station has requested a QSL card, or the logging station 
has requested the QSO be uploaded to the online service

I ignore or invalid

V (deprecated) verified

QSL Sent:
Y yes; an outgoing QSL card has been sent, or the QSO has been uploaded to, 
and accepted by, the online service

N no; do not send an outgoing QSL card; do not upload the QSO to the online 
service

R requested; the contacted station has requested a QSL card, or the contacted 
station has requested the QSO be uploaded to the online service

Q queued; an outgoing QSL card has been selected to be sent, or a QSO has been 
selected to be uploaded to the online service

I ignore or invalid
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Note:  These values are determinants of what is displayed in the Confirmed 
and Need QSL columns in the Awards Tracking tab.

Logbook 
Search

The Filter button enables the operator to perform a logbook search, based on 
selected field criteria.

Once selected, the operator can find QSOs based on Callsign, Date range, and a 
combination of any three additional fields. This is helpful when trying to find 
something unique in the log. These types of database queries are also used in dis-
playing awards totals.

QSL Filter
The QSL filter button enables the operator to search and update QSL Status in-
bulk. This is helpful when printing a significant number of QSL cards over a 
given date range.

Award Filter
The Award filter button enables the operator to search and update award tracking sta‐
tus in‐bulk. This is helpful when making an award application.
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Bulk-Editing QSOs
The bulk-editor is a powerful tool for making mass changes to the data in the log-
book. It is highly recommended that a logbook back be made prior to using this 
tool.

To use the bulk-editor, first select a number of QSO records where the same 
change is desired by using the “Filter” (search) or by selecting some number of 
records manually within the log.

There are a number of places to find the Bulk Editor menu option. To use one as 
an example, right-click on any of the highlighted QSO records, and select one of 
the provided options.

Any Fields is a very powerful choice, as it enables the operator to change anything 
in the database in mass (use with care). For this example, Any Fields is selected 
and the option to backup the logbook is provided.



Chapter 7 - Logging and Managing QSO Records Importing Log Files

Ham Radio Deluxe 127

Logbook

1 Select Any Fields.
2 Next, select the “Add Field” 

button.
3 Select the desired field (CQ 

Zone, in this example)
4 Enter the desired value (10, 

in this example)
5 Click “Ok”

All the selected QSO record 
will be updated with the desired 
value.

Importing Log Files
Logs can be easily imported from other logging programs.  To import a log from another 
logging program, follow these steps:

1 Export the log into ADIF format from the other logging program. Make sure 
that it is configured to provide all available fields.

2 From the menu in Logbook, select Logbook >File > Import, and then 
choose the relevant option from the list of five shown. Most often, ADIF 2 
is used.

3 Then select the ADIF file for input by clicking the button to the right of 
“DIF Filename. The recommended options are shown here:
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4 Once the file has been analyzed, the results will be shown. select Save to 
Database”.

If there are errors in the source ADIF, the operator will see this in the results dis-
played below.
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Note:  Be aware of the “garbage-in/garbage-out” scenario. The information 
provided in Ham Radio Deluxe Logbook (for awards and QSO fields) is 
only as good as the data that comes from the other logbook source. There 
will always be some anomalies that the operator will have to sort out. 
This is generally because other programs may not have country data that 
is up-to-date.

Exporting Log Files
Logs can be easily exported for import into other logging programs. To export a 
log from Ham Radio Deluxe Logbook, follow these steps:

1 From the menu in Logbook, select Logbook > File > Export, and then 
choose the relevant option from the list of five shown. Most often, ADIF 2 
is used.

2 Provide the export filename by clicking the button to the right of “ADIF 
Filename”.
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3 Options are provided to select the field set for exporting.
4 The operator can export All or Selected logbook entries.

• Tip:  Exporting selected logbook entries is a great way to update stand-
alone logbook databases located on multiple computers.

Backup & Restore
Operators are encouraged to allow the automatic log backup to keep their log data 
safe.

The “Automatic Backups” is found in the file menu under Tools, Configure, 
Backups.  Backup files are saved in a proprietary XML format that ensures that 
information that is unique to Ham Radio Deluxe Logbook (like user-defined 
fields) are safely backed up.  Some, but not necessarily all, of the backup loca-
tions should be used.
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Note:  For this reason, making copies of ADIF files is not considered a 
backup method. Using an ADIF as a backup method could result in data 
loss. ADIF is an “amateur radio interface format” and was intended to 
interface logs between dissimilar systems by defining common fields.

The Backup file field is the folder where the native XML file is created. This is the 
most commonly utilized backup file.

The Archives section provides two options.
• Compress to folder creates a compressed version of the XML for every 

backup made. It’s a compressed version of the Backup file and placed into 
the folder of the operator’s choosing.

• Add to archive puts the XML into a compressed folder selected by the 
operator.

One successful approach is to make use of some of the free cloud storage services 
like Dropbox, Microsoft OneDrive, Box, and Google Drive to ensure that a hard 
drive failure could not cause a loss of logbook data.

The Backup databases selections determine the frequency or conditions for which 
backups are made to the selected methods above.

Country Data
Ham Radio Deluxe utilizes a country and prefix database that is roughly equiva-
lent to the AD1C list (http://www.country-files.com). The country data itself 
doesn’t require constant maintenance.  It is updated when new countries are added 
or removed from the DXCC list.  The prefix masks contained within this data is 
rather complex and it is recommended that operators do not modify it.  Updates 
will be made as frequently as necessary.
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The countries information can be seen by clicking on Countries and then Manager 
within the Logbook main menu.

From here, users can also access the Unique Callsign Database by 
clicking on the “Unique Calls” button.

This prompts the operator for the Public or Private UCSDB.

It is recommended that operators do not add or modify the entries in the Public 
UCSDB. These will be maintained and updated as frequently as necessary by 
Ham Radio Deluxe Software. Operators can create entries in the UCSDB by 
clicking Private and entering specific information about a callsign.

Clicking the Add button provides a dialog box that the operator can use to enter 
the information.
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Note:  While this method can be very effective, the operator should consider 
that using the Logbook as a callsign lookup source provide the same 
capability in real-time. That is – if the operator gets a call logged to the 
correct country on the first QSO, then the need to maintain a Private 
USCDB is unnecessary. 

Hint: The lookup methods already use the Public UCSDB to assist the operator in 
logging the QSO to the correct country on the first try.

Callsign Lookup sources
It has become very popular to use callsign databases from the Internet or CD to 
lookup information about another station. Ham Radio Deluxe supports a number 
of callsign databases for lookup sources.

Callsign Lookup options are found under Tools > Configure > Callsign Lookup. 
The supported database sources are shown above. Two of them require a subscrip-
tion (QRZ.com and Hamcall.net), four of them require a CD, one of them pro-



134 Ham Radio Deluxe

Callsign Lookup sources Chapter 7 - Logging and Managing QSO Records

vides free information about US callsigns (callook.info), and the Logbook and 
Country List are also used.

When the ALE is populated with a callsign, “tabbing” out of the callsign field or 
clicking the QRZ button executes the callsign lookup.  At that point, the empty 
fields in the ALE begin to populate based on the following logic:

• If the callsign is contained within the Unique Callsign Database (UCSDB), 
the Country and IOTA will be populated from this source first.  (This is not 
operator configurable.)

• Fields remaining empty from the UCSDB (if applicable) will be populated 
from the “Enabled Methods” in the order selected by the operator.  For 
example (using the image above):
• Logbook – If there is an existing QSO in the log for this callsign, then all 

populated fields from that logbook entry will be copied to the new QSO 
record.  Putting Logbook at the top of the list is a good idea, as it turns the 
operator’s logbook into a private UCSDB.

• QRZ.com (Subscription) – If there are any remaining empty fields from 
the previous sources, they will be populated by this choice if the data is 
available in this choice.

• Country List – If the previous sources did not populate the Country field, 
the callsign prefix is compared to the Country list and then the country 
field is populated.  Country list should never be moved to the top spot in 
the Enabled Methods and should normally be at the bottom of the list (last 
resort choice).

Note:  To reiterate, the order of the Enabled Methods is important. The 
empty fields are filled from the top method to the bottom method until 
the empty fields are filled with “available” data. If the sources in the 
Enabled Methods do not provide certain data, the field will be left 
intentionally empty.

Operators who use a CD database for lookup options see a performance benefit 
from copying those database files to the local hard drive.
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Lookup Options

The Lookup Options tab enables the operator to provide the login information for 
online sources. CD fields provide the ability for the operator to provide the file 
path to the CD ROM drive or to the hard drive location where the databases were 
copied.

Test Lookup
The Test Lookup button is very important. This enables the operator to test and 
confirm that the selected methods are functional. Simply enter a callsign in – such 
as the operator’s call – and click Lookup. A file will pop-up that displays the 
retrieved information. If information is missing, then there is a problem with 
obtaining data from that source. (Commonly, the QRZ or Hamcall subscription 
are expired and need to be renewed online.)

External Log Interfaces
Ham Radio Deluxe Logbook has the ability to interface with a number of external 
online logging and awards systems. Presently the following systems are supported 
- LOTW, eQSL, HRDLog.net, and ClubLog.

Logbook of the World (LOTW) is supported when the TrustedQSL application is 
installed (required). Configuring LOTW is as follows:
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LOTW 
Download

Click the LOTW Download button, or access the download function through the 
Ham Radio Deluxe Logbook menu by selecting Logbook, File, LOTW, Down-
load. The following dialog box will be displayed. 

Note:  TrustedQSL is not used or required for LOTW Download.

1 The LOTW URLs should not be changed or the download will not work 
correctly.

2 The operator adds the Username and Password for the LOTW account.
3 The ADIF field will populate automatically and it’s rarely necessary to 

change it.
4 Select a date range. 

 Hint:  By default, the download will begin where the last one left off.

5 Then click the Download button and the results will be shown after the file 
is downloaded.
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If there are any errors in the downloaded file, they will be described in the above 
dialog box. Most commonly, there is a mismatch between the mode or band for 
the data previously uploaded to LOTW and the data in Ham Radio Deluxe Log-
book. This will tell the operator what needs to be resolved. Then a repeated 
upload will be successful.

6 Click Save To Database
7 Click Finish

Hint: This is the method that updates the QSL and (some) Award status fields in 
the Awards Tracking module. You will have to hit the Refresh button in the 
Awards Tracking tab in order to update the totals.

LOTW Upload Begin by selecting the QSOs that the operator wants to upload. From within Log-
book, this is done by using the Ctrl button and either left-click or shift-click to 
select records.

Then click the LOTW Upload button, or access the download function through 
the Ham Radio Deluxe Logbook menu by selecting Logbook > File > LOTW > 
Upload. 

Note:  TrustedQSL is required for LOTW Upload. The following dialog box 
will appear:

1 The LOTW URLs should not be changed or the upload will not work 
correctly.

2 The operator adds the Username and Password for the LOTW account.
3 The operator must tell Ham Radio Deluxe Logbook what folder TrustedQSL 

is installed.
4 If a Private password is used in TrustedQSL, it must be entered into the 

provided field.
5 The Station location must match exactly to the station location created and 

listed in the TQSL application under Add/Edit Stations.
HINT: This is the most frequent cause of upload failures.

The file fields will populate automatically and it’s rarely necessary to change 
them.
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6 Then click the Upload button and the results will be shown after the file is 
uploaded.

Tip: In order to know which QSOs to upload, it is quite helpful to add the LOTW 
sent field to the logbook layout (by clicking the Layout button and adding 
LOTW sent).  Select the QSOs where LOTW sent is No before clicking the 
LOTW Upload button.
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8  Awards Tracking
The Awards Tracking module in Ham Radio Deluxe Logbook provides the most 
complete award tracking features of any software available on the market. It 
tracks over 200 awards and endorsements in sixteen awards programs. Addition-
ally, users have the ability to create and track additional awards of the operators 
choosing.

Introduction
To open the Awards Tracking tab, click on the Awards Tracking icon in Logbook.

The Awards Tracking tab will be displayed. On the left of your screen you will see 
a list of sixteen Award Programs that are currently supported by Ham Radio 
Deluxe.

To the right of the list of awards programs, you will see the awards totals for the 
selected awards program (DXCC, in this example). When the award name is fol-
lowed by “(Ham Radio Deluxe)”, this signifies that the award is hard-coded into 
the program and cannot be modified. It is possible to copy these hard-coded 
awards and customize them to suit the user’s liking (this will be covered later).

The awards totals panel consists of “rows, columns, and cells” – similar to a 
spreadsheet. Understanding the meaning of the rows, columns, and cells is an 
easy but important step in using the awards feature. All awards programs conform 
to this format.

The rows represent awards or endorsements within the selected 
awards program. 
Endorsements are listed beginning with an asterisk below the related award.
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The columns represent QSO, QSL, and Award credits within the 
selected awards program. 
 Column descriptions are as follows:

Worked
This is the total number of entities within the awards program that have been 
worked, regardless of QSL or award credits. This is a QSO status column.

Confirmed
This is the total number of entities within the awards program that have qualifying 
QSL confirmations. Each awards program accepts different QSLs (for example, 
QSL cards, eQSL, and LOTW confirmations may not be accepted for all awards). 
The award is created to only include the QSL types relevant for that award. This is 
a QSL status column.

Need QSL
This is the number of entities within the awards program that have been worked 
but not confirmed. The information directs the operator to the QSOs that can be 
pursued for confirmation. This is a QSL status column.

Entities Needed 
This is the number of entities within the awards program that have not been 
worked. This is a QSO status column.

Not Submitted
This is the number of entities within the awards program that have been con-
firmed, but not yet included in an awards application. This information will be 
used by the operator to make an awards application. QSOs are not included in this 
total once they have been included in an application and appear in the Submitted 
column. This is an awards status column.

Submitted
This is the number of entities within the awards program that are part of a current 
application and awaiting approval. QSOs are not included in this total once they 
have been granted award credit within the program and appear in the Granted col-
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umn. LOTW download provides this data for confirmations obtained through 
LOTW. This is an awards status column.

Granted
This is the number of entities within the awards program that have been included 
and approved for award credit. LOTW download provides this data for confirma-
tions obtained through LOTW. (Cards included in applications prior to LOTW are 
not included in the LOTW download information and must be added manually.) 
This is an awards status column.

Note:  The “Not Submitted”, “Submitted”, and “Granted” awards status 
columns are “transitional” columns. That is – a given QSO can be in only 
one of these columns.

Award Reports
Printing awards reports is accomplished by selecting the File/Print option in the 
Ham Radio Deluxe Logbook main menu.

The data that rolls-up to the totals in these columns come from information con-
tained within the QSO records in the logbook as follows:

The Worked, Confirmed, Need QSL, and Entities Needed data comes from the 
QSL, eQSL, and LOTW tabs in the ALE. The Not Submitted, Submitted, and 
Granted data comes from the Award tab in the ALE. When the Award tab is not 
populated automatically from the online system (like LOTW), the information 
should be populated manually when applications are made. (Again, a given QSO 
cannot have both Submitted and Granted values. Selecting one de-selects the 
other.)
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The cells provide the totals for the column within the selected award. When 
you double-click on a cell, it will produce a list of the entities that represent that 
total.  For example, the following image indicates that there are ten entities 
worked for the DXCC Digital award where QSLs are needed:

Double-clicking on the “10” provides a list of those entities:

There are three choices for displaying the QSOs represented by this list. These 
three choices are available in the Filter icon in the icon bar above the list. Click-
ing this button “toggles” the filter between the three values.

 The Filter [Off] condition assumes that the operator wants to see all 
the QSOs among the list of entities shown. This is most helpful for 
chasing QSL cards (Need QSL column), where the operator wants to 

see all the QSOs with the displayed list of entities.

 The Filter [Oldest] assumes the operator wants to see only one 
QSO among the list of entities shown. This is most helpful for 
making award submissions (Not Submitted column) where only 

one qualifying QSO is needed.

 The Filter [Newest] assumes the operator wants to see only one 
QSO among the list of entities shown. This is most helpful for 
making award submissions (Not Submitted column) where only 

one qualifying QSO is needed.

 Once the desired filter is selected, the operator can display the results by 
clicking the View All button.

Example 1 What QSOs do I need to obtain cards from to increase my DXCC Digital Awards 
confirmation?

Going back to the ten entities in the Need QSL column, the operator would want 
to select Filter [Off] and View All. This would render a complete list of QSOs 
with those ten entities where a QSL could be obtained.
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Notice that, for the 10 entities where a QSL is needed, there are fourteen QSOs. 
This gives the operator the ability to decide which QSOs to pursue. The operator 
can select QSOs in this view and print QSL cards or labels from this list.

Hint: Select Ctrl + A will select all the QSO. Press the Ctrl button, while click-
ing individual QSOs, will select a number of individual QSOs as desired.

Example 2: What QSLs do I need to submit to include in my next awards application for the 
DXCC Phone Award?

The awards totals indicate that five QSLs are ready for to be submitted in an 
award application:
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Double-clicking on the “5” generates a list of the entities that will be submitted:

Because there may be more than one QSL for some of these entities in this list, I 
will select Filter [Oldest] and View All. This provides the list needed for submis-
sion:

The operator can print this list by clicking File/Print in the Ham Radio Deluxe 
Logbook menu. Additionally, the operator can save this list as an Excel or delim-
ited text file so that the information can be combined into a single award applica-
tion.
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Clicking on the Matrix button generates a matrix report for the selected awards 
program. This is very similar to the style of report that is provided by the ARRL 
for DXCC awards. But this report shows Granted (G), Confirmed (C), and 
Worked (W) countries by award.

Operators can create (define) their own awards by selecting the Definitions but-
ton in the Awards Tracking tab.

The operator can create a new award based on one of the hard-coded (Locked) 
awards by selecting one and clicking Copy, or build a new award from scratch by 
selecting Add.
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Because the awards definition builder is very flexible, it would be hard to describe 
a specific example. It is recommended that the operator tinker with this by creat-
ing a copy of a hard-coded (Locked) award and learning it through trial-and-error.

DX Cluster (and the associated Options)
Ham Radio Deluxe has a very powerful DX Cluster capability that is designed to 
maximize a DXer’s productivity. Configuring the DX Cluster window is done by 
clicking the Options button in the DX Cluster pane.

The following DX Cluster Options dialog box will be displayed:
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Connections 
Tab

The Connections tab defines how the operator will connect to the DX Cluster 
system:

A list of DX Cluster nodes (telnet servers) are shown. There are about 500 cluster 
nodes included. The operator can choose from one of those or add one that’s not 
included by giving it a title, providing the IP address or DNS name, and the IP 
port number.

If a password is required for the selected cluster, or Home node is defined by the 
operator, these are added in the Defaults section.

If the operator desires that the connection to be made when Ham Radio Deluxe 
Logbook is launched, or reconnected in the event of a disconnect, those options 
can be set in the upper right.
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At logon, the operator can opt to automatically pull down Announcements, Spots, 
or solar data from WCY or WWV. The number of each can be specified here.

The User Info is obtained from the My Station data.

Note:  If you are connecting to the same node from multiple computers, it is 
necessary to select a unique identifier – or SSID – for each connection. 
Failure to do so will disconnect the previously connected session.

Appearance Tab The Appearance tab provides options for changing the font or alternating row colors:
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Layout Tab The Layout tab is a very important tab, as it is where the operator will select the 
information that they wish to display in the DX Cluster pane.

The field names now provide an indication about the source of the information.
• Fields that begin with HRD indicate that the information provided is created 

by logbook from other related sources of information about that spot. For 
example, heading and distance are estimated using the “center-of-country” 
coordinates for the spotted station’s country.

• The fields that begin with Spot contain information that comes straight from 
the DX Cluster node. For example, the Country provided by the cluster 
varies in format between cluster nodes. Selecting Spot:DX Country will 
display exactly what the cluster node provides (which is why most operators 
prefer HRD:DX Country so that it’s shown in a consistent format).

• The fields that begin with “WSI” are Worked Status Indicators. These 
columns assist the DXer in determining what spots are needed for new 
countries on band or mode.

• The fields that begin with “Member” display an indicator that shows 
whether or not the spotted station is a user of LOTW or an AG member of 
eQSL.

Note:  It is HIGHLY recommended to use the layout Defaults for some 
period of time to gain familiarity with the most commonly selected 
fields.

Selection Tab The Selection tab provides options for the behavior when selecting spots.

• Selecting a spot – with frequency and mode change for the rig – can be done 
with a single-click or double-click. A double-click is recommended, as this 
gives the operator the ability to single-click to display the spotted station’s 
information in the Lookup Pane.

• Some operators want the ability to open multiple ALE windows 
simultaneously.

• DX Spider and CC Cluster have the ability to send the first “lot” of spots (as 
determined by the Connection tab) in a format that honors the server-side 
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filters.  Using sh/mydx is recommended (this works regardless of the 
existence of server-side filters).

• ITU region is selected here.
• The behavior of mode change and QSX are selected here.

Spot Filters The Spot Filters tab enables the operator to create filters for the data being delivered to 
the DX Cluster window (ie. after the application of server‐side filters). These filters are 
displayed in the dropdown menu in the DX Cluster window.
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WSI Tab The WSI tab defines the behavior of the Worked Status Indicator fields in the lay-
out.

On the left hand side, the WSI icons are defined and the QSL types to include in 
WSI are selected. In the right-hand side, the operator has the option of color-cod-
ing spots based on selected criteria.

Note:  If no QSL types are included, then the DX Cluster will not show a 
yellow yield sign (Worked, but not confirmed). Please select at least one 
QSL type.



152 Ham Radio Deluxe

DX Cluster (and the associated Options) Chapter 8 - Awards Tracking

Alarms Tab The Alarms tab enables the operator to define the criteria with which email or 
speech alarms are generated.

Selecting Add provides a dialog box for a new alarm. It must have a title, and then 
the operator can choose between callsign or Country alarm, by dropping the field 
down to select from a list of Countries. The filter field provides the option to 
select among the filters created in the Spot Filters tab.

The options select email and/or text to speech alarms configured in the next two 
tabs.
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Alarms:E-Mail 
Tab

The Alarms:E-Mail tab enables the operator to configure and test the email 
alarms. Using the email address for the operator’s smartphone is a nice option, as 
MMS text messages display nicely on a phone.
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Alarms:Speech 
Tab

The Alarms:Speech tab provides an audio indicator that an alarm has triggered.

QSL Members 
Tab

The QSL Members tab configures the update frequency and automation for the 
LOTW and eQSL (AG) member’s list. Operators are prompted for this when 
launching Logbook for the first time. The set-it and forget-it option is the recom-
mended choice. This sets both lists to Auto and does not ask before automatic 
updates.

(Interesting note: This data indicates that there are about 9,000 more eQSL AG 
members than LOTW members).

Button Bar

The button bar in the DX Cluster pane provides a number of useful options.
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Connect

The connect button starts a connection to the selected DX Cluster node. The DX 
Cluster node can be selected from a dropdown list.

Close
This button terminates the telnet session with the selected DX Cluster 
node.

While connected, the title bar shows what SSID the operator is using (WA9PIE-3, 
in the above example), the cluster node the operator is connected to (WA9PIE-2, 
in the above example), the type of DX Cluster node the operator is connected to 
(DXSpider, in the above example), and how many alarms are active.

Note:  Ham Radio Deluxe Logbook supports DXSpider, CC Cluster, and 
AR Cluster server nodes via telnet.

The filters dropdown (shown above) enables the operator to filter DX 
Spots based on the filters created in Options/Spot Filter. Provided val-

ues include HF, UHF, VHF, 160m, 80m… etc.
HINT: It is not good practice to try to filter spots by geographic zone from within 
Ham Radio Deluxe. These types of filters are best when created on the server/
node. Google search can provide the filter command set for DXSpider, CC 
Cluster, and AR Cluster.

NEW – The WSI Filter is a powerful asset to the DXer and 
DX awards fan. This filter is capable of hiding spots that are 

not needed for band or mode. Options are Band, Mode, and Band or Mode. As a 
result, the DX Cluster window will display the following:
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9  Digital Master-780
Introduction

DM-780 is a very sophisticated, feature packed, program that allows you to send 
and receive many of the popular amateur radio digital modes, including SSTV and 
several PSK versions using a computer sound card. It supports AFSK modes as 
well as FSK RTTY.

The program integrates with the Ham Radio Deluxe Rig Control program to control 
band and frequency changes without exiting the program. It’s also integrates with 
the Ham Radio Deluxe Logbook to allow easy callsign look-ups and logging of 
your digital contacts through its built-in Add Log Entry (ALE) screen.

DM-780 has features not found in any other program on the market today. The 
SuperSweeper gives you the ability to view and decode multiple signals using CW, 
BPSK and RTTY in single window. You can also enable the SuperSweeper History 
file to keep track of and display information about callsigns you have heard from 
your location.

The SSTV module has a built-in editor for creating templates for your outgoing 
messages on background pictures from your own photo collections. It can also 
place an incoming picture within one of your outgoing pictures so your contact can 
see just exactly how his transmission looked when you received it. These are just a 
few of the many great features of DM-780.

Getting Started
Computer 
requirements

Our suggestion of a minimum specification would be a Pentium 4 machine with 
2Gb RAM running at least Windows XP Service pack 3 - The program runs very 
well on Windows XP, Vista and 7 but will not run satisfactorily on older Windows 
operating systems.

Lets start... Start DM780 from within your Ham Radio Deluxe application by click-
ing on the DM780 button in the toolbar. For now continue to use the 
Dem-o-matic TS-2000 rig if you do not have a data interface with your 

radio.

When you first open the DM780 for the first time you will see a Getting started 
dialog that you must complete. The first item of business is entering your callsign.
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1 Click where is says Click here. This will open the Programs Options 
window.

2 In the first dialog line your callsign should auto-populate with the callsign 
listed in License Manager.

3 Enter you name in the line below labeled Name. We will come back and 
enter more information later in this chapter.

4 In the Programs Options window, select Soundcard in the first window on 
the left side.

5 Verify that correct sound card is selected. If it is not... well you know what 
to do. We will save calibration for a bit later.

6 Close the Program Options dialog window.

7 On the Toolbar click on Radio if it is not open.
8 Click on the Configure button in the Radio tool bar. This will open the 

Radio Configure dialog window.

Start here
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9 The Configure Radio window is where you layout your display. This is 
similar to what you can do in Ham Radio Deluxe Rig Control. If you do not 
see any radio functions, click on the Connect button.

10 You can close the Configure Radio window.

Connections Before you really use the DM-780 program you must make some connections to 
your rig for CAT control and audio input/output.

CAT Control
CAT control provides software control of your rigs receive and transmit features 
via a cable connected from the rig to either a serial port or USB port on your com-
puter.
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Some rigs, like the Kenwood TS-2000 only need a serial cable connection 
between the rig and the computer for rig control. Others require a CAT interface 
product of which there are several good ones on the market. Keep reading and we 
will discuss some of them. Some do rig control only while others interface rig 
control and audio.

Audio Input /Output
You also need an audio interface to send and receive the data (Audio tones) to and 
from your rig and this is done by connecting your rigs audio output and input to 
your computers sound card.

Audio 
Interfacing

DM-780 requires the use of a sound card some type of interface from the sound 
card to the radio. Although the computers built-in sound card can be used it is rec-
ommended you either install a second sound card. The second sound card can be 
either internal or external. The advantage of having the second sound card it can 
be used for your digital communications while eliminating the possibility of trans-
mitting unwanted computer sounds. You would also be able to listen to music on 
your computer while still operating in the digital modes.

Next we need to interface the sound card to the radio. Interfacing can be done in 
so many ways that it would take days to plow through all the available informa-
tion. You can do a Google search and find hundreds of articles on the subject. It is 
possible to connect your radio directly to your sound card without any form of 
isolation but it is not recommended. We’ll assume that you want to do things 
properly, so here is a home brew circuit that has proved its worth many times.

DIY Solution Audio Interface with Tx/Rx Control
This solution will work with any Icom or Yaesu rig that has a 6-pin mini-DIN con-
nector for external audio. It will work on just about any other rig but you will have 
to modify the connections to your radio. If you plan to use the circuit below, 
please check the actual connections to the mini-DIN connection of your rig.

Note:  HRD Software LLC does not accept responsibility for damage to 
your rig should things go wrong.
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A proven audio interface: Cheap and easy to build

You should always use the rig’s high-impedance audio output if there is one avail-
able: this supplies a constant signal level to the sound card. Most rigs also have a 
TX audio connector independent to the microphone input: you are advised to use 
this input. Some commercial interfaces don’t allow this: It is recommended that 
you avoid any interface requiring use of the microphone connector and speaker 
output of your radio unless there is no other option for getting the audio signals to 
and from the radio.

Commercial Interface Solutions
There are also some very nice commercial solutions available for interfacing the 
radio’s audio to the computer.

Timewave Technology has a very good reasonably priced CAT rig control product 
called the HamLink USB which allows rig control. As with all CAT rig control 
interfaces, the level of rig control is controlled by the capabilities of the rig.

Timewave also offers the PK232SC - which has a built in sound card and CAT rig 
control. This unit has many other useful features such as Digital Signal Processing 
which helps clean up the audio signal. More information can be found at their 
website: http://www.timewave.com

Tigertronics provides two different interfaces. One has a built-in sound card and 
one does not. The advantage of having an interface with a built-in sound card is it 
frees up the computer’s internal sound card for computer audio, such as listening 
to CDs, while using the external sound card for the digital modes.

SignaLink Model SL-1+
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The SL-1+ connects to your computer's sound card and to your radio's Mic, Data 
or Accessory Port. It is designed to work with ALL computer sound cards, and 
with ALL radios. The SignaLink SL-1+ is compact, low powered and fully iso-
lated for optimum performance. It supports ALL sound card Digital and Voice 
modes, and does NOT use a serial or USB port!

SignaLink USB

Note:  Neither SignalLink product interfaces with the radio for CAT control.

The SignaLink™ USB combines the legendary performance of their SignaLink SL-
1+ with a state of the art “built-in” low-noise sound card. The SignaLink USB has 
only one USB connection to the computer, and in most cases, only one connection 
to the radio. Convenient front panel controls make setup and operation very easy. 
The SignaLink USB is fully isolated and is compatible with ALL radio Mic, Data, 
and Accessory Ports, and supports virtually ALL sound card Digital and Voice 
modes. Both of the above interfaces are available from on the Tigertronics web-
site at http://www.tigertronics.com

Another commercial solution to interfacing the radio’s audio to the computer is 
the Navigator.

The Navigator

The Navigator interface is available on the web from U.S. Interface Products. The 
website is at http://www.navigator-interface.com/naviusa_004.htm The Navigator 
is a high quality interface between the rig and the computer, for use in running the 
digital modes such as PSK31, Olivia, MFSK, Hellschreiber, MT-63, etc. It also 
works fine for SSTV.

The Navigator interfaces to the rig using a USB port, thus it does not require a 
serial port on the computer. The Navigator has a built-in sound card for audio 
from the radio to the computer. It also provides CAT control to the rig via a serial 
connection from the Navigator to the rig. The Navigator is completely configured 
and defined in software, and future updates are expected to be flash-ROM updates 
that can be installed by the user.
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The Navigator is also directly supported by DM-780 by clicking on Program 
Options and then selecting Navigator from the list of options on the left side of 
the window.

micro KEYER II

Micro KEYER II™ is the most powerful single radio All-In-One USB interface 
and the only USB interface to fully support voice operation including microphone 
switching. With an single USB port, micro KEYER II™ works with any Windows 
based logging or control program for CW, voice, FSK and digital (RTTY, PSK31, 
SSTV, OLIVIA, MFSK, WSJT, etc.) operation. micro KEYER II™ includes a 
radio control interface that supports all standards (RS-232, CI-V, Kenwood and 
Yaesu TTL), a powerful CW memory keyer using K1EL's WinKey, a Digital 
Voice Keyer, two channel audio for transceivers with dual receivers, automatic 
microphone selection, and a buffer/sequencer for amplifier or LNA control. micro 
Keyer II is available from the MicroHam website at http://www.microham.com.

West Mountain Radio offers several RIGblaster products with various features. 
Visit their website at http://www.westmountainradio.com for more information.

Note:  Because West Mountain Radio control the radio in a slightly different 
manner we had to add special support for these interfaces. Please visit 
the Options in Ham Radio Deluxe and select the COM Port TX tab then 
click the West Mountain - RIGblaster support box (See image below)

Other companies who provide audio interfacing solutions that work well are:
• ZLP Electronics: http://www.g4zlp.co.uk
• Rig Expert: http://www.rigexpert.com/index?s=standard

If you choose to use one of the commercial audio interfaces, make certain you fol-
low the manufacturer’s instructions carefully for installation and set up.
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Program Options Overview

Clicking on the Program Options icon brings up the menu where you can config-
ure the appearance and many options found in DM-780. Below is a brief descrip-
tion of each option.

Program Options Menu

Appearance: Select the theme and skins used for the main display

Callsign (My Info): Enter information about your station used in macro tags and 
the My Station screens.

Clock: Configure appearance and time format of the tool bar clock

Logbook: Configures and connects DM-780 to Ham Radio Deluxe Logbook.

Modes + IDs: Configure CW and RTTY Ports and setup RSID and Video ID

PTT: Configure transmit Push To Talk options

Radio: Configure appearance of the radio pane

QSO: Configure appearance of the receive and transmit panes

Soundcard: Configuration of the soundcard used by DM-780
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Sounds: Enable warning sounds used by DM-780

Storage: Configure program and storage directories for DM-780

SuperSweeper: Configure DM-780’s panoramic frequency monitor screen

Waterfall: Configure DM-780’s waterfall appearance and options

Alarms: Set and maintain alarms

Favorites: Set up and maintain frequency/mode listings

Macros: Access to the Macro Manager

Modes: Create Modes tool bar on the waterfall display

Navigator: Configuration for U.S. Interface Navigator

Audio Recorder: Configure Ham Radio Deluxe audio recorder utility

PSK Reporter: Configure PSK Propagation Reporter

Soundcard Calibration: Calibrates soundcard for use in SSTV

Time Synchronization: Adjust computer’s time to national time standards
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Configuring DM-780
You should now have your audio connection made between the radio and the com-
puter so it’s time to start configuring DM-780.

Now, let’s get started. DM-780 can be run as a standalone program, however, to 
take advantage of the many integrated features from Rig Control and Logbook, we 
recommend running the entire Ham Radio Deluxe suite.

Your 
Information

1 Select Program Options from the Toolbar. This will bring up the Program 
Options window used to configure DM-780.

2 Select Callsign (MyInfo) from the menu on the left side of the screen.

QSO Tag and My Station Set up

3 Enter any additional information that you would like displayed. The center 
portion of this option contains information about you and your station used 
for substitution tags within DM-780 macro sets. We’ll discuss setting up the 
macro sets later on in the documentation, but for now, just type in all 
information under the QSO Tags section. Don’t worry about the lack of a 
SAVE button on this screen, your data is automatically saved when you exit 
this screen by clicking the red X in the upper right corner of the display.
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4 After you have entered the information in the QSO Tag portion, you will 
notice on the right side there is a button Edit My Station Direct. Clicking 
on this brings up the My Station data screen.

Information in the My Station screen is used by Ham Radio Deluxe Logbook. 
If you have already set up the Logbook portion of the suite, this screen 
should be populated with the required information and you can just close it 
out and continue with the set up.

My Station Set Up
Ham Radio Deluxe allows you to set up multiple QTH locations. This allows you 
to have a “Home” location as well as other locations such as a vacation home or 
favorite portable locations.

Multiple Callsigns
If your License Manager shows more than one callsign 
such as for parent and child or husband and wife, you 
are able to enter station set up information for each call-
sign. You can also set up “Guest” accounts for club or 
special event stations.
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If you haven’t already set up the My Station data, in the Description field you see 
the word HOME for a profile of your Home QTH. This generates your main 
“location”. Then go ahead and fill in all the rest of the information for this loca-
tion. Please note which fields are required if you use one of the DX Clusters.

Most of the fields are self-explanatory. A couple of the fields do need a little 
explanation. The field SIG stands for Special Interest Group. This could be a club 
or any organization you belong to. The SIG Info field could be a website address 
for a group. You could leave these fields blank if you like.

Another spot you might need help is once you enter your Locator, for example 
EN36QR, if you hit the little arrow that points downward, that will automatically 
fill in your Latitude and Longitude fields. 

By the same token, if you know your Latitude / Longitude, enter them and hit the 
upward pointing arrow to fill in your Locator.

If you operate from mobile or maybe have a vacation 
home, you can generate My Station profiles for those 
locations as well by clicking on the Add Location but-
ton. You can copy the data from the Home location to 
be placed in an additional location then just edit any-
thing that is to be different for that profile. Each profile 
is auto-saved when you exit the screen by clicking the 
red X in the upper right corner.

Once you’ve completed configuring your Tags and My Station, your almost home. 
Just a couple more things before you can go on the air live with DM-780.

Soundcard 
Setup

Now that we have our sound card interfaced to the radio and our personal infor-
mation set up its time to start configuring DM-780 to receive some signals.

The first thing we need to do is tell our software where the sound card for our dig-
ital operation is located. 

1 Click on Program Options, on the toolbar.
2  Select the soundcard option.
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3 Locate the Input (Receive) device at the top of the options. There is a drop-
down box where you select the input device on the sound card that receives 
the audio from the radio. In this illustration we are using the Microphone 
input from our USB external sound card.

4 For the Output (Transmit) device, another drop-down box where you 
select to send the audio from the sound card to the radio. In this case, the 
Speakers of our external sound card is selected.

5 Everything else should be left at DEFAULT for your system at this time. 
Just click the “X” in the upper right corner to exit the Program Options and 
your settings will be saved automatically.

You should now be back to the Getting Started Screen in DM-780. To clear this window, 
let’s click on the “X” on the tab just to the right of where it says “Getting Started”. This 
tab is located just below the QSO and the SuperSweeper icons on the menu bar. Your 
screen should now look like the picture below.
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DM-780 Tour
Now that we have the bawsic setup completed for DM-780 it is time to take a tour of the 
program. You will find this program to be both confusing and easy at the same time. That 
is what happens when you have a powerful application available to use.

DM-780 Toolbar QSO Window
Click on the QSO icon, located on the left end of the toolbar. This is going to open DM-
780s main display window.

The CW Mode screen above is divided into several sections. The larger white section is 
the receive panel, the smaller white section is the transmit panel. 

On the left side of the screen are several tabs. The top one is for the ALE (Add Log Entry) 
panel. The next one is for Macros. Both of these will be discussed in detail later in this 
section. The bottom tab opens the Tag window which you have already seen.
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The receive panel and transmit panel are self-explanatory. The receive panel is where 
incoming text is displayed. The transmit panel is where text is prepared for transmission. 
The ALE (Add Log Entry) section is just that. This is where data about your contact is 
placed to be added to the logbook after your QSO is over. Information in the ALE can be 
entered manually from the keyboard or automatically from one of the Call Sign look-up 
services configured in HRD’s logbook module.

Changing Operating Mode
To change this window to a different 
operating mode click on the mode select tab in 
the top left corner of the QSO window, There 
you will see over a dozen different digital 
operating modes displayed. Each of these 
modes is further sub-divided into variants of 
the digital mode. Note our example of PSK 
offers three variants of PSK for you to choose 
from. We have selected to most popular PSK 
operating mode.

After you have made your selection you will 
notice that there has been some subtle changes 
in the QSO window for operating in PSK.

Some things, however, have not changed as they are common to all of the operating 
modes.

Next to the mode selection tab is a series of 
tool icons. In order from the left:

Save Received Text - This allows you to 
save all your received text to a file in Rich Text Format in a location of your choice.

Viewer - Opens a viewer so you can view your saved received text.

Erase - Clear the receive screen.

Alarms - Manage and select user defined alarms. Help you spot desired stations.
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Channels - Select to receive one, two or three channels at one time. Allows you to 
keep tabs on up to three different conversations at one time. You can only transmit 

on the Main channel which is the top most or left most depending upon your display 
choice.

Options - This is another way to access Program Options that you have access 
through the toolbar.

Waterfall 
There is one important panel missing from our display. There has to be a way to tune in 
the digital signals on a frequency. That’s the job of the Waterfall.

On the tool bar click the Waterfall icon.

The waterfall is a requirement for working PSK and this version is loaded with 
features to make your digital contacts jump. Full operational details can be found 
later in this section.
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SuperSweeper

SuperSweeper is a great tool to see what is happening on the bands. This high powered 
tool allows you to set alarms to alert you of stations that you want to locate. The blue 
signal is caused by an alarm for stations calling CQ. The setting up and use of 
SuperSweeper is discussed later in the section.

Radio Panel
Thee next operational feature found on the toolbar is Radio. This allows control of your 
radio without switching back to Rig Control.

You can see that you have some controls displayed when you open up the window. There 
are built in features.
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There are several items in the radio panel toolbar that make 
operation easier. The << and >> icons shift your frequency 
up or down in 500 Hz increments.

The next group of icons allow to tune to preselected favorite 
frequencies either by selecting the frequency from the drop 
down list or by using the two arrow icons to scroll through the list. You can managed the 
contents of this list by selecting Manager from the drop down list.

Radio Panel Config
The last icon in the Radio panel is the config button. This 
allows you to cofigure buttons, drop downs and sliders that 
are very similar to those you set up in Rig Control. If the 
item does not have a label, no function is assigned and it 
does not display. 

To assign a function to one of the buttons, click on a button to select it and you will see a 
Select Button window where you can make your assignment. Do the same for the drop 
downs and sliders. When you are done click on the Save button.

The remainder of the icon buttons in the toolbar should be familiar to you by now.

Main Window Tour
We now return back to our main display. 

Now, let’s review selecting a mode. The most popular of the digital modes is BPSK-31 
and the most used frequency for this mode is 14.070 in the 20 meter band. At this time, 
tune your radio to 14.070 and set it to upper sideband, since ALL digital modes are used 
in upper sideband, with maybe one exception and that’s QPSK which can be used in USB 
or LSB. You might also want to tune your antenna for lowest SWR on this frequency 
before we go any farther.

Next, in the upper left corner of the large receive panel, you will 
see a small tab with a drop-down arrow. Clicking on this brings up 
the Modes menu. Highlight PSK and another menu will show up 
with BPSK-31, BPSK-63 and BPSK-125. Click on the BPSK-31 
mode to select.

Looking at the main display, you will also notice that the tab just 
above the ALE also reflects the current mode being used.
We have selected the mode so now take a close look at the 
Waterfall.
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Waterfall

The Waterfall actually has three sections. The top gray section is the Waterfall tool bar. 
The black area contains audio frequencies calibrated in HZ, and the blue area is the actual 
Waterfall. The reason for the name is the light colored signal traces flow from the top to 
the bottom of the display just like a waterfall. The traces are actually signals from 
different stations.

PSK Bandwith
The bandwidth of a BPSK-31 signal is 31.25 Hz. Our waterfall is 
about 3000 Hz wide. Since BPSK has such a narrow bandwidth, 
the use of audio off-set frequencies can be used to display many 
BPSK signals on the waterfall at one time. Notice how each signal 
is displayed under a different audio frequency on the waterfall. In 
the picture on the left you see what our cursor looks like on the 
waterfall. The yellow bar is about 31.25 Hz wide. There is an 
arrow at the top of the cursor and two lines extending downward 
from the cursor. Placing he cursor on a BPSK-31 signal with the 
arrow in the center of the signal and the trailing lines on either side of the signal tunes in 
the base frequency of 14.070 + the audio frequency off-set to allow you to decode that 
signal in the Receive panel.

Go ahead and try a few on your own. It takes a little practice to position the cursor 
properly.

Display Check
At this point if you are not showing any traces on your waterfall or are unable to decode 
the traces, go back and recheck your sound card settings, cables, and if using a 
commercial audio interface, read the manufacturer’s installation instructions over again 
to make sure everything is set correctly.

Once you are receiving and decoding signals its time to try to transmit using DM-780 and 
BPSK-31.

Transmit Panel The Transmit panel is where you prepare text to be transmitted. This text can either be 
entered manually thru the keyboard or by using one of the pre-defined macros. For this 
test we will be entering the text manually.

In the waterfall, place your cursor somewhere near the center of the waterfall on an area 
where you don’t see any signals. Wait a short time to make sure the frequency is clear and 
then proceed.

Before we continue with the transmit test it is recommended you install a dummy load, if 
you have one. If you don’t have a dummy load it’s best then to decrease your RF output to 
it’s lowest possible setting which will give you some deflection of your power meter to 
indicate you are indeed transmitting.

Place your cursor inside the lower Transmit panel of the main display. Now, type in the 
following:

CQ CQ CQ DE (your callsign 3 times with a space between each) followed by PSE K
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The transmit panel should look something like this:

Text in Transmit panel for sending

Transmitting
Pressing the Send or the F4 key will transmit the string you just typed in the Transmit 
panel. Your transmitter should now key and the text transmitted. As the text transmits it 
will show in the Receive panel and a strike-through will move through the text in the 
Transmit panel. Immediately after sending the text, press the Stop or the F5 key to un-key 
your transmitter.

Text send from the Transmit Panel

If your transmitter keyed and you have seen deflection on your power meter, you’re in 
business. If the transmitter keyed and you see no deflection of the power meter, first, go 
back through the audio set up and make sure you have selected the proper Output 
(Transmit) device in the Program Options sound card settings. If everything is correct 
there, try increasing the RF power just a bit and maybe even increasing the audio volume 
on the sound card you’re using. If you’re using one of the commercial external interface 
devices, check the installation instructions to make sure you have everything set correctly 
for the unit you’re using.

If all else fails, first contact the manufacturer or distributer for the sound card device your 
using. If all seems fine there contact HRD support through one of the methods listed on 
the support page at www.hrdsoftwarellc.com

Transmit 
Toolbar

Now we will take a closer look at the tools available on the Transmit Toolbar.

Transmit Tool Bar

Clicking on the Send button OR pressing the F4 key starts transmitting data currently in 
the Transmit panel.

http://www.hrdsoftwarellc.com
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The Auto button or F2 on your keyboard will start transmitting data currently in the 
Transmit panel and will automatically stop and return to receive mode when all text is 
sent.

The next two options are normally grayed out when in the receive mode. They are the 
Pause (F3) and Stop (F5) buttons. The Pause button allows you to pause transmitted text 
at any point while it is send. This allows you to edit the text following the pause, such as 
inserting a comment or deleting part of it, then clicking the Pause again resumes 
transmission where it left off to the end of the text.

The Stop (F5) immediately stops the transmission and returns the rig to the receive mode.

The Break-In is a toggle and turns the Break-In mode ON or OFF. With this mode toggled 
on, text that is typed into the transmit panel is sent immediately, however, if you pause 
typing while this mode is turned on, the transmitter switches back to receive. Once you 
start typing again, the transmitter keys and you continue from where you stopped. This 
allows you to listen briefly to see if your contact is trying to Break-In on your 
transmission, just like is done during CW operation when a sender pauses briefly to see if 
his contact is trying to break in.

 As text is being sent, an overstrike line moves thru the text in the Transmit panel. 
If you Pause the transmission at any point, when you Un-pause it, the transmission 

continues where you left off. Pressing this icon removes the overstrike line from the sent 
portion of the text making it appear to be un-sent. When you resume, the transmission 
begins again from the beginning of the text in the window.

The Eraser icon does just that. Pressing this icon erases all text in the Transmit 
Panel.

DM-780 can send the contents of text files. Clicking on this icon allows you to 
navigate to a folder where you have text files stored. Once in the folder you can 
select a text file which will automatically be opened in the Transmit Panel where 

you can then transmit the contents of the file.

Clicking on this icon allows you split frequency operation in the current passband. 
To do this, first select the frequency or audio frequency where you want to transmit. 
Place your main cursor on that frequency and press the lock icon. An indicator will 

appear with a TX inside a little box that shows the transmit frequency. This will be the 
frequency where your contact will receive your transmissions.

Now, move your cursor to the frequency you are receiving on. This will 
be your contacts Transmit frequency. When you transmit, DM-780 will 
automatically shift and transmit on the frequency indicated by the TX 
marker on the Waterfall. In this case, the audio frequency is 1600 for 
transmit and 1700 for receive, a 100 Hz split.

To clear the split and go back to normal, just click that lock icon to release it.

This icon brings up a drop-down menu that allows you to turn off or set an 
interval timer. This comes in handy when calling CQ. You can set a time interval 
in this option to automatically send a CQ call for you at the specified time 

interval. Once you set a time interval, you start sending your CQ macro. Once it starts 
sending you will see the Repeat icon on the tool bar becomes active. Clicking on the 
Repeat icon now sets DM-780 to transmit the CQ macro, wait the preset time interval, 
and resend the macro again. This will continue until you click the Repeat icon to toggle 
the repeat off.

This is the icon to toggle your RSID on or off. For those not familiar with 
RSID, it stands for Reed-Solomon ID
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RSID was originally developed by Patrick Lindecker, F6CTE. The Reed-Solomon ID 
(RSID) is a short 16-tone MFSK transmission which identifies the mode in use. The 
RSID transmission is about 180Hz wide and lasts for just less than two seconds.

You should enable RSID when using an 'exotic' mode such as Olivia so that users of 
programs with RSID support know what mode you are using. For a full list of modes 
supported by this program look in the Program Options for Modes + IDs.

There are two ways to enable RSID: 1) In Program Options select Modes + Ids and check 
the option to show the RSID button in the Transmit tool bar, 2)Add the tag <rsid> to the 
beginning of a CQ macro. The latter is most recommended since it is rather annoying to 
have the RSID popup coming up EVERY time a contact transmits during a QSO. By 
including the tag in the CQ macro, the RSID information only displays when the CQ is 
received.

When activated, the Video ID places text in the waterfall which can be 
seen by the sending and receiving stations. The Video ID is based on the 
Hellschrieber digital mode. 

Video ID Set Up Screen

The Video ID is set up in the Modes + IDs area in the Program Options display of DM-
780. Above you can see there are several items you can have sent in the Video ID. 
Callsign, Mode, or both. When activated a display is seen on the Waterfall that looks 
similar to the one shown above. It can be sent in a Vertical or a Horizontal display. This is 
an eye-catcher for anyone sitting watching the waterfall.

This next icon toggles a mini-logbook display on the Transmit tool bar. Click once 
to turn it on and again to turn it off.

Mini-Log on Transmit Tool Bar
Last but not least, clicking on this icon activates the QSO Options panel from the 
Program Options menu.
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Receive Panel 
Toolbar

We’ve gone through the options on the Waterfall and the Transmit toolbars, so now we’ll 
look at the Receive Panel Toolbar.

Receive Panel Tool Bar

Clicking on this icon revels a drop-down menu where you can select the 
digital mode you would like to operate.

Click on this icon to allow you to save to a file all the text in the current receive 
panel.

Opens a Viewer to allow you to go back and review all text in the receive panel. 

This icon erases all text in the receive panel.

Clicking on this icon allows you to manage, select and activate alarms.

These icons move your cursor up and down the waterfall to the next active 
signal.

Rewind (replay) the last transmission on the current frequency selected on the 
Waterfall.

 This icon has a drop-down menu that allows you to activate up to three receive 
panes (channels), along with associated channel markers for each channel on the 
Waterfall. This allows you to monitor and participate in three QSOs at the same 

time, if you are one of those “Muli-taskers”…..

 Activates the QSO Options panel in the Program Options Menu.

Waterfall 
Toolbar

Looking at the Waterfall tool bar you will see buttons that control various things. On the 
left end you will see ZOOM. To the right of word ZOOM you will see a left pointing 
arrow, the number x1 followed by a right pointing arrow. This number controls the 
magnification of the waterfall. Click on the x1 will increment it to x2 and the arrows on 
each side will become active. Pressing on the left arrow will now shift the waterfall to the 
left and pressing the right arrow will shift it to the right. The magnification can be 
increased up to x4 by clicking on the number.

To the right of the word Main you will see a number. In the above picture the number is 
1862. That is the audio frequency that your main cursor is currently sitting on. On the left 
of this number you can see the left pointing solid red arrow. Clicking on this arrow moves 
the main cursor down the waterfall in 10 Hz increments. Clicking on the left pointing 
chevrons, between the arrow and the number, moves the cursor down the waterfall in 
increments of 1 Hz. These can be used for fine tuning in on a waterfall signal. The arrow 
and chevrons on the right side perform the same function except they move the cursor up 
the waterfall.

The next control is Signal. The blue arrows to the right move the cursor up or down the 
waterfall to the next signal detected.
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The Re-cycle symbol to the right of this plays back the last transmission received from a 
trace on the waterfall.

AFC toggles the Automatic Frequency Control on or off. 

The Decode button toggles a little receive pane on the waterfall that displays the text 
being received from the signal your cursor is centered on. 

The Option button brings up the Waterfall Options screen where visual changes can be 
made to the Waterfall.

Next is the Frequency Tool bar. When activated from the Options it displays the 
frequency the radio is tuned to. HRD Rig Control must be running for this option to work.

The rest of the tool bar explains itself. There is a list of 
bands. Clicking on a band button brings up a drop-down 
list of frequencies available on the band which are used 
by the mode you are in. If you change mode, the 
available frequencies change. Check the frequency to 
change the radio frequency.

Clicking on the Faves tool activates the Favorite 
Frequency panel. This panel contains an editable listing of modes and frequencies 
normally used by the modes in each band. Items with check marks in the Enabled column 
are the ones contained in the band buttons we previously described.

The Modes icon activates a panel where you can add another tool bar to the waterfall. 
This would be a Modes Tool bar, and could be displayed by individual mode buttons, 
such as BPSK-31, Olivia, RTTY, CW SSB, etc. It could also be configured to just display 
groups with drop-down pick menus for each mode. This is a choice for the operator. Use 
the extra space for the waterfall or take part of the waterfall to display this tool bar.
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Configuration Tabs
Above is the Waterfall Configuration panel. There are 4 tabs on this panel and each 
configure a different aspect of the waterfall. Below is a list of the options that are 
configured from this tab.

Waterfall Options Center Frequency Marker
Define up to three center frequencies, normally set to the center of a narrow filter. When 
enabled a [C] button is displayed in the waterfall tool bar.

Here the Center Frequency Marker is activated and set to the center 
of the filter. If you are decoding a trace to the left or right of this 
marker, clicking on the [C] marker tunes the radio to bring the bring 
the signal to center on this marker, therefore placing the signal your 
decoding in the center of the narrow filter.

You must also define a Radio macro button to enable the narrow filter 
- or select the filter from the radio pane in DM780 or from your 
radio's front panel.

Radio Macros
It is normally convenient to display special radio macro buttons in the waterfall tool bar. 
Typically radio macros are used to enable narrow or wide filters.

Various
Erase when changing frequency - erase the waterfall when the radio frequency changes.

Only update if visible - only updates the waterfall f visible - saves CPU cycles on 
computers with less powerful graphics cards.

Show radio frequency tool bar - shows the current radio frequency in the waterfall tool 
bar.

Show sound card in window title - shows the name of the current sound card selection 
in the waterfall title bar.

Tuning Guides
Tuning guides - channels - vertical bars displayed in the waterfall when help you 
position the M, A and B channels over the received signal.

Tuning guides - mouse - vertical bars displayed at the current mouse position in the 
waterfall, helps you correctly select a signal.

Tuning indicator - the traditional display which helps you tune a signal correctly.
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Waterfall 
Configuration

Waterfall Color Options
On this option panel the operator can adjust the color settings of the Waterfall to his own 
preference. This is strictly a trial and error type adjustment. If you don’t like one color 
setting, try another until you find something that you like and is easy on your eyes.

Waterfall color settings do not affect decoding!
The waterfall display takes the audio from the sound card and converts it to power (signal 
strength). If you enable the Spectrum option you see the relative signal amplitude. Use the 
color schemes to highlight the signal peaks so that you can find the signal traces.

Suggested Schemes
The best and most commonly used schemes are: Default and Scope 1
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Frequency, Mode, Speed Tab
This top section allows you to select the Mode for the Waterfall. You can display the 
standard Waterfall, display a Spectrum representation, or both. You can also adjust the 
Passband width to your taste. You can also adjust the speed that the Waterfall moves. The 
higher the speed the higher the CPU usage, so those with a slow CPU might want to 
select a slow speed to avoid a possible jerky display or pauses during printing of received 
or transmitted text.

The center portion of the above panel adjusts the Waterfall Display Mode only, and does 
not affect decoding. This section adjusts for clipping of the signal. Use clipping to shift 
the data so that baseline noise is at the bottom of the screen, thus giving a larger viewing 
dynamic range.

The lower portion of the panel adjusts the appearance of the frequency bar of the 
Waterfall. You can select the background and text color, and font for the numeric display. 
You can also adjust it to show either the audio frequencies or show the RF frequency + 
Audio. To do the later, requires a radio connection.



186 Ham Radio Deluxe

Main Window Tour Chapter 9 -  Digital Master-780

Weak Signal Configuration

Weak Signal Panel

This panel helps adjust and compensate for weak signals on the Waterfall.

Enhance / Amplify
When enabled all signals are uniformly increased in strength so that the strongest signal is 
at the maximum strength, similar to your radio's AGC option.

Advanced
When enabled automatic gain is applied to all signals by using an advanced digital 
amplifier algorithm.

This amplifier has both gain and bandwidth, the signal is amplified by the selected gain 
such that the signal strength of the strongest signal inside the bandwidth does not get 
clipped or cause visual overload.

Gain
The gain applied to the signal, range is 0 to 100%. The effect of gain depends to a large 
extent on the current Color scheme (selected in the Colors page).

Bandwidth
The bandwidth of the amplification applied to each signal, range is 100 to 1,000Hz.

Now that we have DM-780 configured, can both transmit and receive digital modes, and 
have gone through some of the various tool bar options, its time to start looking into the 
more advanced features of the program. This includes the use of macros to create short-
cuts to use during your QSOs, logging QSOs, using SSTV and customizing your display.

Since you should be basically up and running at this point, HRD Software LLC would 
like to welcome you to the fascinating world of Digital Communications.



Chapter 9 -  Digital Master-780 Main Display Configuration

Ham Radio Deluxe 187

D
igital M

aster 780

Main Display Configuration

DM-780 Main Display

There are many configuration options available for the visual display of DM-780. If you 
will notice there is a scroll bar located on the right side of the ALE panel. Using the scroll 
bar and sliding down to the bottom of the ALE reveals more control buttons for the ALE. 
Many people don’t like to have to use this scroll bar so one option is to reduce the hight of 
the Waterfall.

Placing your cursor along the top edge of the waterfall, just below the transmit panel, 
clicking and holding the left mouse button, will allow you to drag the top of the Waterfall 
down so you can see the options on the bottom of the ALE. Doing this, though, brings up 
another problem. When you get it to the point where you can see the bottom of the ALE, 
the Waterfall is so narrow it makes it hard to select the signals.

Full Screen 
Mode

An alternative would be to press your F11 key. This takes the display to the Full Screen 
mode.
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F11 – Full Screen Mode

Now in this mode you can see the lower part of the ALE, and as you will learn later, 
below the three icons at the bottom a line of text will appear when you have a call in the 
Callsign box indicating the worked status of that call. Plenty of room for all of that now, 
but another problem has been introduced.

You have lost your tool bar and have no way of selecting any other options available.

SOLUTION: Select an empty spot on the tool bar and click your right mouse button. A 
menu will pop up looking like the one at the left. Un-check each of those checked options 
in this menu to remove them from the tool bar. Remember, removing the Clock from the 
tool bar isn’t going to hurt you, you always have the system clock on the Windows Task 
bar. The frequency is displayed on the Waterfall tool bar. Everything else will now be 
available from the Text Menu at the top of the screen.

Now you can adjust the height of the waterfall to something easier to work with and still 
see the entire ALE without having to use the scroll bar.

Multiple QSO 
Windows

On the Text menu at the top of the display, click on QSO and select New Window. You 
will see a new tab appear on the display. The tab will be identical to the first one created. 
Click on this new tab. It doesn’t look like anything changed. Your still in the BPSK-31 
mode and the screen looks just like the previous tab.
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Click on the BPSK-31 tab, in the upper left corner of the Receive panel. When the drop-
down selection box opens, come down to RTTY and click on RTTY-45. You now have 
TWO mode tabs open on the main display.

Let’s try another. Click on QSO on the Menu and select New Window. You now have 
THREE mode tabs. In this new tab, let’s select Olivia 8/500.

The tabs in your display should look like the following picture.

You can have as many mode tabs open as you like and easily switch back and forth just 
by clicking on the tabs. To close a tab just click on the “X” located to the right of the tab 
name.
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If you a QSO and someone sends you a link a website, you don’t have to exit DM-780 to 
view the site. You don’t even have to open your favorite browser. All you have to do is 
click on the link, in the receive panel, a browser tab will open to the website you clicked.

Looking closely at the above picture, you can see you now have four tabs on the display. 
Three Mode tabs and the Browser tab.

DM-780 – Digital Modes
At present, DM-780 handles 14 of the most popular digital modes used in amateur radio. 
These modes are BPSK, QPSK, CONTESTIA, CW, DOMINOEX, HELLSCHRIEBER 
(HELL), MFSK, MT63, OLIVIA, RTTY, RTTYM, THOR and THROB and VOICE. 
Each mode is subdivided into variants of the mode. 

The mode can be selected from a number of places in the DM-780 display, depending on 
how you customize your display. Modes can also be selected by right-clicking on the 
waterfall and choosing from the popup menu.

You can select from the Modes Pane, which can be pinned to the display or by clicking on 
the small mode drop-down tab located in the upper left corner of the Receive Pane. 
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You will find that some modes, like BPSK and QPSK require only about 25 to 40 watts to 
maintain a good QSO contact, while others require more power. You will also find that 
some modes, like OLIVIA and CONTESTIA, require more RF power but perform 
extremely well under adverse band conditions. You can often be able to copy an 
extremely weak DX station when there is a high noise level using one of these modes.

Experimenting with the different modes and variants can be a lot of fun and you can find 
the mode that works best for you under even the worst band conditions.
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DM-780 – Logging QSO
DM-780’s integration with the Ham Radio Deluxe Logbook makes it very simple to log 
each QSO by using the ALE (Add Log Entry) panel.

Add Log Entry 
(ALE) panel

If you DO NOT have Ham Radio Deluxe Logbook running and ARE NOT connected to 
it, this panel will be grayed out. If active, you can manually enter a callsign in the Call 
field, press the TAB key on your keyboard and depending on how you have the call look-
up configured in Logbook, the call will be looked up and all information will be 
populated in the ALE.

Once the callsign and other information is entered in the ALE, the “HIS TABS” will 
become active in the macros and when used will be replaced with the data from the ALE 
window.

There is also an alternate method of entering the callsign into the ALE and automatically 
completing the look-up.

You can place your mouse cursor on the callsign in the Receive Pane and right-click.
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ALE Alternate 
Method

Using this method brings up a context menu where you can select Callsign, left-click and 
the call will automatically be added to the ALE and the look-up will be performed to 
populate the rest of the data. This method makes logging quick and easy, especially 
during contesting.

In performing this alternate method of entering a callsign into the ALE, you might have 
noticed another feature of DM-780. When you hover over a callsign, a balloon will pop 
up indicating whether you have worked and logged the call in the past. 

Worked Status 
Pop-up

Again, these features will only work if you have Ham Radio Deluxe Logbook running 
and connected to DM-780.
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10  DM-780 – SuperSweeper
From the DM-780 tool bar, clicking on the SuperSweeper icon adds a tab to the main 
DM-780 display and brings up an outstanding feature of the program.

SuperSweeper 
Display

You can now switch between the SuperSweeper and the BPSK-31 display by clicking on 
the tabs just above the display window. You can also close the active window by clicking 
the “X” on the right end of the tab.

BPSK-31 – 
SuperSweeper 
Tabs

The advantage of using the SuperSweeper window is its capability to decode multiple 
signals on one screen. This is a lot different than using the main display with the waterfall 
or spectrum display where you can decode only the signal you have marked with your 
cursor.

Modes
Modes available in SuperSweeper are selected by clicking on the drop-down mode 
indicator in the upper left corner of the window.
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SuperSweeper Mode Selection

In the screen shot above, you will notice the call AK4VN followed by a check mark and a 
red X. If you have HRD Logbook running and are connected, when SuperSweeper 
recognizes a call it places it on the end of the red trace. The symbols after the call are 
Work Status Indicators. The first, the green check mark, indicates you have worked the 
country of origin for this call. The red X indicates that you HAVE NOT worked this 
operator. In the above, what we’re seeing is, the country of origin of this call is the United 
States and we have worked it, but we have not had a QSO with AK4VN.

History Report Another useful feature of SuperSweeper is the History report. Clicking on the History 
icon in the SuperSweeper tool bar brings up this feature.
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SuperSweeper History

When enabled, the History logs callsigns recognized, by SuperSweeper, the time, band, 
continent and country of origin. It also shows if you have worked the country, indicated 
by either a green check mark for worked or a red X for not worked, and whether or not 
you have worked that particular call.

This feature can come in handy if you are trying to determine how the propagation on a 
band is running. You can find what areas are being received the most, at your local 
station, and by checking the times you can see what time of day the propagation into an 
area was the best from your station.

This feature can be enabled or disabled by clicking the Enable button on the History 
panel. You can also enable or disable the Status, which shows at a glance how many 
countries, how many stations and what continents were heard by clicking on the Status 
icon. 

Clicking the Report icon transfers the data from the History panel to the Notepad, where 
you can save or print the report if you choose to keep it for future reference. Clicking on 
the Erase icon clears the History.

Starting a QSO from the SuperSweeper can be done using two different methods. In the 
first method, while watching SuperSweeper, and you see a callsign in light colored area 
on the left end of the trace, if you double-left-click on the callsign two things will happen. 
First you will be taken back to the main DM-780 display. The second thing that happens 
is the call you clicked on will automatically be transferred to the ALE and an automatic 
look-up will be done to populate the information about the call. You will also find your 
cursor is on the frequency that is being used by the QSO. 

QSO 
Connection 

From here all that needs to be done, when the contact finishes his current QSO, you hit 
your CALL macro which puts out a call for the station callsign appearing in the ALE call 
field. From there just proceed as normal to carry on your QSO with the contact.
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The second method is holding a QSO in the actual SuperSweeper window. On the 
SuperSweeper tool bar, clicking on the QSO option changes the layout of the window. 

SuperSweeper QSO Display

You will now notice you have the ALE panel, a QSO RX and a QSO TX panel displayed 
along with the SuperSweeper. Clicking on the red trace of any QSO will now display the 
received text in the QSO RX window located in the lower left part of the window. If there 
is a callsign displayed in the white end of the trace, hovering your cursor over the call will 
bring up the balloon to let you know whether or not you have worked that station. If you 
double-click on that callsign, the Call Look-up panel will open in the display. The 
callsign will be transferred to the Look-up panel and details will be populated from the 
call look-up service you have configured in the Ham Radio Deluxe Logbook. If you 
decide you would like to work this station, on the top of the Look-up panel, click on the 
LOG icon. This will populate the ALE panel. 

You can now make your contact and carry on your QSO just as you would do from the 
main DM-780 display using the QSO TX and the QSO RX windows. 

When your QSO is completed, click the ADD (F7) icon at the bottom of the ALE to save 
the contact to your logbook and clear the ALE for the next contact.
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11  DM-780 – Macro Manager
Macros are a great way to handle repetitive operations in the digital modes. They allow 
you to pre-define operating procedures and execute them with just a click of the mouse. 
It’s much more convenient to just click on a macro to send a CQ call rather than type in 
the call each time.

DM-780 contains a Macro Manager tool that allows you to set up and maintain an 
unlimited number of macro sets to handle these procedures. When installing DM-780 for 
the first time you will find a default set of macro definition. This is usually a READ 
ONLY file and should be kept as a template to build other editable sets. Sets can be made 
mode specific for CW, PSK, RTTY or set up for contesting exchanges. The uses for 
macros are almost unlimited.

When you create a custom set of macros it’s recommended that you not only save the set 
within the DM-780 directory but also in an external directory, such as in a folder in your 
Documents. In the event you have to re-install HRD from scratch, having the macro sets 
saved in an external folder will eliminate the need to re-create the sets. You can just load 
them from the external folder and save them back into the DM-780 program folder.

Macros can be accessed from either a tool bar located between the Receive Pane and the 
Transmit Pane of DM-780 or from a macro pane which can be pinned to the display. This 
choice is yours.

Macro Toolbar Between the Receive pane and the Transmit pane, just below the Transmit tool bar, you 
will find the Macro toolbar. Left clicking on any one of the Macro buttons will 
automatically transfer the contents of the macro to the Transmit pane and depending on 
how the individual macro is configured, it will AUTO SEND the contents or wait till you 
press the SEND button to transmit the contents.

From here we can send a macro by clicking on the macro button or we can edit individual 
macros by right clicking on the macro button which will take you directly to the Macro 
Editor. For this part of the documentation we are going to use the Macro Manager by 
clicking on the far right icon called Macros then click on the drop-down option 
Manager.
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Macro Manager

Above is a screen shot of the Macro Manager with the Default macro set displayed. From 
the Macro Manager you can edit the contents of individual macros, create new sets, 
modify the macro tool bar and edit how each macro functions.

Tool Layout
In the bottom portion of the Macro Manager you will see three columns. 

Appearance
The first column manages how the tool bar appears on the main display. With a tick in the 
“Button” option, the macros are shown on the tool bar as individual macro buttons. 

With the tick in the “Popup” option, the macros are displayed as GROUPS with a drop-
down menu for each group to select the macros within that group.

The next option under appearance is “Icons”. 

• If the function of a macro is set to “Send Immediately”, an arrowhead is 
placed to the left of the macro name in the tool bar. 

• If it is set to “Erase TX Window” after sending, there will be an “Eraser” 
icon in front of the macro name. 

• If both are ticked, both icons will appear.
• If the macro is a Radio Control macro, another icon will appear to designate 

the macro as a control macro.
In the Macro Manager screen you will see a column named “GROUP”. Each macro is 
assigned to a group. Under the Macro Pane heading there is a check box to display the 
macros in order of groups. You also see a check box for showing the macro set title. This 
title is displayed on the tool bar and also at the top of the macro pane.

The third column shows First Name. When a call is looked up and the data is entered in 
the ALE the contacts full name usually appears in the Name field of the ALE. By 
checking the box under First Name, when a macro is sent that contains the <his: name> 
tab, instead of sending the contacts full name, the macro will only send the contacts first 
name.
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Macro Manager toolbar

Above is the Macro Manager toolbar. 

• The New icon opens an empty Macro Editor window. 
• Copy allows you to highlight a portion of one macro definition and paste it 

into another macro.
•  Highlight a macro and click the Edit button brings up the Macro Editor 

and allows you to edit an individual macro. 
• Highlighting a macro and clicking the Delete icon deletes the macro from 

your list.
• Highlighting a macro and pressing the up or down arrow on the tool bar 

moves the icons position up or down in the list.
• Clicking on the Import icon brings up a drop-down menu of the ten macro 

sets in DM-780. This can be used when creating a new macro set. You can 
create an empty set then Inport an already created set into the blank one to 
use as a template to edit the new set.

• Clicking the Defaults loads the Default set of macros.
• If you have created more than ten sets of macros, you have the ability to 

Save these additions sets to some location of your choice. Once the set is 
created click the Save As icon to save the set.

• The Load icon allows you to load any macro sets you have saved. These 
functions give you the ability to have an unlimited number of macro sets.

New Macro Sets This next section will deal with creating a new macro set. As mentioned before, it’s 
always best to keep the default macro set as a template. This can remind us of the format 
for each macro.
 

To create a new macro set, just above the window that contains the macro definitions, you 
will see a field called Macro Set. This is a drop-down field which currently contains the 
word Default. Clicking on the drop-down arrow in the field brings up a box containing 
10 macro sets. Some of these sets may already have names assigned, which indicates 
there are already macros created within the set.

Select an empty set from this drop-down menu. Usually a name like Set followed by a 
number is an empty set.

Let’s say for example that you select Set 4. Clicking on Set 4 will bring up an empty 
editor screen with Set 4 showing in the Macro Set field. To the right of this field you will 
see a button that says Set Title. Clicking on the Set Title button will bring up a box where 
you can enter a name for this group of macros. 
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In our example, let’s name this new set My PSK so type this name over the name 
currently in the Set Title box and click the OK button. My PSK now appears in the Macro 
Set field. We are now ready to create the individual macros for this set.

We now have an empty macro set named My PSK in the Macro Manager. Since we’re 
new to programming macros we are going to use the Default set as a template to make our 
My PSK macro set.

On the Macro Manager tool bar click the Import macro. A drop-down box will appear 
and from that, place your cursor on Default and click the left mouse button. A new dialog 
box will pop up asking you if want to Replace My PSK with Default or Add Default to 
My PSK. 

Since we’re starting with a blank set it really doesn’t matter which you select. If you had 
macros already in this set and just wanted to add the Defaults to those you would select 
the Add option, or if you wanted to replace them you would select the Replace option.

With the Macro Editor, we create each individual macro and set how it executes. Here is a 
brief explanation of the various functions available in the Macro Editor.

Macro Editor Macros contain free-format text with optional tags. Tags are enclosed within angle 
brackets <> and contain:

• Information about yourself such as your callsign and name - taken from the 
Tags window,

• Information about the other station such as his callsign and name - taken 
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from the Add Log Entry (ALE) window,
• Special tags such as the date and time.

Example:

<his:callsign> <his:callsign> de <my:callsign> 
<my:callsign>
73's and thanks for the <my:mode> QSO k

In this example <his:callsign> is replaced with the value in the Callsign field in the 
Add Log Entry window and <my:callsign> is replaced with the value in the Callsign 
field in the Tags pane of the QSO window. (Select Tags from the QSO menu to display the 
Tags pane.) The 

 tag is replaced with the current mode (PSK31, RTTY etc.) as shown in the mode 
dropdown in the QSO window.

So if HB9DRV is working GD4ELI using RTTY the actual text sent is:

GD4ELI GD4ELI de HB9DRV HB9DRV
73's and thanks for the RTTY QSO k

Adding Tags
To add a tag to the current macro:

1 Position the cursor in the definition field where the tag is to be inserted.
2 Make sure Tags is selected in the tab strip.
3 Double-click on an entry - the my: and his: prefixes are added automatically.

Options
The extra options are:

• Send immediately - when the macro is selected DM780 starts sending.
• Autostop - switch to receive when the macro is sent.
• Start on new line - make sure the text starts on a new line.
• Erase TX window - erase the contents of the TX window when selected.

Load Text from File
When you select this option the text

<file:YOUR-FILENAME-HERE>File-contents-go-here<eof>
is added to the macro. Replace YOUR-FILENAME-HERE with the full path of the 
filename. the contents of the file replace the text between the <file:...> and <eof> 
tags. This option is typically used for sending weather reports from automatic weather 
stations.

Now we’ll create a macro that does a CQ call. The first thing is to create a title for the 
macro. In this case, the title will be CQ. Type the title in the title box at the top of the 
editor. 

The next field is “tool bar Title”. This is the title that appears on the macro button. Since 
we are going to have this macro do a CQ call two times, we will make the tool bar Title 
CQ X2, again without the quotation marks.

We’ll now create a Group for this macro. Let’s call this group CQ. Enter CQ in the Group 
field.

We want to make sure this macro is going to be Enabled on the macro toolbar, we need to 
place a check mark in the box to Enable the macro. This box is just to the right of the 
macro title field.
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In the large yellow area we can now build our macro. Place your cursor in the editor area 
and type CQ CQ CQ DE. Hit the space bar after the DE and look down at the Tags list. In 
the My Tabs column you will see callsign. Double-click on callsign and you will see the 
<my:callsign> tag displayed in the editor after the DE. Your macro will look 
something like this….. CQ CQ CQ DE <my:callsign>. Place the 
<my:callsign> in the macro two more times, making a space between each tag. 
Immediately after entering the last tag press ENTER on the keyboard and repeat the 
sequence. 

After entering the second CQ call, place PSE K and from the Special Tags column, 
double click on the Stop to place the <stop> tag at the end of the macro. Your finished 
macro should look like:

CQ CQ CQ DE <my:callsign> <my:callsign> <my:callsign>
CQ CQ CQ DE <my:callsign><my:callsign> <my:callsign> PSE 
K <stop>

When you’re finished entering your macro definition we can now set the macro options. 
For this macro, under the Macro Options, located on the right of the upper portion of the 
macro editor, place a check in all four options. These options determine how the macro is 
transmitted. It will start transmitting immediately when you press the macro button, it 
will begin on a new line, it will automatically stop at the end of the text and erase the 
transmit window when finished executing.

To save the macro just click the OK button in the lower left corner of the editor and you 
will be returned to the Macro Manager screen.

Now we’ll talk just a bit about some special tags used within macros. There are several of 
these tags that perform various operations. Some are used in standard macros and some 
are used to create Rig Control macros.

Reed-Solomon IDs
This idea was originally developed by Patrick Lindecker, F6CTE.

The Reed-Solomon ID (RSID) is a short 16-tone MFSK transmission which identifies the 
mode in use. The RSID transmission is about 180Hz wide and lasts for just less than two 
seconds.

You should enable RSID when using an 'exotic' mode such as Olivia so that users of 
programs with RSID support know what mode you are using.

For a full list of modes supported by this program look in the Program Options for Modes 
+ IDs.

There are two ways to enable RSID:

1 In Program Options select Modes + Ids and check the option to show the 
RSID button in the transmit tool bar. Clicking this button will transmit the 
RSID at the beginning of each transmission you make.

2 Add the tag <rsid> anywhere in the text being sent. By adding this tag to a 
macro, the RSID will only be sent when the macro is executed.

Insert Video ID
A special feature of DM780 is the ability to send an ID string which can be read in the 
waterfall - for more information select Modes from the Program Options in the main 
menu and tool bar. Many thanks to Dave Freese W1HKJ for the original design and 
coding in fldigi.

The Video ID bandwidth is ~ 80Hz.

When you select Insert Video ID the text
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<ident:YOUR-TEXT-GOES-HERE>
is added to the macro, the <ident> tag must be at the start of the macro. Replace 
YOUR-TEXT-GOES-HERE with the text to be sent, for example:

• Callsign:     <ident:HB9DRV>
• CQ:            <ident:CQ>
• 73:             <ident:73>

There are two special options:

• Call:        replaced with the callsign in the tags window, and
• Mode:     replaced with the current mode.

Whatever you send - keep the text short!

Callsign
<ident:call>CQ CQ CQ de HB9DRV HB9DRV HB9DRV pse K

Mode
<ident:mode>CQ CQ CQ de HB9DRV HB9DRV HB9DRV pse K

CQ
<ident:CQ>CQ CQ CQ de HB9DRV HB9DRV HB9DRV pse K

73
<ident:73>G4POP de HB9DRV 73 and thanks for this QSO

Radio Control A radio control macro contains commands sent to Ham Radio Deluxe to configure your 
radio, for example to set a special filter. The text in the definition is not added to the input 
(TX) window. These definitions are specific to the radio you are using.

The tag {{RADIO-CONTROL must appear anywhere in the macro definition. If you 
have added this by mistake just remove the lines containing the tag.

The easiest way to add entries is to use the Radio window, as you select options in the 
Radio window the options are sent to Ham Radio Deluxe and the corresponding text is 
added to the definition (remember to press the Connect button in the Radio window). 
Only add one entry per line.

Note:  Lines starting with # are treated as comments and are not passed to 
Ham Radio Deluxe. Blank lines are ignored.

Commands
There are four command types:

• Center frequency on/off,
• Drop down (menu) buttons,
• Normal press buttons,
• Sliders.

To simplify the command parsing any spaces in the button / slider names are replaced 
with a tilda (~). Slider entries contain the radio title, this is for historical reasons.

Center Frequency
• center-on
• center-on 1750
• center-off

To enable the current center frequency option in the waterfall enter center-on. 
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Note:  The center frequency option must be enabled (checked). To specify 
the center frequency just add the frequency in Hz after the center-on tag, 
for example center-on 1750.

To undo the center frequency option and restore the previous radio frequency enter 
center-off.

The center-on and center-off text must be the only entry on the line. Typically you 
combine these options with a filter settings, for example when enabling the center 
frequency option a narrow filter is selected, when undoing a normal (wide) filter is 
selected.

#++
#
# {{RADIO-CONTROL
#
# For the TS-2000
#
# Set the center frequency to 1250Hz, adjust DSP 
filtering
# to Low = 1000Hz, High = 1400Hz.
#
#--

center-on 1300
Set slider-pos TS-2000 DSP~low~cut 11 // DSP low cut = 11
Set slider-pos TS-2000 DSP~high~cut 0 // DSP high cut = 0

Drop down-Button
When you select an entry from a drop down button it is added to the end of the definition. 
Existing entries for the same drop down button are not overwritten as a drop down button 
can contain unrelated commands.

Press Button
When you press a button the editor first tries to replace an existing entry for this button; if 
there is no entry then a new entry is added to the end of the definition.
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12  Satellite Tracking
Introduction

Note:  This chapter needs a lot of TLC to get it to match the current 
build. It will get totally redone soon.      
N0ZRD - The Work Wacker

If you are new to satellite tracking visit http://www.amsat.org/ maintained by The 
Radio Amateur Satellite Corporation (AMSAT) for excellent articles written for 
new satellite users.

Ham Radio Deluxe‟s Satellite Tracking support would not be possible without the 
help of David Taylor and his open source satellite-tracking library. After using 
David‟s code to get started I wrote my own library, shipped as a DLL with Ham 
Radio Deluxe and based on NORAD SGP4/SDP4 Implementations by Michael F. 
Henry. 

Note:  The most important rule: it's the frequency on the satellite that is 
important, not the frequency on your radio. This is the most common 
mistake made when using a satellite.

If you are using two radios for satellite tracking – one for transmit, the other for 
receive – read this section first, then refer to  Synchronizer on page 92.

Dual radio support is arguably the most flexible way to work with satellites.

Satellites
The software requires information about the satellites you will be tracking, this 
information is known as Keplerian elements. Johannes Kepler (1571 – 1630) dis-
covered the three laws of planetary motion in 1609 and 1619 – a remarkable feat!
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The satellites window lists the files containing the Keplerian elements used to plot 
the position of satellites and compute the correct frequencies for the uplink and 
downlink.

The default folder is Satellites located below the folder where you have installed 
Ham Radio Deluxe - for example:

C:\Program Files\Amateur Radio\Ham Radio Deluxe\Satellites. 

To change the folder just press Select.

It is recommended that you update the data files in the Satellites folder when you 
start using Ham Radio Deluxe as the files shipped in the kits will be out of date by 
the time you start to use them. These files should ideally be refreshed every few 
days.

If you check the ‘Download when Satellite Tracking starts’ option then the files 
are downloaded every time you start satellite tracking.

To download the latest Kepler data files press Download. The files are down-
loaded to the folder containing your satellite data.

To edit the list of files press Edit List. The file is Ham Radio Deluxe Satellite 
List.txt in the folder Satellites folder.

Example:
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New satellite data files can be downloaded from the Internet, for example from 
http://www.amsat.org/ or from http://www.celestrak.com/ maintained by T.S. 
Kelso.

The only supported file format is two-line element sets, for example:

The verbose format is not supported.

The bare NASA format elements from http://www.amsat.org/ contain all satellites 
of interest to radio amateurs.

Alternatively if you look at http://www.celestrak.com/NORAD/elements/ you will 
see many files that can be downloaded. Just download these files and save them in 
the Satellites folder selected previously. For more information about the contents 
of these files browse http://www.celestrak.com/.

All text files in the Data Folder are loaded into Ham Radio Deluxe, so you should 
delete old files if you no longer need them.

Select up to 100 entries from the Available list by either double-clicking on indi-
vidual entries or by highlighting one or more entries and pressing >. By pressing 
>> all entries (up to a maximum of 100) are moved to the Selected list.
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Observer

In the Observer window you enter your location and height above sea level in 
meters or feet (for users more familiar with imperial measurements: 1 metre is 3.3 
feet). You also enter an optional list of stations that are plotted on the world maps. 
Only the checked [X] entries are plotted.

Enter your location either:
• By entering your Maidenhead Locator in the Locator field and the pressing 

Convert >> or
• By entering the Latitude and Longitude directly.

You also select the preferred time format; either Local (default) or UTC. Distance 
is displayed in either kilometers or miles.

You must press Apply to update the satellite settings.
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Ground Control

• This window is used to adjust your radio's TX (uplink) and RX (downlink) 
frequency to compensate for the Doppler effect (the apparent shift in 
frequency of a wave due to the relative motion of source and observer). 
Doppler shift is calculated in accordance with Kepler's laws.

• Enter the satellite uplink (your TX) frequency in the Satellite TX field.
• Enter the satellite downlink (your RX) frequency in the Satellite RX field.
• Select the VFO you will use for TX and RX (see rest of this section).
• If you are using a transverter select the Options tab and enter the transverter 

offsets.
When you are tuning remember that the important frequency is the satellite fre-
quency, not the frequency on your radio. The frequency on your radio is the satel-
lite frequency corrected for Doppler shift.

Tabs Plot
A plot of the selected satellite‟s position and footprint. Use the plot offset buttons 

 to offset the plot time.
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Options
Infrequently used options are located here to avoid cluttering up the display.

 Swaps TX and RX frequencies.

 Copies TX frequency to the RX.

 Copies RX frequency to the TX.

Displays pass details using the default text editor, useful for pro-
gramming memories in a handheld UHF/VHF transceiver.

For example:

 Reloads the latest Kepler data – see Satellites on page 129.

Doppler – the current frequency correction.

Transverter – if you are using a transverter enter the correct offsets here and check 
TX and RX as appropriate.

AMSAT.org
The satellite‟s page in AMSAT.org (if available). Note: not all satellites are sup-
ported yet.

This is a useful way of getting information about satellites modes and frequencies.
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Kenwood 
TS-2000

The computer can only update both main and sub frequencies either:
• In receive mode, or
• In transmit mode with SAT selected.

A special solution is required when the uplink (TX) and downlink (RX) frequen-
cies are in the same band. When you start the TS-2000 you have an extra TX VFO 
option Sub+XIT which is only used for same band split operation (see below). 
When selected the Sub VFO is used for transmitting, Doppler correction is 
applied by adjusting the XIT value.

Cross Band
In normal cross-band satellite mode (for example transmit on 70cms and receive 
on 2m) select:

The TS-2000 must be in satellite mode so that the computer can update the TX 
frequency.

Be careful with the TS-2000's TF SET button, each time you press TF-SET the 
uplink (TX) frequency and the downlink (RX) frequency are swapped. So if the 
frequencies in Ham Radio Deluxe are the opposite of those shown on the radio 
just press TF SET once.

Same Band (Split)
An example is talking to the astronauts on the ISS where the TX frequency is 
145.200.000 MHz and the RX frequency is 145.800.00 MHz. You cannot use SAT 
mode as this is only used for cross-band operation, so you use Split mode.

XIT will be switched on as soon as you check TX [X] updates. If you switch it off 
then Ham Radio Deluxe will switch it on again.

TX VFO TX), B/Sub (the TS-2000 always uses the Sub VFO for
RX VFO A/Main,
SAT on
Split off

TX VFO Sub+XIT,
RX VFO Main,
SAT off,
Split on.
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The RX (main) frequency on the TS-2000 is set to the correct RX frequency (sat-
ellite + Doppler correction).

The TX (sub) frequency on the TS-2000 is set to the TX satellite frequency; the 
Doppler correction is applied by adjusting the XIT value. When you transmit the 
TS-2000 displays the TX (sub) frequency +/- XIT so the frequency displayed on 
the TS-2000 is the correct frequency (satellite + Doppler correction).

When you start transmitting you may hear beeps from the radio - it takes Ham 
Radio Deluxe a few seconds before it detects that you are transmitting. When 
Ham Radio Deluxe detects transmit mode it stops updating the RX (main) fre-
quency until you return to receive as the frequency cannot be updated by the com-
puter while transmitting with SAT off.

Yaesu FT-847
You must select SAT mode on the FT-847 so that Ham Radio Deluxe can read and 
set both the TX and RX frequencies. It is not possible to determine the state of the 
FT-847's SAT button so you must press the SAT button in Ham Radio Deluxe so 
that it shows SAT as being enabled.

In normal cross-band satellite mode (for example transmit on 70cms and receive 
on 2m) select:

The FT-847 must be in satellite mode so that the computer can update the TX fre-
quency.

When in SAT mode the FT-847 takes a long time to respond to 'Read Frequency' 
requests - especially if tracking is on, as a result when you tune the FT-847 with 
the radio's tuning dial the displayed frequency will not update very quickly.

Other
The transmit frequency of some Yaesu radios such as the FT-817 and FT-857 can-
not be changed while in transmit mode, so it is not possible to apply Doppler cor-
rection while transmitting. If you think your Yaesu radio can be updated while 
transmitting please contact the author.

ICOM IC-910H
In normal cross-band satellite mode (for example transmit on 70cms and receive 
on 2m) select:

TX VFO B/Sub
RX VFO A/Main
SAT on
Split off
Tracking off 

(you do not need to enable tracking, the computer 
does everything for you, also the tuning response 
with Ham Radio Deluxe is much faster with 
tracking off). To switch tracking off press the A > 
B button underneath Track.

TX VFO Sub
RX VFO Main
SAT on
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The IC-910H must be in satellite mode so that the TX uses the Sub frequency. If 
the bands on the radio are the same as Ham Radio Deluxe but reversed press M / S 
to switch the Main and Sub frequencies.

Because the IC-910H cannot display the same band on both Main and Sub Ham 
Radio Deluxe cannot update the frequencies unless the correct bands are select 
using the radio controls.

In same-band mode:

A few notes:
• The TX mode is not updated from the radio.
• The software has to switch between Main and Sub so that the Sub VFO is 

updated, it is not possible to detect the radio's current Main / Sub selection 
so the radio operates in main mode all the time. If you press Sub on the radio 
you will see that radio switch back to Main as soon as the Sub frequency is 
updated.

Single VFO 
Radios

If you are using a single VFO radio such as the FT-817 then you use the same 
VFO for TX and RX. Use the TX (F1) button to switch between TX and RX. 
When you switch to TX the transmit frequency is loaded into the radio before it 
switches to transmit, when you return to receive the receive frequency is loaded 
into the radio after it switches to receive.

So the rule is: always use the TX (F1) button to switch between transmit and 
receive.

Linear 
Transponders

Check [X] the Linear Transponder Tracking option if you are using a linear tran-
sponder such as HAMSAT / VUSAT / VO-52. These satellites receive a specific 
range of frequencies (typically 40 - 100 kHz) in one band, convert them to another 
band and amplify the converted signal for transmission back to your planet. The 
converted signal is inverted - LSB becomes USB etc. - this is known as an invert-
ing transponder.

Do not use the satellite tracking built into your radio - let Ham Radio Deluxe do 
the work for you (for example on the FT-847 this is the Tracking option). To set 
up the linear transponder frequencies:

As you tune your RX frequency the TX frequency will be correctly adjusted by 
applying [1] offsets from the center frequencies and then [2] Doppler correction.

To adjust your transmit signal so that it matches the receive frequency use the spin 
button to the right of the TX center field. It will be necessary to adjust the transmit 

TX VFO Main
RX VFO Main
SAT off

TX center The center frequency of the uplink (TX) 
band. For example on VO-52 the uplink band 
is 435.220-435.280 MHz (LSB/CW) so the 
center frequency is 435.250.000 MHz.

RX center The center frequency of the downlink (RX) 
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signal as your radio(s) may not be correctly aligned, also the linear transponder in 
the satellite may also not be correctly aligned.

The tracking option in a radio cannot correctly compensate for Doppler, this is 
one reason why many QSO's drift gently across the linear transponder's available 
bandwidth. Only correct computer control will ensure that two or more stations 
stay on the same frequency while the satellite passes overhead. When using the 
linear transponder option Ham Radio Deluxe will correctly control your radio's 
frequencies so that are they are both compensated for Doppler shift.

Frequency 
Resolution

The frequency resolution is set the 1 Hz for:
• All ICOM,
• All Elecraft,
• All FlexRadio,
• All Kenwood.

All other radios are set to 10 Hz. If you have a radio that supports 1 Hz resolution 
and is not in the above list please contact the author.

Options
Option Description
VFO The VFO used for the uplink (TX) and downlink (RX). If checked 

[X] the selected VFO is updated regularly as the satellite frequency 
is corrected for Doppler shift.

Satellite The satellite frequency. Click the Open button to select a new 
frequency from a popup window containing the Favorites 
definitions or enter the new frequency. band. For example on VO-
52 the downlink band is 145.870-145.930 MHz (USB/CW) so 
the center frequency is 145.900.000 MHz.

Transverter If you are using a transverter enter your transverter's intermediate 
frequency here and check the [X] box. If you are not using a 
transverter either leave this field empty or do not check the [X] box. 
The radio frequency is calculated as: Satellite - Transverter + 
Doppler shift.

Radio The radio frequency as computed by Ham Radio Deluxe taking 
Doppler shift into account.

Satellite Select the current satellite from a dropdown list that contains the 
entries selected earlier in the Satellites window.

Plot for Determines the amount of information that is plotted over the 
surface of the planet for the current satellite.

TX > RX Copy the Uplink satellite frequency to the Downlink satellite 
frequency. 

RX > TX Copy the Downlink satellite frequency to the Uplink satellite 
frequency. 

TX <> RX Exchange the Uplink and Downlink satellite frequencies.
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Satellite

Schedule

This window shows the pass schedule for the satellites selected in the Satellites window.

Current Data

This window shows all computed information for a selected satellite. This win-
dow provides the data for the Ground Control and DDE windows.

Press Viewer to display the data with the default text file viewer, usually Notepad.
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Mutual Visibility

The mutual visibility window answers the question 'when is a satellite simultane-
ously visible from two or more locations'.

The information is determined up to 99 days in the future for any stations from the 
list defined in the Observer page.

The satellite is considered to be visible if the elevation is the same as or greater 
than the selected value.

Use the Viewer option to display the data in Notepad, for example:
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Satellite

Visibility

The visibility window gives you an overview of the satellites you have selected in 
the Satellites window.

Select the satellites that are displayed:
• All - displays all satellites,
• Visible now - displays only the satellites which are currently visible,
• Visible in next… - displays the satellites visible at any time in the time 

period you select, for example the next 60 minutes.
For each entry in this display the columns are:

Column Description
Vis Whether the satellite is currently visible.
Satellite The name of the satellite.
Azimuth The azimuth of a satellite is the angle between the vertical plane 

containing it and the plane of the meridian. It is customary to reckon 
the azimuth of a line from the south point of the horizon around by 
the west from 0[deg] to
360[deg].

Elevation The angular distance above the horizon.
AOS Acquisition of signal is the elapsed time at which the satellite 

becomes visible and a signal can theoretically be heard. If empty 
then the satellite is already visible.

LOS Loss of signal is the elapsed time after which the satellite is no 
longer visible and the signal can theoretically no longer be heard.

Lon The satellite's current longitude. 
Lat The satellite's current latitude.
Range The distance of the satellite from the observer's location measured in 

kilometers. (A mile is 1.6 kilometers; a kilometer is 0.62 miles.)
Altitude The altitude of the satellite above sea level measured in meters.
Range Rate The value required to calculate Doppler frequency adjustment.
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Next Passes

This window shows up to 1,000 passes for a selected satellite. Note: do not select 
more than 100 passes unless you have a very powerful computer, minimum CPU 
frequency of 2 GHz is recommended.

Press Alarm to add an audio alarm when a satellite is about to pass overhead. 
Press Plot to plot a selected pass in the Single Pass window.

Press Viewer to display the data with the default text file viewer, usually Notepad.

Single Pass
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Satellite

This window plots a single pass for the satellite selected in the Next Passes win-
dow. The elevation is plotted on the left y-axis; time is on the x-axis. Select Azi-
muth, Altitude or Range to be plotted on the right y-axis.

If Popup info is checked a vertical dashed marker line is displayed which either 
tracks the current time or is positioned by clicking on the chart with the left mouse 
button.

As the marker position changes, the azimuth, elevation, altitude and range are dis-
played in the marker fields.

Plot

This window shows the position of one to four satellites above the surface of the 
planet.
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DDE

This window controls the DDE server. If you want to use Ham Radio Deluxe's 
data with another program you must start Ham Radio Deluxe's DDE Server. 
Select the DDE format: currently only Nova is supported. Press Start to start the 
DDE server.
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13  Antenna Rotator
Introduction
Why? This program was written to provide better support in Ham Radio Deluxe and the 

associated satellite tracking software.

The Main Features

The main features are:
• Support for NOVA and Orbitron DDE.
• Connect to an unlimited number of rotators simultaneously.
• Many rotator protocols supports, for example:

• AlfaSpid,
• EA4TX,
• GS-232A,
• Idiom Press,
• Prosistel.

• Works maps – double-click to move the rotator.
• Full diagnostics in the logfile.

Your Locator Select Options from the Tools menu and enter your locator in the Your Informa-
tion pane.

Rotator Display
The same display is used for all rotators:
 

In the example above you see the software connected to an AMSAT IF-100 rota-
tor which supports both azimuth and elevation (it’s designed for tracking satel-
lites). The world map uses the famous Blue Marble image from NASA.

Connecting To connect the program to your rotator:
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1 Make sure all cables are correctly inserted,
2 Start your computer,
3 Start this program

Select the correct rotator type from the Rotator dropdown:

If the rotator supports more than one protocol then a Protocol dropdown is dis-
played, if so select the correct protocol to be used. If in doubt consult the rotator 
handbook.

If a serial or parallel port is used to connect to the rotator then select the correct 
port from the Port dropdown.

The EA4TX/ARSWIN option communicates with EA4TX’s ARSWIN software 
using the DDE protocol – ARSWIN must be already be started.

Select the Refresh rate – how often the rotator controller is polled for the current 
status. Some controllers such as the IF-100 cannot provide this information, in 
which case the Refresh rate dropdown is not shown.

Finally press Connect. If you experience problems look in the Logfile 
window.

Selecting a 
Bearing

Select a bearing by either:
1 Entering a callsign – the HRD countries file is used to locate the latitude and 

longitude for the country.
2 Selecting a country from the Country dropdown.
3 Entering a 4- or 6-character Maidenhead locator.
4 Just double-clicking anywhere on the map.

Switch between short and long path bearings by pressing either Short or Long.

Formats Two map formats are currently supported:
1 Mercator – an aspect ratio of 2:1, and
2 Great Circle – created from the Mercator image. A great circle map

You can zoom the image from 100% to 1,000%.

The Great Circle map can be rotated in steps of 30 degrees. This is often desired 
by users in the southern hemisphere. 
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Displaying 
Tracks

In the Mercator map you can display the signal track and bearing at the current 
cursor position by selecting Show Track from the Rotator toolbar.

DDE Support
Supported 
Format

The program contains a DDE client which accepts DDE data in the Nova and 
Orbitron formats from external programs such as HRD Satellite Tracking.

Before enabling DDE support:
1 Select either Nova or Orbitron in the DDE toolbar.
2 Make sure the Nova or Orbitron software is started.
3 Press Enable.

The DDE data is shown in the status bar.

You can now use the DDE data to drive the rotator – press Track DDE in the 
Rotator window.

Logfile
Using The logfile contains all diagnostic information. For full diagnostics make sure the 

Full Diagnostics option is selected.
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Use the Text Viewer option to display the logfile in your default text program 
(usually this is Notepad) from where you can save the logfile as a file on your 
hard disk.

Options
Appearance Select Appearance from the Tools menu.

Skin
As you have already seen in other Ham Radio Deluxe programs you can select a 
skin and display theme. Select Appearance from the Tools menu top display the 
Skin and Theme windows.

Image
Two images are included as resources in the executable file:

• NASA’s blue marble and
• David Taylor’s WXtrack.

You can select an image from a file on your computer; a good site for maps is 
http://flatplanet.sourceforge.net/maps/ with many great options.

Select High quality for image scaling unless you have a very low power CPU, 
normally CPU usage will not be a big problem. The quality is noticeable when 
zooming.

Select Options from the Tools menu or press the Options toolbar button to display 
the general options:

General Select Options from the Tools menu or press the Options button in the main tool-
bar.

http://flatplanet.sourceforge.net/maps/
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Your Information
You must enter your locator in this window so that the program can correctly 
compute bearings.

Parallel Ports
Use this window to configure your parallel ports if you are using and older rotator 
controller with a parallel port connection.
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Appendix A  
Command Tester
Introduction Too Many Radios

In a project like Ham Radio Deluxe it is not always possible for the developers to 
have every radio available for their own use: it’s very expensive and takes up too 
much room.

This is where the user community helps - by using the Command Tester individ-
ual commands are tested by the users of Ham Radio Deluxe and the results sent to 
the developers as a text file in a standard format.

Very often the problem is either determining the data returned for the various 
mode / filter / frequency combinations supported by a rig or working out how to 
set a rig option.

The handbooks supplied by manufacturers can be wrong or just not contain 
enough information to successfully implement a command.

Data Formats
There are major differences in the formats selected by the manufacturers whose 
radios are supported by Ham Radio Deluxe.

The Command Tester supports all necessary formats for the radio manufacturers 
supported by Ham Radio Deluxe.

Command Types
There are two types of command – Get and Set.

• A Get command returns an item of information, for example the VFO 
frequency or mode. 

• A Set command changes a rig setting, typically the frequency or mode.
Command Tester supports both Get and Set commands.

Starting To start the Command Tester:
• Make sure you have not connected to a radio with Ham Radio Deluxe if you 

will be using the same COM port for the Command Tester. If you have a 
radio connection then you must disconnect using the Disconnect option in 
the File menu.

• Select Command Tester from the Tools menu.
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Connect To connect to your radio you must select:
1 COM port where you have connected the interface cable to the radio,
2 The baud rate (COM port speed). If you are not sure of the correct speed 

consult your radio manual.
3 CTS used for flow control, specifies whether the CTS (clear-to- send) signal 

is monitored for output flow control. Used by Kenwood.
4 DTR used either for flow control or to provide power for the CAT interface. 

This depends on the manufacturer’s protocol and your CAT interface.
5 RTS used either for flow control or to provide power for the CAT interface. 

This depends on the manufacturer’ protocol and your CAT interface.
6 Then press Connect.

When you press Connect a warning message is displayed. Using incorrect 
commands can confuse some radios, so if you are not sure what you are doing 
now is the time to leave Command Tester.

7 Press Yes to continue.

General 
Options

These options are common to all formats.
• Send – sends a command to the radio.
• Erase – clears the contents of the results window.
• Save – saves the contents of the results to a file in ASCII format. You can 

send the contents of this file by email to help the developers of ham Radio 
Deluxe.

• Help – pressing help displays the contents of the small help window as a text 
file using Notepad.

• Close – closes the Command Tester. If there are entries in the results 
window you are prompted to save them first.
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Results The results are shown in the bottom half of the Command Tester window.
• Title – as entered in the Title: field.
• Send – the command sent to the rig, shown in ASCII and/or Hex as 

appropriate.
• Received – the received data, shown in ASCII and/or Hex as appropriate.

Platforms Examples of Ham Radio Deluxe use with various platforms is shown here.

Elecraft
The Elecraft protocol uses ASCII characters; it appears to be based more-or-less 
on the Kenwood protocol. Refer to the „Elecraft KIO2 Programmer‟s Reference‟ 
for full information.

The data sent and received is always shown in ASCII (text) that makes debugging 
relatively easy.

If you select Show hex output the returned data is also shown in hexadecimal (see 
the Change mode to RTTY below).

When a Set command is sent – for example MD6; to set the mode to RTTY there 
is no response from the rig, so instead MD6;MD; is sent – set the mode to RTTY 
(MD6;) and then read the mode (MD;) – this way there is always returned data.

In the Change mode to RTTY example above the returned string is shown in both 
ASCII and hexadecimal because the Show hex output option was selected for this 
command.

Fields
• Title – a description of the command you are testing, for example “Read 

Frequency” or “read Mode”. Mandatory
• Cmd – the ASCII string sent to the rig. Elecraft strings are terminated with a 

;
• Wait for rx terminator – when reading the response read characters from the 

rig until this character is returned or a timeout occurs.
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Examples

ICOM CI-V
The example below is uses an IC-7800 with:

• From: (controller address) E0 (personal computer, the default value),
• To: (CI-V address) 6A (the default for the IC-703). Refer to your ICOM 

radio manual for the correct CI-V address for your rig.
The data received from the radio is always shown in hexadecimal.

Fields

Test Description
Read 
Frequency

Command is FA; returned data format is FA + 11 digits + ;.
• FA00007035000; 

Frequency is 7.035.000 MHz.
Read Mode Command is MD; returned data format is MD + 1 digit + ;.

• MD1;
(1=LSB, 2=USB, 3=CW, 6=RTTY, 7=CW-REV, 9=RTTY-REV)

Read S-Meter Command is SM; returned data format is SM + 4 digits + ;.
• SM0000;

Returned value is in the range 0000 to 0015.

Field Description Status
Title a description of the command you are testing, 

for example “Read Frequency” or “read 
Mode”.

Mandatory

From controller‟s default address. Enter E0 (Personal 
Computer).

Mandatory

To transceiver‟s default address, the IC-703 uses 
68. The address used by your radio is found in 
the user manual.

Mandatory

Cmd command number (refer to the radio 
handbook).

Mandatory

Sub Sub command number (refer to the radio 
handbook). If there is no sub command then 
this field must be left empty.

Optional

Data if the command supplies data (for example 
setting a new frequency or mode) then enter the 
values in these fields.

If there is no data for the 
command then these fields 
must be left empty.
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Examples
These examples show a CI-V address of 6A, the default for the IC-7800. Change 
this to the CI-V address assigned to your radio.

Mode / Filter
A common problem is determining the data returned for the possible mode and 
filter combinations.

To list all combinations follow the following steps for each mode and filter com-
bination:

1 Select the Mode and Filter on your rig using the rig buttons and controls.
2 Enter a value in the Command Tester Title field which corresponds to the 

mode and filter selected in 1 above, for example Mode = USB, Filter = 
Wide.

3 Enter a command of 04; clear the sub command and data fields.
4 Press Send.

When you have finished press Save to save the contents of the Results window to 
a file which you can forward to the Ham Radio Deluxe development team.

Other
Follow the logic in Mode / Filter above for other commands which you want to 
investigate:

Test Description
Read 
Frequency

Command is 03, no sub command or data; these fields must be left 
empty.
The returned data is:

• FE FE (preamble)
• E0 (Controller address)
• 6A (IC-7800 CI-V address)
• 03 (Command number)
• 89 38 06 07 00 (frequency in BCD format)
• FD (end of message)

Read Mode Read ModeCommand is 04, no sub command or data; these fields 
must be left empty.
The returned data is:

• FE FE (preamble)
• E0 (Controller address)
• 6A (IC-7800 CI-V address)
• 04 (Command number)
• 00 01 (mode)
• FD (end of message)

Read S-Meter Command is 15, sub command is 02. There is no data; these fields 
must be left empty.
The returned data is:

• FE FE (preamble)
• E0 (Controller address)
• 6A (IC-7800 CI-V address)
• 15 (Command number)
• 02 (Sub command number)
• 01 09 (s-meter value)
• FD (end of message)
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1 Select the option on your rig using the rig buttons and controls.
2 Enter a value in the Command Tester Title field that corresponds to the 

option you are investigating.
3 Referring to your rig‟s handbook enter the command, sub command and 

data value as appropriate to read the rig‟s current value or set a new value. If 
there is no sub command or data then these fields must be left empty.

4 Press Send.

Yaesu
Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very 
similar to that used by Kenwood. So if you are fortunate enough to have the 
FTDX-9000 please use the Kenwood commands.

The example below uses the FT-817. The data received from the radio is always 
shown in hexadecimal. The overall format of Yaesu commands is always P1 – P4 
+ OpCode, the actual commands and the data returned from the rig depends on the 
model and also on the EPROM revision level.

Some commands do not require specific values for P1 – P4, it is recommended 
that is a value is not specified in the radio handbook then you enter 00, this is the 
approach taken in Ham Radio Deluxe.

Be aware that there are many errors in the Yaesu documentation, so the data

returned may not agree with the handbook and the radio‟s current settings.

Fields

Field Description Status
Title a description of the command you are 

testing, for example “Read Frequency” or 
“read Mode”.

Mandatory

P1 – P4 cthe command parameters. Not all commands require 
parameters; it is recommended 
that parameters that can be set 
to any value be set to 00. Fields 
left empty are set to 00.

OpCode the instruction OpCode. Mandatory
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Examples

Other Commands
For the commands you want to investigate:

1 Select the option on your rig using the rig buttons and controls.
2 Enter a value in the Command Tester Title field that corresponds to the 

option you are investigating.
3 Referring to your rig‟s handbook enter the P1 – P4 parameters and OpCode 

as appropriate to read the rig‟s current value or set a new value. If there are 
no values specified for P1 – P4 then enter 00 in these fields.

4 Press Send.

Portmon
Introduction This excellent utility for monitoring COM port activity can be downloaded from 

http://www.sysinternals.com/.

Quoting the Sys internals website: “Portmon is a utility that monitors and displays 
all serial and parallel port activity on a system. It has advanced filtering and 
search capabilities that make it a powerful tool for exploring the way Windows 
works, seeing how applications use ports, or tracking down problems in system or 
application configurations.

Portmon works on NT 4.0, Win2K, XP and Server 2003, Windows 95 and Win-
dows 98.

It is often useful to run Portmon when unexpected results are returned from a 
radio (or other device such as a rotator or keyer).

The Steps:
1 Close any programs connected to your radio or device being interrogated.
2 Start Portmon.exe
3 Make sure these options are set:

Test Description
Read 
Frequency 
and Mode

The OpCode is 03, P1-P4 can have any value, in this example they 
are set to 00.

• P1: 00 P2: 00 P3: 00 P4: 00 OpCode: 03
The format of the returned data is 5 bytes, the first four containing the 
frequency in binary coded decimal followed by the mode.
The returned value is 00 35 78 15 00 which corresponds to a 
frequency (00 35 78 15) of 51.875.300 and a mode (00) of LSB.

Read RX 
Status

The opcode is E7, P1-P4 can have any value, in this example they are 
set to 00.

• P1: 00 P2: 00 P3: 00 P4: 00 OpCode: E7
The format of the returned data is 1 byte. 
The returned value is 00.

Read TX 
status

The OpCode is F7, P1-P4 can have any value, in this example they 
are set to 00.

• P1: 00 P2: 00 P3: 00 P4: 00 OpCode: F7
The format of the returned data is 1 byte.
The returned value is FF (not in TX mode).
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4 Start Ham Radio Deluxe then connect to your radio.
5 Let Ham Radio Deluxe run for about 60 seconds while you perform your 

tests.
6 Stop Ham Radio Deluxe (File menu: Disconnect).
7 In Portmon set the Capture: Capture Events option to OFF.
8 Save the logfile to disk, put into a zip file if possible and send to 

mailto:simon@hb9drv.ch .

Sample Log For this example the Process and Port columns are not shown to save space. The 
log shows the startup for an IC-7800, results are in Hex. The Time for each com-
mand is shown which helps detect timeouts.

Menu Option State / Comment
Options Show Time ON
Options Show HEX ON if ICOM, Yaesu or TenTec

OFF if Elecraft, Kenwood
ON if you are not sure (I read hex)

Options Clock Time OFF
Computer Select your local computer
Capture Ports The COM port where you have 

connected the interface to your radio, 
select only one COM port to avoid 
confusion.

Capture Capture Events ON



Chapter  - N8VB vCOM

Ham Radio Deluxe 243

A
ppendix

N8VB vCOM
Introduction N8VB‟s vCOM driver creates up to ten sets of paired virtual COM ports; use 

these like you would use a null-modem cable. Virtual null-modems are pure soft-
ware; no hardware is involved.

Note: vCOM is only supported on Windows 2000, and Windows XP.

When using the 3rd-party program support you must use a virtual null-modem 
cable to connect Ham Radio Deluxe to the 3rd-party program. Ham Radio Deluxe 
opens one end of the virtual cable; the 3rd-party program opens the other.

Virtual null-modems are also used in the remote station support to connect Ham 
Radio Deluxe to the Ham Radio Deluxe serial port client program – see Remote 
Station Support on page 111.

N8VB‟s vCOM driver is copyrighted 2005 by Philip A Covington N8VB.

Configuration The easiest way to install the N8VB vCOM driver is by selecting N8VB vCOM 
Configuration from the Tools menu.

With this window you can install, update or remove the vCOM driver.

In the above example the driver version is 0.0.0.226 or build 266.

Input Files
The key files are:

• Driver – vCOM.sys,
• Information – N8VBvCOM.inf,
• Device console utility - devcon.exe (a command-line utility that acts as an 

alternative to Device Manager).
These files are shipped in the vCOM sub-folder.
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 To install a different version of the vCOM driver you must find the kit on 
N8VB‟s website, unpack it and select the information and device driver files.

 Selects the default files shipped with Ham Radio Deluxe.

Ports
Select the number of paired ports (null-modem cables) to be created and the port 
numbers assigned to the pairs. The port numbers must be unique; you must not 
select a port number already assigned to a hardware device such as the COM port 
on your computer.

If the vCOM driver is already installed the current values are read from the regis-
try, the key is:

HKEY_LOCAL_MACHINE SYSTEM
CurrentControlSet

Enum
Root

MULTIPORTSERIAL
0000

Device Parameters
Loads the default values from the currently select infor-
mation (.INF) file.

Installation
To install the driver a batch file (install.bat) is created which in turn uses 
devcon.exe. A sample batch file is shown below:

The batch file, device console (devcon.exe), device driver (vCOM.sys) and infor-
mation file (.INF) are copied to a temporary folder. The BAT file is then run from 
this folder.

When devcon starts you see a window similar to that below if you are using Win-
dows XP:
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Press  and the installation proceeds. A typical log is shown below:

After installing you must reboot your computer.

Update and Remove follow the same logic as installation using a custom BAT file 
and devcon.exe.

Auxiliary Switching
Introduction A standard PC used to come equipped with an 8-bit parallel port that can be used 

to switch auxiliary equipment such as antennas, bandpass filters and power ampli-
fiers. If yours does not, you can obtain an online or at a well equipped computer 
store a parallel port card that you can plug into your computer. This expansion 
card will not work on a laptop computer.
Ham Radio Deluxe supports the parallel port via fully configurable manager and 
monitor displays.
Typical uses of this option are to switch antennas, either automatically as the fre-
quency changes, or by selecting an option from the Parallel Port pane of the 
Selection window.

Technology The parallel port sends eight bits at a time. The layout of the parallel port pins is 
shown below.

The data pins are shown in red; D0 is pin 2, D7 is pin 9.
To indicate that a bit has a value of 1, a charge of 5 volts is sent through the cor-
rect pin. No charge on a pin indicates a value of 0. This is a simple but highly 
effective way to transmit digital information over an analog cable in real-time.
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Manager The manager window is invoked from the Tools > Parallel Port > Manager 
menu.

Definitions
Each definition consists of:

• [X] Enabled selection – if not checked then the definition is ignored when 
Ham Radio Deluxe detects a new frequency. The definition is still shown in 
the selection window if this option is enabled.

• Title – a description of the antenna or component that will be switched when 
the entry is selected.

• From – the lower end of the frequency range.
• To – the upper end of the frequency range.
• Port – the LPT port to be switched by the definition.
• D0-D7 – the parallel port data bit settings, each bit is either 1 (on) or 

0 (off). D0 is pin 2, D7 is pin 9.

Port Address
The default port addresses for LPT1, LPT2 and LPT3 are 0378, 0278 and 03BC 
respectively. If your computer has a different configuration just select the address 
that corresponds to the port.
You will find the port address via the Device Manager settings display located in 
the System control panel applet.
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Various
The options are:

• Auto-switch: as the frequency displayed by Ham Radio Deluxe changes a 
lookup is made against the parallel port definitions and the parallel port 
switched to the configuration for the first definition in the list that matches 
the new frequency.

• Selection window: displays a Parallel Port pane in the main Ham Radio 
Deluxe selection window. See Selection Window on page 45.
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Creating or Modifying Definitions
To create a new definition:

1 Select Edit > New from the Manager menu bar.

2 Enter a title for the definition.
3 Enter the frequency range for the definition.
4 Choose the port if you have more than one.
5 Choose a pin number. Make sure you are not using one that is already 

defined with another definition unless you have a need to.
6 Click on OK to save your new definition.

The steps to modify a definition are the same except that you must first highlight 
the definition and then select Edit > Modify from the manager menu bar.

Monitor The monitor window is started from the Tools > Parallel Port  > Monitor menu. 

The monitor:
• shows the current state of the data pins for a selected parallel port,
• allows you to select a definition, and
• toggle the data pins directly.

The Definition field shows the definition that matches the current pin 
selection (if any).

K1EL WinKey
Introduction “WinKey brings high functionality, fully featured Morse keying to logging appli-

cations. Although designed for Windows-based software implementation, 
WinKey can add value to all logging programs regardless of operating system or 
platform. Can also be used as a stand-alone keyer.”
Source: http://www.k1el.com/
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A lot of the description of the WinKey support is taken from the WinKey docu-
mentation, copyright K1EL.

(Photos from http://www.k1el.com/)
K1EL’s WinKey is an excellent computer controllable keyer solution. It supports 
everything a CW enthusiast could want. Many computer programs support 
WinKey; here is a description of the Ham Radio Deluxe support.
You will need a standard 9-pin serial cable (not NULL-modem).

Main Window Select K1EL WinKey from the Tools menu, the WinKey window is displayed.

Here the user is sending text at 12 wpm – the speed is adjusted with the slider in 
the top-left. If Repeat is checked the text is retransmitted after a user- configured 
value between 2 to 60 seconds, in this example 5 seconds.
Text is entered using the keyboard; only the allowable CW characters can be 
entered.
Macros are selected by double-clicking on an entry in the macros list or by using 
an accelerator key combination such as Ctrl+1.
Press F2 to start sending.

Characters sent to the keyer are marked with the strike through effect. Characters 
sent by the keyer to the radio are displayed at the bottom of the window.
Press F1 to mark sent text as unsent, F3 to erase the contents of the window.

Options Press the Options button (F8) to display the Options window. As an intelligent 
owner of the WinKey you will have studied the available literature, so some of the 
information here should be obvious. But in case you have forgotten something…
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Keyer

Select the type of keyer and the COM port to which the keyer is connected. 
When you press Connect the keyer is initialized and an echo-back test performed. 
The test must succeed for the connection to stay open. This ensures that you have 
not accidentally connected to another device such as a rotator, which may have a 
fit if driven by the WinKey protocol!
A sample log for a successful connect:

Autospace
If you pause for more than one dit time between a dit or dah WinKey will interpret 
this as a letter-space and will not send the next dit or dah until full letter-space 
time has been met.
The normal letter-space is 3 dit spaces. WinKey has a paddle event memory so 
that you can enter dits or dahs during the inter-letter space and WinKey will send 
them as they were entered. With a little practice, autospace will help you to send 
near perfect Morse.

Contest Spacing
Reduces the wordspace time by one dit. Instead of 7 dits per wordspace, contest 
spacing selects six dits per wordspace.

Paddle Echoback
When enabled all characters entered on the paddles will be echoed back to the 
host. From the host perspective paddle echo and serial echo are the same, in either 
case the letter sent in Morse by WinKey is echoed back to the host. The echo 
occurs after the letter has been completely sent.

Paddle Watchdog
The paddle watchdog counter disables the key output after 128 consecutive dits or 
dahs. This is to guard against the paddles being accidentally keyed continuously.

Swap Paddles
Allows right- and left-handed operators to share the same keyer.
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Serial Echoback
Echo back is a feature that is included to allow a host application to stay exactly in 
sync with Morse letters sent. When this mode is enabled all data taken out of the 
serial buffer is sent to the host after it has been sent in Morse. This allows the host 
to reconcile differences in timing introduced by WinKey‟s internal 32-byte serial 
buffer. Note that only letters, and not buffered commands with their parameters or 
wordspaces, are echoed back to the host.

Speeds

With Keyer minimum and Keyer maximum you set the range available in the 
WinKey main window.
Similarly with Speed pot minimum and Speed pot maximum you set the range 
available with the potentiometer mounted on the top of the WinKey enclosure.
Farnsworth speed is the speed at which characters are actually sent.

Options

These options define the shape of the transmitted signal.

Ist Extension
This addresses a problem often encountered when keying older transceivers that 
have a slow break-in response. Due to a slow receive to transmit changeover time, 
the first dit or dah of a letter sequence can be chopped and reduced in length. Add-
ing a fixed amount to the first element of a sequence can compensate for this. For 
example, an R would be sent with the first dit elongated but the subsequent dah-
dit sent normally. The compensation amount is transceiver dependent and is gen-
erally independent of sending speed. Note though that this is usually only a 
noticeable problem at higher CW speeds >25 WPM.

Compensation
This allows a fixed amount to be added to the length of all dits and dahs. QSK 
keying on modern transceivers can cause shortening of the dit and dah elements 
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that is especially noticeable at high speeds. WinKey allows the length of the dit 
and dah elements to be increased uniformly to compensate for this. The adjust-
ments are made in units of one-millisecond steps. The maximum adjustment is 
250 msecs.
Key compensation is very similar to Weighting in that any adjustment added to 
the dits and dahs is subtracted from the spacing so the speed is not changed. The 
difference between weighting and compensation is that compensation is indepen-
dent of speed, so if 10 msec of key compensation is selected 10 msec will be 
always be added regardless of speed. So be careful at high speeds and large values 
of key compensation, you may end up with no inter-element space.

Switchpoint
Controls when WinKey will start looking for a new paddle press after sensing the 
current one. If there is not enough delay the keyer will send unwanted dits or dahs, 
if there is too much delay it bogs you down because you can't get ahead of the 
keyer. The default value is one dit time (50) and is adjustable in percent of a dit 
time. Faster operators report a setting somewhat less than default is more pleas-
ing. If the paddle sensitivity is set to zero, dit and dah paddle memory is disabled. 
The delay is calculated with this formula:

DELAY_TIME = (SWITCHPOINT * DIT_TIME)/50
where SWITCHPOINT is a value between 10 and 90.

Dit: Dah Ratio
Allows WinKey to deviate from the standard 1:3 ratio of dit/dah. The formula to 
determine dah/dit ratio is:

DAH/DIT = 3.(nn/50)
A value of 50 selects 1:3, a value of 33 would select 1:2, and a value of 66 would 
select 1:4. This causes an intentional distortion of the Morse waveform. Some 
operators use this option to make their CW sound less “machine like”.

Weighting
This command allows a proportional amount to be either added or subtracted from 
the length of all dits and dahs sent. A value of 50 selects no weighting adjustment. 
Values less than 50 reduce weighting and values greater than 50 increase weight-
ing. Note that weighting does not affect sending speed because any increase in 
keyed time is subtracted from spacing time. A reduction in weighting results in a 
thinner sounding keying; increased weighting results in a heavier sound. Since 
weighting tracks speed, a given weighting will sound the same at all speeds.

PPT Lead / PTT Tail
WinKey provides a transmitter PTT output that can be used to switch a transmitter 
or linear amplifier over to transmit mode in advance of actual CW keying. You 
have control over the time delay between when PTT is asserted and when CW 
keying will start, this is lead-in. You also have control over how long the transmit-
ter will stay in transmit after keying has stopped; this is the tail delay.
Note: PTT pin 5 can be reconfigured as a sidetone output, see Sidetone Frequency 
option.

Sidetone
Pin 5 can be configured to output a square wave sidetone by using the Set Pin 5 
Mode option. When sidetone is enabled, pin 5 functions as a sidetone square wave 
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output. The PTT delays still work as described by the Set PTT Lead/Tail Com-
mand, but a PTT output is not available.
Available sidetone frequencies are: 3759 Hz, 1879 Hz, 1252 Hz, 940 Hz, 752 Hz, 
625 Hz, 535 Hz, 469 Hz, 417 Hz, 375 Hz.

Pin Config

Determines how the output pins are mapped.

Macros

Define an unlimited number of macros that can be selected in the WinKey main 
window.

Logfile

To help diagnose problems use the Logfile window. The Viewer option displays 
the contents of the window in your default text file (.txt) editor. If you check Trace 
then all traffic over the COM port is logged.
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Help

Some basic help text; specifically the Prosign key assignments.
Prosign Assignments

Settings
Overview User settings are stored in the registry and in files in the user’s application- spe-

cific data folder.

Registry The registry key used for storing options in Ham Radio Deluxe is:
HKEY_CURRENT_USER Software

Amateur Radio
HamRadioDeluxe

Options

The values in this key will not make much sense – they are used by Ham Radio 
Deluxe to preserve settings such as window geometry (size, position) and the cur-
rent scheme.

The values in the key can be safely deleted at any time. Don’t change values with 
a registry editor – you may cause unexpected problems for Ham Radio Deluxe!

Files Ham Radio Deluxe stores files in the folder defined by CSIDL_APPDATA, this is 
the file system directory that serves as a common repository for application-spe-
cific data. A typical path is:

C:\Documents and Settings\username\Application 
Data\Simon Brown, HB9DRV\Ham Radio Deluxe.

You will not normally need to directly access the files in this folder.

" RR / DN
$ SX : KN
' WG ; AA
( KN < AR
) KK = BT
+ AR > SK
- DU @ AC

File Description
*.css Cascading style sheets, used by HTML export options – for 

example in Logbook Analysis.
Ham Radio Deluxe 
Logbook.mdb

Logbook database

*.opt Optional schemes – see Schemes on page 29.
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 Archiving The Archive option in the Tools menu takes a copy of the registry values and files 
used by all Ham Radio Deluxe programs (Ham Radio Deluxe, PSK31 Deluxe, 
Mapper) and copies them to another folder.

 Select the destination folder

 Browse the From folder 

 Browse the To folder

 Start copying files and registry values.

Ham Radio Deluxe Bands 
02.txt

Band layouts

Ham Radio Deluxe 
Countries.txt

A default Log Windows country file

Ham Radio Deluxe Custom 
Defs - <radio>.txt

Custom CAT commands for a specific radio – see CAT 
Commands on page 103.

Ham Radio Deluxe Favorites 
01.txt

See Favorites on page 69.

Ham Radio Deluxe Logbook 
Analysis Defns.txt

TBA

Ham Radio Deluxe Macros - 
TS-480.txt

Macro definitions – see Macros on page 103.

Ham Radio Deluxe Parallel 
Port Defns.txt

Parallel port definitions – see Auxiliary Switching on page 
53.

Ham Radio Deluxe Satellite 
Definitions.txt

Used by Ground Control on page 133 – contains a list of 
satellites and associated frequencies and modes.

File Description
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When you press Copy you see a DOS window appear briefly a few times. Ham 
Radio Deluxe uses regedit /e to copy the registry values, this in turn causes the 
DOS to appear.

To restore registry values just double-click on a .reg file. Windows will prompt 
you to load the values into the registry.

Logbook Database
Introduction The logbook uses a very simple Access database. Originally DAO 3.5 (Access 97) 

was used as the programming interface; this has been replaced with ODBC in 
early 2006 starting with version 3.3 build 984.

Apart from getting away from DAO and the need to install the DAO support (not 
shipped with Windows) ODBC is needed for used of 64-bit Windows, as DAO is 
not supported on 64-bit Windows.

The database structure is the same for DAO and ODBC. Each table contains an 
auto-incrementing primary key. 

To analyze the database yourself:
1 Start Microsoft Access,
2 Convert the database if necessary using the Convert Database option 

selected from the Tools menu; do not overwrite the database!
3 Use the Analyzer> Documenter option selected from the Tools menu.

Notes:
Do not use programs such as Microsoft Access to convert the database – or if 
you do just make sure that you do not overwrite the database. If you convert 
to a newer version of Access you may not be able to open the database with 
Ham Radio Deluxe.

Take regular backups.

Tables Bands
This table defines the frequency ranges for the ADIF bands, used when exporting 
to ADIF.

Columns

Countries
The country list; used to lookup a country based on prefix, also to cross- reference 
a country and DXCC number.

Name Type Size
PrimaryKey Long Integer 4
MinFreq Long Integer 4
MaxFreq Long Integer 4
Title Text 32
ADIF Text 32
Comment Text 64
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Columns

Logbook
This table stores information for each QSO.

Columns

Name Type Size
PrimaryKey Long Integer 4
Country Text 64
DXCC Text 32
Comment Memo -
Prefix Memo -

Name Type Size
PrimaryKey Long Integer 4
Created Date/Time 8
Modified Date/Time 8
Station Text 32
EndTime Date/Time 8
StartTime Date/Time 8
Remark Memo -
ReportRecv Text 32
ReportSent Text 32
BandMHz Text 32
Mode Text 32
Frequency Text 32
Locator Text 32
Country Text 64
DXCC Text 10
IOTA Text 10
QSLRecv Text 10
QSLSent Text 10
QSLRecvDate Date/Time 8
QSLSentDate Date/Time 8
eQSLRecv Text 10
eQSLSent Text 10
eQSLRecvDate Date/Time 8
eQSLSentDate Date/Time 8
eQSLStatus Text 255
QSLVia Text 64
Name Text 128
Address Text 255
QTH Text 255
MyStation Text 128
MyOperator Text 32
MyOwner Text 32
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MyAntenna Text 128
MyCallsign Text 32
MyLocator Text 10
MyPower Text 32
MyName Text 32
MyCountry Text 64
MyStreet Text 64
MyCity Text 64
MyCounty Text 64
MyState Text 64
MyZip Text 20
MySig Text 32
MySigInfo Text 64
MyLatitude Text 12
MyLongitude Text 12
MyCqZone Text 8
MyItuZone Text 8
MyIota Text 10
Custom1 Text 64
Custom2 Text 64
Custom3 Text 64
Custom4 Text 64
Custom5 Text 255
Custom6 Text 255
AntAz Text 3
AntEl Text 2
AntPath Text 1
SatName Text 32
SatMode Text 32
ContestCheck Text 8
ContestClass Text 8
ContestPrecedence Text 8
ContestContest Text 64
LocationCounty Text 64
LocationState Text 64
LocationContinent Text 2
LocationArrlSect Text 4
LocationCqZone Text 8
LocationItuZone Text 8
LocationDistance Text 10
LocationLatitude Text 12
LocationLongitude Text 12
StationEmail Text 64
StationUrl Text 64
StationEquipment Text 255

Name Type Size
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Modes
The supported modes, this list contains all modes supported by ADIF.

Columns

QRZ
When a QRZ lookup is made a copy of the returned data is stored in this table so 
that subsequent lookups are much faster.

The fields correspond to the fields extracted from the returned QRZ data.

Columns

ADIF
Ideally Ham Radio Deluxe’s logbook will support all ADIF fields. The table 
below contains all ADIF fields as of ADIF spec 2.1.7 and the location in the Add/
Modify window. Grateful thanks to Dave, AA6YQ for maintaining order in the 
Yahoo! ADIF group.

StationAge Text 4
StationSig Text 32
StationSigInfo Text 64
StationTenTen Text 10
PropagationAInde Text 10
PropagationKInde Text 10
PropagationMaxB Text 10
PropagationNumB Text 10
PropagationNumPi Text 10

Name Type Size
PrimaryKey Long Integer 4
Title Text 32
ADIF Text 32
Comment Text 64

Name Type Size
PrimaryKey Long Integer 4
QRZUpdated Date/Time 8
QRZCallsign Text 255
QRZName Text 255
QRZAddr1 Text 255
QRZAddr2 Text 255
QRZCountry Text 255
QRZGrid Text 255
QRZHomePage Text 255
QRZQslMgr Text 255

QRZLatitude Text 32
QRZLongi- Text 32

Name Type Size
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This table is really a programmer’s checklist to ensure essential fields are sup-
ported. ADIF fields that have not yet been added have empty values in Ham 
Radio Deluxe Field.

• Antenna and Satellite are combined into one dialog.
For ADIF information: http://groups.yahoo.com/group/adifdev/files/ .

Ham Radio 
Deluxe 
Window

Ham Radio 
Deluxe Field

ADIF Field

Antenna/ Azimuth ANT_AZ
Antenna/ Elevation ANT_EL
Antenna/ Mode SAT_MODE
Antenna/ Name SAT_NAME
Antenna/ Path ANT_PATH
Contact 10-10 TEN_TEN
Contact Age AGE
Contact Email EMAIL
Contact Equipment RIG
Contact SIG SIG
Contact SIG info SIG_INFO
Contact URL WEB
Contest Check CHECK
Contest Class CLASS
Contest Contest CONTEST_ID
Contest Precedence PRECEDENCE
Location ARRL sect ARRL_SECT
Location Continent CONT
Location County CNTY
Location CQ zone CQZ
Location Distance DISTANCE
Location ITU zone ITUZ
Location Latitude LAT
Location Longitude LON
Location State/province STATE
Main Address ADDRESS
Main Band BAND
Main Cntry COUNTRY
Main Cntry (read- DXCC
Main End TIME_OFF
Main Freq FREQ
Main IOTA IOTA
Main Locator GRIDSQUARE
Main Mode MODE
Main Name NAME
Main QTH QTH
Main Remark COMMENT
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Main RST Recv RST_RCVD
Main RST Sent RST_SENT
Main Start QSO_DATE
Main Start TIME_ON
Main Station CALL
My Station City MY_CITY
My Station Country MY_COUNTRY
My Station County MY_CNTY
My Station CQ zone MY_CQ_ZONE
My Station Equipment MY_RIG
My Station IOTA MY_IOTA
My Station ITU zone MY_ITU_ZONE
My Station Lat MY_LAT
My Station Locator MY_GRIDSQUARE
My Station Lon MY_LON
My Station Name MY_NAME
My Station Operator call OPERATOR
My Station Owner call OWNER_CALLSIGN
My Station Power TX_PWR
My Station SIG MY_SIG
My Station SIG info MY_SIG_INFO
My Station State MY_STATE
My Station Street MY_STREET
My Station ZIP MY_POSTAL_CODE
Propagation A index A_INDEX
Propagation K index K_INDEX
Propagation Max bursts MAX_BURSTS
Propagation MS shower MS_SHOWER
Propagation Num bursts NR_BURSTS
Propagation Num pings NR_PINGS
Propagation Prop mode PROP_MODE
Propagation Solar flux SFI
QSL Info QSL Recv QSL_RCVD
QSL Info QSL Recv QSLRDATE
QSL Info QSL Sent QSL_SENT
QSL Info QSL Sent QSLSDATE
QSL Info QSL Via QSL_VIA
Depreciated OPERATOR
Depreciated VE_PROV
In ADIF files PROGRAMID
In ADIF files PROGRAMVERSIO
t.b.a. BAND_RX
t.b.a. FORCE_INIT
t.b.a. FREQ_RX

Ham Radio 
Deluxe 
Window

Ham Radio 
Deluxe Field

ADIF Field
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Links
Ham Radio 
Deluxe

Homepage –  http://hrd.ham-radio.ch/. 

Forums –  http://forums.ham-radio.ch/.

Yahoo! Mailing list –  http://groups.yahoo.com/group/ham-radio-deluxe/.

Other Software BV Software by DF3CN - http://www.df3cb.com/ . Excellent QSL management 
and label printing software.

DXLab by Dave Bernstein AA6YQ - http://www.qsl.net/dxlab.

IrfanView -  http://www.irfanview.com/. Great image viewer and sound file player.

t.b.a. GUEST_OP
t.b.a. NOTES
t.b.a. OWNER_CALLSIGN
t.b.a. PFX
t.b.a. PUBLIC_KEY
t.b.a. QSL_RCVD_VIA
t.b.a. QSL_SENT_VIA
t.b.a. QSLMSG
t.b.a. QSO_COMPLETE
t.b.a. QSO_RANDOM
t.b.a. RX_PWR
t.b.a. SRX
t.b.a. SRX_STRING
t.b.a. STATION_CALLSIG
t.b.a. STX
t.b.a. STX_STRING
t.b.a. SWL

Ham Radio 
Deluxe 
Window

Ham Radio 
Deluxe Field

ADIF Field
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INDEX
Numerics
3rd-Party Programs 94
A
Activation Key 10
Add ADIF Record 90
Add Quick Save Entry 59
Adding A Logbook Entry 105
ADIF 259

Add Record 90
Logbook Table 259

Advanced Features 67, 87
ALT 29
Ant/Sat 109
Archiving 255
Audio 87
Audio Browser 88
Audio Grabber 87
Audio Interfacing

DM-780 162
Autospace 250
Auxiliary Switching 245
B
Band Layout Manager 53

Adding A Definition 54
Copying A Definition 55

Band Layout Selection 36
Band Layouts 53

Adding A Definition 54
Copying A Definition 55
Manager 53
Selecting 55

Band Selection 29
Bands

Logbook Table 256
BSP 29
Button

Connect 32
selection 32

Buttons 30
Radio Control 30
Radio Feature Control 31
Ttuning Control 31

C
CAT Command 39
CAT Commands 59

Macros 59
Manager 59

Clock Format 36
Clock Position 42
COM Port TX 48
Command Tester 235
Commands

DDE Support 90
Commercial Interface Solutions

DM-780 163
Comms 47
Computer requirements

DM-780 159
Configuration

Customize Layout 37
Configuration Options 13

COM Port 17
Company 15
Connecting 18
Radio 16

Configuring DM-780 168
Connect 32
Connect Button 32
Connect Toolbar 32
Connecting to the Remote Server 77
Connection Process 15
Connections

DM-780 161
Contest 109
Contest Spacing 250
Controlling Your Radio’s Features 30

Buttons 30
Sliders 31

Countries
Logbook Table 256

Current Data 219
Customize Display 34
Customize Layout 37

Schemes 37
D
Database 99

Logbook 99, 256
Database Configuration 112
Date & Time 36
DDE 224

Satellite 224
DDE interface 5, 99
DDE Monitor 90
DDE Support 90

Commands 90
Dem-o-matic 13
Digital Master-780 159
Digital Modes

DM-780 190
Display

Buttons 41
Configuration

Buttons 41
Customize 37
Faceplate 42
Frequency 43

Layout
Radio Layout

Configuration 38
Meters 44
Schemes 37
Slider Layout 45
Sliders 44
Tuning Dial 45

Customize 37
date & Time 36
Faceplate 42
Layout 38

Customize 37
Display Scroll 30
DM-780 1, 159

Audio Interfacing 162
Commercial Interface Solutions

163
Computer requirements 159
Configuring 168
Connections 161
Digital Modes 190
Full Screen Mode 187
Logging QSO 192
Macro Editor 202

Tool Layout 200
Macro Manager 200
Macro Toolbar 199
Macros

Adding Tags 203
Load Text from File 203
Options 203
Radio Control 205

Main Display Configuration 187
Main Window Tour 176
Multiple QSO Windows 188
New Macro Sets 201
Program Options Overview 166
QSO Window 172
Radio Panel 175
Receive Panel Toolbar 181
Soundcard Setup 170
Station Set Up 101, 169
SuperSweeper 175
Transmit Panel 177
Transmit Toolbar 178
Tuning Guides 183
Waterfall 174, 177

Color Options 184
Configuration 184
Frequency, Mode, Speed Tab

185
Options

Center Frequency Marker
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183
Weak Signal 186

Suggested schemes 184
Waterfall Toolbar 181

DM780 35
Toolbar 35

DM-780 Toolbar 172
DM-780 Tour 172
DM-780Getting Started 159
Docking panes 51
Drop Downs 31
Dropdown Button 39
Dropdowns 40, 43

Hiding 40
Dual Radio Satellite Tracking 94
DXLab 262
Dynamic Data Exchange 92
E
Enable Restart 76
eQSL 108
External IP Address 67
F
Faceplate 42
Favorite 33

Toolbar 33
Favorites 56

Manager 56
Markers 58

File Locations 254
Files 254
Fine Tuning 28
Firewall 68
Firewall Ports 68
Frequency Direct Entry 28
Frequency Display 35

Configuration 36
Enhanced Display 35
Frequency Selection 27

Frequency Selection 27
FTDX-9000 52
Full Screen 34

Toolbar 34
G
Getting Started 27
Griffin 28
Ground Control 213
H
H1PH 1
Ham Radio Deluxe

Links 262
Remote Server 70
Serial Port Client 80
Serial Port Server 83

HamLinkUSB 4
HB9DRV 1

Hide dropdowns 40
Hide status texts 40
Hiding dropdowns 40
HyperTerminal 95
I
ICOM Calibration 48
Icom CI-V Details 19
Import / Export Logbook Data 117
Insert Video ID 204
Installation 5
Internal IP Address 68
Internet 49
Internet Connection 3
IP Address

External 67
Internal 68
Static 68

IrfanView 89, 262
K
K1EL WinKey 248
Keplerian elements 209
Keyboard Accelerators 46
L
Layout Size 42
Links 262
Load from File 38
Logbok

eQSL 108
LogBook

Custom 110
Logbook 1, 34, 99

Add 34
Adding An Entry 105
Ant/Sat 109
Contact 107
Contest 109
Database 256
Database Configuration 112
Import / Export 117
Location 108
Logbook Table 257
Main Display 104
My Station 110
Options 106, 111
Printing 116
Propagation 109
QSL 108
Tables 256

ADIF 259
Bands 256
Countries 256
Logbook 257
Modes 259
QRZ 259

Toolbar 34
Logbook Add

Toolbar 34
Logbook Database 99, 256
Logbook Problems 117
Logfile 253
Logging QSO

DM-780 192
M
Macro Editor 202
Macro Manager 200
Macro Toolbar 199
Macros 39, 59, 253

CAT Commands 59
Macros Manager 63
Main Display 104
Main Tuning 29
Main Window Tour

DM-780 176
Manager

Band Layout 53
CAT Commands 59
Favorites 56
Macros 63
Parallel Port 246

Marker
Quick Save

Size 59
Marker Size

Favorites 58
Quick Save 59

Markers 58
Favorites 58

Show 58
Size 58

QuickSave 59
Show 59

Menu Bar 32
Menus and Toolbars 31
Mode 36, 39
mode 35
Mode Selection 30
Modes

Logbook Table 259
Supersweeper 195

Monitor
Parallel Port 248

Mouse Wheel 28, 50
MP3 Player Options 89
Multiple QSO Windows 188
Mutual Visibility 220
My Station 110
N
N8VB 243
N8VB vCOM 243
New Tab 14
Next Passes 222
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O
Observer 212
ODBC driver 99
Options 34

Logbook 111
Out Of Band 49
P
Paddle Echoback 250
Paddle Watchdog 250
Parallel Port 245
Parallel Port Manager 246
Parallel Port Monitor 248
Passing Audio 85
Plot 223
Port 7805

Firewall 68
Port 7806

Firewall 68
Portmon 241
Preset Tab 14
Printing Logbook 116
Product Activation 9
Program Options 34, 46

Band Layouts 53
Com Port TX 48
Comms 47
ICOM Calibration 48
Internet 49
Keyboard Accelerators 46
Mouse Wheel 50
Out of Band 49
Selection Window 50
Themes 51
Toolbar 34
Updates 52
Yaesu 52

Program Options Overview
DM-780 166

Propagation 109
Prosign Assignments 254
Protocols 61
PSK Bandwith 177
Public Interfaces 5
Q
QRZ 259

Logbook Table 259
QRZ Lookup 106
QRZ.com 106
QSL 108
QSO Connection 197
Quick Save 34, 59

Markers 59
Toolbar 34

Quick Save Entry 59
Quick Save markers 34

R
Radio Control

Sliders 31
Radio Control Macros 205
Radio Feature Control

Buttons 31
Radio Interfacing 3
Radio Macros 183
Radio Panel

DM-780 175
Radio’s Features 30
Raio Control

Buttons 30
Receive Panel Toolbar 181
Record 87
Reed-Solomon IDs 204
Refresh 91
Registration 9
Registry Settings 254
Remote Audio 85
Remote Connection 79
Remote Port Settings 81
Remote Radio Control 67

Serial Port Server 67
Remote Server 67, 70
Remote server connection 77
Remote Station Control

Remote Server 67
Remote Station Support 67
Rig Control 1
Rotator 1
S
Satellite

Current Data 219
DDE 224
Ground Control 213
Mutual Visibility 220
Next Passes 222
Plot 223
Schedule 219
Single Pass 222
Visibility 221

Satellite Observer 212
Satellite Tracking 1, 209
Satellites 34, 209
Sattelites

Toolbar 34
Save as File 38
Schedule 219
Selection 32

Toolbar 32
Selection button 32
Selection Window 50
Serial Echoback 251
Serial Port Client 80
Serial Port Server 67, 83
Serial Ports Tab 15

Set Button 91
Set Dropdown 91
Set Frequency 91
Set Mode 91
Settings 254

Registry 254
Shortwave Database 34
Show Markers

Favorites 58
Quick Save 59

Single Pass 222
Skype 85
Sliders 34

Appearance 44
Layout 45
Radio Control 31
Toolbar 34

Snapshots 66
Soundcard Setup

DM-780 170
Speeds 251
Sstatus Text

Hiding 40
Static IP address 68
Station Set Up

DM-780 101, 169
Status Window 42
SuperSweeper 175, 195

Modes 195
QSO Connection 197

SuperSweeper Display 195
SuperSweeper Tabs 195
Supported Radios 3
SW Data 34
Swap Paddles 250
Synchroniser 92
System Requirements 2

Computer 2
Internet Connection 3
Public Interfaces 5
Radio Interfacing 3
Supported Radios 3

T
Tables

Logbook 256
TeraTerm 95
The Connection Process 15
The Preset Tab 14
Tigertronics 4, 163
Timewave 4, 163
Toolbar 32

Connect 32
Customize Display 34
Digital Master 780 35
DM780 35
Favorite 33
Full Screen 34
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